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1 Getting Started
c UserÕs Guide
Welcome to Uromac, an application program that lets you use your 

Acquidata as a multichannel chart recorder for clinical investigation 

and diagnostic Urodynamics. It is one of a range of Acquidata 

applications that provide a multi-purpose data recording and analysis 

environment for use with an Apple Macintosh computer. 

This chapter contains instructions on the installation of Uromac, 

hardware requirements, and the use of this guide in learning to use 

the application.
1
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Press here for on-
line help topics
Learning to Use Uromac

Where to Start

To install Uromac and to use it, you should be familiar with the Apple 
Macintosh environment. If you do not know how to use the mouse and 
keyboard, choose commands from the menu, copy or duplicate files, 
and so on, please consult the Macintosh User’s Guide that came with 
your computer. The application is designed to be easy to use, but 
familiarity with the Macintosh computer and some simpler applications 
will make learning it a lot easier. 

If you have previously used Macintosh applications, you should find 
that Uromac works similarly in most respects — menus, dialog boxes, 
and controls all follow the standard user interface. If you have used 
earlier versions of Uromac, you should find that this version has much 
in common, although it has been improved in a number of ways. 

You should start by reading the introductory chapters in your Acquidata 
owner’s guide to be sure that you know how to connect your 
Acquidata to your computer properly, and how to use your Acquidata 
safely and effectively. Skim through the various terms defined in the 
guide’s glossary, then continue with this chapter. 

How to use this Guide

If you are in a desperate hurry, read the rest of this chapter, the 
Overview of Uromac in the next chapter, and then go through the 
Quick Start booklet, to familiarise yourself with some of the key 
features of Uromac, trying the controls and settings with a copy of a 
Uromac demonstration file. Start recording data, using this book for 
reference when you encounter problems or unexpected results, or as 
you have the time to learn about the features you need. 

We recommend, however, that you work through this guide in front of 
your computer. It may take more effort in the short term, but will end 
up saving you time and energy. Working through a guide like this 
(method), while slower, is a more effective learning process than just 
trying an application on the computer and seeing what happens 
(heuristics). The information in the following chapters is set out in the 
d 2
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order you will probably require it. First of all, though, read the rest of 
this chapter, which covers system configurations and installing and 
personalising your copy of Uromac.

Note. The screen shots used as illustrations in this guide are from a 
monochrome monitor. There will be slight differences in appearance 
when using Uromac on a grayscale or colour monitor. 

Computer Requirements
Minimum: a Macintosh computer with a 68020 microprocessor and a 
hard disk, System 7, and 4 MB RAM. 

Recommended: either a Power Macintosh or a Macintosh computer 
with a 68040 microprocessor, with a hard disk, System 7.x, 8 MB RAM, 
and a 14-inch or larger monitor. 

Your particular needs will determine the computing requirements and 
hence which Macintosh you use. The Acquidata will work with any 
Macintosh from an LC onwards, including the Quadra, PowerBook, and 
Power Macintosh models (Uromac v3.4 in fact has various features 
optimised for the Power Macintosh). 

Slower Macintosh computers may not be able to perform some of the 
more mathematically intensive functions in real time, or sample 
continuously at the highest speeds (using Uromac). Faster computers 
allow better sampling rates on a greater number of channels, faster 
printing, and improved overall performance. Your Acquidata dealer will 
be happy to discuss your requirements and suggest possible 
configurations. 

The Acquidata System

The Acquidata system is an integrated system of hardware and software 
designed to record, display, and analyse experimental data. The system 
consists of a Acquidata hardware unit and software application 
programs (such as Uromac and EMG/Scope), which run on the 
Macintosh computer to which the Acquidata is connected. 

Your Acquidata unit has considerable computing power of its own and 
performs many tasks that are necessary during data recording. Once the 
d 3
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Acquidata transfers the data to the Macintosh, the data becomes 
available for display, manipulation, printing, storage, and retrieval.

Installation Instructions
You will have been provided with two 1.4MB disks labelled Uromac 
and Extensions, these may contain the following files:

Uromac:
Uromac  application software.
Folder ‘Sample Patient’:

Sample Patient Uromac data file.
Extensions:

AcquiAmp1  system extension.
Folder ‘Uromac Extensions’:

(AcquiPack)
AcquiFKeys
AcquiMeter
AcquiVideo
UroCalc
UroFillRate
UroPhase
UroReport
(some of these are options)

Folder ‘Calibration Folder’:
Uromac Settings customised file for your system.

If you purchased your computer from Neomedix Systems your Uromac 
System will be fully configured. However if you need to set up the 
system yourself the following steps outline the recommended 
installation.

1. Create a new folder called ‘Uromac’ on your hard disk drive.

2. Insert the Uromac installation disk into your floppy disk drive.

3. Copy the Uromac application and Sample Patient Folder from the 
installation disk to the Uromac folder you have just created.

4. Eject the Uromac installation disk and insert the Extensions 
installation disk into your floppy disk drive.
d 4
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5. Copy the contents of the Extensions installation disk to the same 
Uromac folder as before.

6. Eject the Extensions installation disk.

If you are using System 7.5 (or above) we recommend that you place 
an alias of the Calibration Folder into the Apple Menu Items folder 
(refer to your Macintosh Guide for further details); then to start Uromac 
just select the particular settings file from the Apple Menu Calibration 
Folder. Alternatively double click on the Uromac application (or a 
settings file) and open the Setting file from within the application. File 
opening and execution are discuss later in the manual. 

We recommend that you remove any earlier versions of Uromac and 
EMG/Scope from your hard disk. If there are multiple versions of an 
application present, and you double-click on an icon of one of its files 
in the Finder, then any version of the application could start up to open 
the file, not necessarily the latest. Use the Find… command (File Menu) 
from the Finder to locate multiple copies. 

Keep your original disks in a safe place after installation. Follow your 
workplace policy on backups (we recommend you make at least one), 
but remember that each purchased copy of the software only licenses 
you to use the software on one computer at any one time. 

Naming Your Copy of Uromac
Ensure that the Acquidata is connected properly to your Macintosh (this 
is covered in the owner’s guide that came with your Acquidata), and 
turned on. Click the Uromac icon and select Open from the File menu, 
or simply double-click the icon. There may be a short delay while the 
Acquidata is set up.
Figure 1–1 
The Uromac icon
Figure 1–2 Fill in this 
dialog box with the name of 
your department and 
institution, or whatever is most 
appropriate.
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On opening Uromac for the first time, a dialog box may appear (Figure 
1–2), asking you to name the copy of the application. If the computer 
has an owner’s name in the system already (for file sharing), the name 
will be put into the Name box and selected automatically. Just start 
typing if you want to overwrite it.

If the Acquidata is not connected, then after naming your copy of the 
application, the dialog box in Figure 1–3 will appear. If this dialog box 
appears when the Acquidata is connected and turned on, see the 
owner’s guide that came with your Acquidata for help. Some of the 
information from that guide on Acquidata start-up problems is also 
repeated in Appendix B at the back of this guide. 

Quitting Uromac 

If you want to quit Uromac after naming your copy of the application, 
choose Quit from the File menu. If you want to proceed with working 
through this guide, you can leave the file open, and just carry on. 
Figure 1–3 This dialog 
appears if the Acquidata is 
not connected correctly.
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2 Introduction to Uromac
c UserÕs Guide
Uromac is one of the application programs that together with your 

Acquidata make up the Acquidata system, providing a highly ßexible 

data recording and analysis environment for your Macintosh 

computer. This chapter provides a general overview of Uromac, looks 

at the Uromac window in detail, and deals with the basics of 

recording data in Uromac.
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An Overview of Uromac
Uromac, together with the Acquidata hardware and a Macintosh 
computer, gives you the capabilities of a multi-channel chart recorder 
and more. Depending on your hardware, you can record on from one 
to eight channels at a variety of speeds. Uromac also provides a range 
of powerful, sophisticated, and easy-to-use features that transcend the 
limitations of a mechanical pen-and-ink recorder. 

Controls and Display

Controls are easy and intuitive. The Uromac window can be resized 
like other Macintosh windows. The data display can be compressed or 
expanded horizontally, or the window split into two panes, and the 
vertical size of each channel can be changed to suit, simply by dragging 
the dividing bars. Channels can be turned off if they are not required, 
or set to show absolute values only, and their Amplitude axes can be 
dragged, stretched, or set through a dialog box for optimum data 
display. 

You can type in appropriate channel titles, and define units of 
measurement for each channel. The time display format and speed of 
recording can be changed swiftly, and range and filtering options can 
be set independently for each channel. Display colours, patterns, and 
grids can be altered. A Tool Bar allows common operations and user-
defined macros to be performed with a single click of the mouse. 

Recording

You can not only view data as it is recorded, but also review data while 
still recording, in a split or single window. Recording speed and range 
can be changed while recording. You can start and stop recording at 
any time and build up a Uromac file with many individual sections of 
data. You have the option of recording to disk — especially useful if 
you are making very lengthy recordings, and data recorded this way 
can survive a power failure. Comments to mark particular events can be 
made during or after recording, on all or on specific channels. A 
Notebook accessory is available for making general notes about a 
recorded data file. 
to Uromac 8
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Saving, Printing, and Editing

Uromac recordings can be printed, edited, and saved to a disk for later 
review. You can save the settings of any Uromac file to enable a 
procedure to be repeated quickly and easily, without having to go 
through the process of setting it up again. You can print a selection or 
save it as a file — this allows for easy editing by extracting only that 
part of the recording you need. You can append files to the end of an 
already open file, to produce recording summaries conveniently in a 
single file. Data can be transferred as text to other Macintosh 
applications, such as spreadsheets or statistics programs. 

Analysis

When you have finished recording, you can scroll through your data 
and make measurements directly from the recording — since 
everything is digital, you are given a direct read-out, with no chance of 
measurement errors. You can measure from a selected reference point, 
using the Marker, or a baseline (which you can also set). There is a 
sophisticated and flexible Data Pad, which calculates and stores 
statistics about recorded data — this can be printed out or its data 
transferred to other applications. It is saved along with the data file. 
The X–Y window gives you a plot of data from one channel against 
another. Uromac has an Overview miniwindow for finding areas of 
interest in large recordings, and a Zoom window for examining a 
section of the recording in more detail — this window allows you to 
overlay data from several channels for direct comparison. Comments 
can be added after recording, and are listed in the Comments window, 
from which you can go directly to the part of the record where a 
comment was added. 

Advanced Features

Triggering functions allow you to control when Uromac starts and stops 
recording, using internal or external measurements. The Stimulator 
allows you to set up an external stimulus for an experiment, and the 
Stimulator Panel control allows this to be turned on or off or adjusted 
as required during recording. Data can be smoothed off-line to remove 
unwanted high frequencies in the waveform. A range of computed 
input functions can be applied in real time to measured data: event 
counting, signal frequency, and so on, cyclic and envelope parameters, 
to Uromac 9
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and differential and various integral functions are all available. 
Computed data can be displayed in place of the raw data or in addition 
to it, on another channel. 

Customising

Uromac can be extensively customised for your purposes. Controls, and 
menus and their commands (and Command-key equivalents) can be 
locked, hidden, or altered, and Uromac as a whole simplified, say, for 
student use. Macros can be created to speed up and to automate 
complex tasks, stored in any menu in a file, and added to the Tool Bar 
as buttons. Uromac extensions are available to add specific features to 
Uromac: Data Pad functions, off-line functions, and general utilities. 

Recording Automation and Control

The Timed Events dialog box allows you to create a list of actions you 
want performed at particular times: Uromac will do the rest. By setting 
up the digital output lines appropriately (using the Configure Digital 
Output dialog box), you can control the state of the output while 
recording. This is ideal for turning on and off external devices, 
controlling pumps, relays, indicator lights, and so on. By setting up a 
list of comments that correspond to certain states of the digital inputs 
on the Acquidata, you can have Uromac automatically insert 
appropriate comments when the digital inputs change. 

Opening a Uromac File
It is a good idea to have a Uromac file open if you are working through 
this guide, so that you can try the commands, controls, and settings as 
they are discussed in the text. First, make sure that the Acquidata is 
properly connected to your computer, and is turned on. You may wish 
to learn Uromac without the Acquidata — if you have taken home a 
copy on your Macintosh PowerBook, for instance. In this case, on 
opening a file, a dialog box will offer the Analysis option, which lets 
you use Uromac except where it requires the Acquidata hardware: for 
recording, for example. Unusable controls appear dimmed. 

To open a Uromac file, click one of the Uromac icons in the Finder to 
select it, and choose Open from the File menu, or simply double-click 
the icon (see Figure 2–1). There may be a short delay while Uromac 
Figure 2–1 Uromac 
desktop icons: double-click 
one to open Uromac
to Uromac 10
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Note
To start up Uromac with 
its default settings, hold 
down the Command key as 
you open it (straight after 
double-clicking the icon). 
Release the key when the 
alert box appears, asking 
you to conÞrm your 
actions, and click the OK 
button. To start up 
Uromac without Uromac 
extensions, use the same 
procedure with the Shift 
key.
sets up the Acquidata. The top icon in Figure 2–1 shows the Uromac 
application, which will open a new untitled file if double-clicked. The 
middle icon shows a settings file, which will open an untitled file set up 
in a predefined way. The bottom icon shows a file of recorded data. 

In each case, Uromac opens and the Uromac window will appear. By 
default, the new untitled file opened when Uromac starts up will fill the 
screen, but its size can be adjusted. 

Once the Uromac application has already been loaded, you can open 
another file or create a new one by choosing Open… or New from the 
File menu. The Open directory dialog box appears: only Uromac files 
are shown in the scrolling list. You can navigate through your hard disk 
using the Macintosh file system to find the file you want. Uromac 
allows you to open only one file at a time. 

There are two checkboxes, Load Settings and Load Data, at the bottom 
of the Open directory dialog box. Data refers to the recorded 
waveforms. Settings are of two sorts: those that affect recording, such 
as the sampling speed, channel ranges, triggering, and stimulation 
functions; and those that affect the way the data looks, such as the 
window size, channel areas, display settings, and menu configuration. 
(Macros are also stored as settings.) If the Load Settings checkbox alone 
is selected when opening a file, then settings of the first sort from the 
selected file are loaded into the current file, which is not closed. 
Settings will apply to any recording subsequently carried out; display 
settings are unaffected. 
Figure 2–2 
The Open directory dialog box
to Uromac 11
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If the Load Data checkbox is selected, then the currently open file will 
be closed, and the selected file opened. If there are any unsaved 
changes to the current file, an alert box will appear asking if you want 
to save them before opening the new file. You can keep the alterations, 
abandon them, or change your mind and click the Cancel button. If 
both checkboxes are selected, then both the settings and the data will 
be loaded, otherwise the current settings are retained. 

Using a demonstration file as you work through this user’s guide will 
show you some real data and perhaps give a better idea of what is 
going on in Uromac. To protect the original files (although you should 
have backups!), duplicate some demonstration files in the Finder, and 
name them something like MyFile1, ProfessorTraining2, and so on, and 
open these to experiment with.

Closing or Quitting a Uromac File

To close a Uromac file, choose Close from the File menu. To quit 
Uromac, choose Quit from the File menu. In either case, if you have 
made any changes, a dialog box will appear, asking you if you wish to 
save your work. Click the Save button if you wish to keep the changes 
you have made. Click the Don’t Save button if you want to discard the 
changes — probably the case while learning Uromac. 

The Uromac Window
All essential controls for recording data are provided within the Uromac 
window, illustrated in Figure 2–3. These controls are discussed below, 
and, where appropriate, in greater detail elsewhere. There are three 
main areas in the window, from left to right: the Amplitude axis area, 
which contains the scale for each channel; the data display area, which 
contains recorded data; and the channel control area. 

The menu bar at the top of the screen contains the Uromac menus (see 
Appendix A), allowing you to set up and modify the way Uromac looks 
and behaves. The Uromac Window command from the Windows menu 
returns to this window from another, or opens a new, untitled file. The 
Tool Bar appears by default between the menu and the title bar of the 
Uromac window, and provides shortcuts for common tasks, including 
returning to the Uromac window or opening a new file. 
to Uromac 12
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Figure 2–3 
The Uromac window
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Click the close box to close a currently open Uromac file (this is the 
same as choosing Close from the File menu). The title bar shows the 
title of the file, and has horizontal lines across it if it is active (that is, 
the frontmost window). Drag the title bar to move the Uromac window 
to another area of the screen, or to another monitor if you have one 
attached (you can do this while recording). Drag the size box to set the 
size of the window: this is useful if you want other applications on the 
screen, and does not affect recording fidelity — the resolution of 
recorded data is independent of the resolution of the display. Click the 
zoom box to toggle the Uromac window between the set size and the 
full size of the screen. 

Navigating

The scroll bar allows you to move through the Uromac file in the 
window. Click the left and right arrows, or drag the box in the scroll 
bar, to move smoothly left or right. Click in the gray region to either 
side of the box in the scroll bar to jump a screen left or right. 

You can also move left or right by pressing, respectively, the left and 
right arrow keys on the keyboard. Hold down the Option key while 
pressing the left or right arrow key to jump a screen left or right. Hold 
down the Command key while pressing the left or right arrow key to 
go to the beginning or the end of the file. 

You can manually scroll data by holding down the Option key while 
the pointer is over the data display area: this turns the pointer into a 
hand that can drag the data back and forth. If you ‘push’ the data, by 
moving the hand and releasing the mouse button while it is moving, 
the file keeps scrolling through automatically at the speed at which you 
moved it. It will stop at the beginning or end of the file, or when you 
click anywhere in the Uromac window. 

View Buttons

The View buttons allow you to compress or re-expand the horizontal 
scaling of a file in the Uromac window (the steps are 1, 2, 5, 10… up to 
2000 to 1). To see more of the file on screen at once, click the left (far 
mountains) button to compress it. To expand the file out again, click 
the right (near mountains) button. The button between the two shows 
the scale: clicking it returns the scale to 1:1 from any other setting, or if 
it is at 1:1, changes it to 20:1. Pressing the button pops up a menu 
to Uromac 14
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allowing you to choose directly the extent of horizontal compression. If 
you print a horizontally compressed file or selection, then it will print at 
that compression.

The Uromac Axes

The horizontal Time axis, above the scroll bar along the bottom of the 
Uromac window, records the time from the start of sampling or the 
absolute time, depending on the time display mode (which can be set 
by clicking the clock at the top right of the channel control area — 
note that this clock is visible only when the pointer is over the area).

The vertical Amplitude axis on the left of the window indicates the 
amplitude of the recorded waveform. Note that the axis area remains 
blank until some data are actually recorded. The scale for each channel 
is initially set by the range control on the right side of the window, but 
can be stretched or dragged using the pointer. Display options can be 
chosen from the Scale pop-up menu. Units are volts by default, but 
may be changed to mmHg, Ω, kPa, or any other unit that you need, by 
using units conversion.

The Channel Controls

The channel controls are located rightmost in the Uromac window, at 
the right of the data display area. 

The Speed pop-up menu to the left of the clock controls the sampling 
speed (scrolling speed and samples per division), which is always the 
same for all channels. (Clicking the clock at the top right of the window 
brings up the Time Display Mode dialog box, where you choose the 
form and units of the Time axis and time display.) 

There are two channel controls for each individual channel. Press the 
down arrow button to the left to choose the range from the Range pop-
up menu. Press the channel title to choose options from the Channel 
Function pop-up menu. Note that the channel’s Range pop-up menu 
button is dimmed when the channel is off. 
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▼ Refer
Duration of Recording,  p. 23
Sampling Parameter Display

The Speed/Time display shows the current set speed of sampling if the 
pointer is over the channel control area, or the time at the pointer 
position if it is over the data display or Time axis areas. The 
Range/Amplitude display shows the current range of each channel if 
the pointer is over the channel control area, or the amplitude of the 
waveform at the position of the pointer if it is over the data display or 
Time axis areas. 

Data Display Area

Recorded data is displayed in the area in the Uromac window bounded 
by the channel control area on the right and the channel Amplitude 
axes on the left. The data for each channel is to the left of the channel 
title and bounded above and below by horizontal bars. These channel 
separators can be dragged up or down to vary the size of the channel 
display areas. 

Split Bar

The vertical split bar, at the left-hand side of the data display area, can 
be dragged to the right to split the data display area into two parts, 
each with its own scroll bar, so that you can compare different sections 
of recorded data, or compare data already recorded with new data as it 
is being recorded. 

Memory Indicators

There are two indicators of available recording memory. A small box at 
the bottom left of the Uromac window gives a numeric indication of 
current remaining memory (RAM or disk), in megabytes or kilobytes. 
When memory becomes very low (less than 30 K), the box is 
highlighted. Immediately under the title bar, there is a thin strip used to 
indicate memory used: the black bar increases in length from the left as 
the used proportion of allocated memory increases. 

The Marker

The Marker can be found in a box at the bottom left of the Uromac 
window, above the memory indicator box. It can be dragged from its 
to Uromac 16
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lair onto the data display area to set a particular data point on a 
waveform as a zero reference point, so that relative measurements can 
be made. Double-click it or click its lair to send it home. (When 
sampling, the Marker temporarily disappears, and its box shows 
roughly how much of the computer’s processing power is used during 
sampling.)

Start Button

To start recording, click the Start button at the bottom right of the 
Uromac window. The button then changes to Stop: click it to stop 
recording. The button may show a dimmed Wait… while starting or 
stopping if the Acquidata or Macintosh is particularly busy. 

Record/Monitor Button

The Record/Monitor button at the bottom right of the Uromac window, 
to the left of the Start button, controls whether data is recorded (the 
default) or merely displayed. In the latter case (used to get an idea of 
incoming signal characteristics), a cross will show on the control. 
Clicking it toggles between recording and monitoring.

Pointer

The pointer will change form as you move it about the Uromac 
window, giving you an indication of its function in certain areas — it 
becomes an I-beam over a text entry area, for instance. It becomes 
dimmed when it cannot effect a function under particular conditions. 

The Tool Bar

The Tool Bar provides short cuts for common tasks in Uromac in the 
form of buttons. The default buttons are shown in Figure 2–4: you can 
change it to suit your preferences, and add new buttons for any 
available macros. You can assign Function keys to the buttons for use 
with an extended keyboard. The Tool Bar can be hidden if you don’t 
want to use it, or moved by Shift-dragging it. 
Figure 2–4 
The Tool Bar
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The text box at the right of the Tool Bar tells you the function of the 
button that the pointer is over. It will also indicate the state of Uromac 
in some cases: loading data or settings, saving, sampling, recording a 
macro, and so on. 

Recording
To start recording, click the Start button at the bottom right of the 
Uromac window. The button then changes to Stop: click it when you 
want to stop recording. The button may show a dimmed Wait… while 
starting or stopping if the Acquidata or Macintosh is very busy. 

Uromac uses the visual metaphor of a mechanical Uromac recorder: 
recorded data normally scrolls across the data display area from the 
right of the window as if it were a roll of paper in such a device, with 
new data being drawn at the right and old data moving left. 

When recording, the controls at the bottom of the Uromac window 
change, as shown in Figure 2–5. The Time axis area goes gray, and the 
Recording Status indicator appears; the scroll bar is replaced by the 
comments bar; and the View buttons are replaced by the Scroll button 
and the Review button (for background recording). The Marker is 
replaced by an indicator showing roughly how much of the computer’s 
processing power is used during sampling. The controls are discussed 
later on.

Display While Recording

Unless sampling at high speeds, the amplitude of the signal being 
recorded is shown in the Range/Amplitude display at the right of each 

Channel the 
comment applies to 
(* for all)

Comment 
number box

Comment 
text entry 
area

Review 
button

Scroll 
button

Recording Status indicatorCPU load indicator
Figure 2–5 
Control changes during 
recording
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▼ Refer
Display Control 
Checkboxes,  p. 61
channel during recording. If units conversion is being used, the value 
of the data is displayed in the set units rather than as a voltage. The 
time is also shown in the Speed/Time display at the top of the channel 
control area — from the start of the block, or absolute time, depending 
on the time display mode. These displays are updated every second or 
so. 

Since Uromac records to memory (RAM by default, or disk if chosen), 
and sampling stops automatically when memory runs out — not 
necessarily at zero kilobytes — it is important that memory usage is 
monitored. A small box at the bottom left of the Uromac window gives 
a numeric indication of current remaining memory, in megabytes or 
kilobytes. When memory becomes very low (less than 30 K), the box is 
highlighted. Immediately under the title bar, there is a thin strip used to 
indicate memory used: the black bar increases in length from the left as 
the used proportion of allocated memory increases. 

Blocks and Settings

By default, a solid vertical line is drawn between two sections (‘blocks’) 
of recorded data to indicate discontinuity, for instance if you stop 
recording and then start again. If you change the range of one or more 
channels, a new scale is drawn between the two blocks for each 
changed channel to show the new range. Blocks always apply across 
all channels, even if only one has been changed. 

You can change the recording speed and channel range settings 
without having to stop and restart recording. Uromac will simply start a 
new block at the point where the settings were changed, drawing a 
solid vertical line or a new scale as appropriate. The display will 
momentarily stop scrolling while you are making settings changes, then 
update once the operation is complete. 
Figure 2–6 
Displays of the time and 
amplitude while recording
Figure 2–7 
Blocks of data Ñ left break, 
after stopping and starting; 
right, after changing a 
channelÕs range
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Recording or Monitoring

The Record/Monitor button at the bottom right of the Uromac window, 
to the left of the Start button, controls whether data is recorded to 
memory (the default) or merely displayed on the screen, to get an idea 
of incoming signal characteristics. Clicking it toggles between recording 
and monitoring. The control is dimmed (inactive) when triggering is in 
operation. 

You can stop or start recording data into memory at any time during 
recording by clicking the Record/Monitor button. This is useful to see if 
incoming signals are behaving themselves before you actually record 
them. If you have set up fixed-duration recording and have Uromac set 
to monitor rather than to record, then when you click the 
Record/Monitor button, Uromac records for the set time and then goes 
back to monitoring. 

You cannot add comments while monitoring, since there is no real 
record, so the comments box is dimmed, and typing has no effect. 

Recording Status Indicator

While sampling, a shadow box appears just to the left of the Start 
button, giving information on the recording status of Uromac (see 
Figure 2–9): whether data is actually being recorded, or whether 
Uromac is waiting for a trigger or for the post-trigger delay time to 
elapse. This gives you a quick visual indication of recording status.

‘Recording’ means that data is being recorded to memory (either to 
RAM, the default, or to disk). By analogy with a mechanical recorder, 
the wheel at the right end of the box turns when Uromac is recording. 
If data is not being recorded into memory and is only being displayed 
on the screen, ‘NOT Recording’ shows. The wheel does not turn, and 
flashes to give a visual cue. If you have set up triggering, ‘Waiting for 
trigger’ shows while the Acquidata is waiting for a trigger event to 
occur before it starts sampling. If you have set up a trigger delay, ‘Post 
trigger delay’ shows after triggering, while the Acquidata is waiting for 
the delay to elapse. A few other messages will appear in some 
circumstances, such as if you are printing on-line. 
Figure 2–8 
Record/Monitor button: left, 
data displayed and recorded; 
right, data displayed but not 
recorded
Figure 2–9 
Recording Status indicator 
display
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▼ Refer
Comments,  p. 85
Adding Comments While Recording

During recording, comments can be entered as required, and are 
automatically numbered as they appear. Type what you want to say: it 
will appear in the text entry area at the bottom of the Uromac window 
(see Figure 2–5). Pressing the Enter or Return key will add the 
comment to the file at the time the key is pressed: the comment’s 
position will be indicated by a dotted vertical line with a small box at 
the bottom with the comment number in it (by default). 

By default, the comment applies for all channels: when this is the case 
the numbered comment box is preceded by an asterisk. To comment 
on a specific channel, either press the Tab key (which selects the 
asterisk) and type the number of the channel, or click the channel you 
wish to comment on in the data display area: the number of the 
channel appears. To apply a comment to all channels again, press the 
Tab key and type 0, or click in the gray area at the bottom of the 
Uromac window (the Time axis area when not recording). 

Comments are stored and saved along with recorded data, and can be 
edited after recording, in the Comments window. Comment boxes are 
inserted in the appropriate channel on the record, or along the Time 
axis, marked by a dotted vertical line. When you have finished 
recording, you can read the comments by positioning the pointer over 
the comment box and pressing the mouse button. 
Figure 2–10 
General and channel-speciÞc 
comments, and the pop-up 
comment box
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Background Recording

Recording is not an all-or-nothing process; you can do other things 
while recording in Uromac. You can review recorded data, compare old 
data with new by using the split-screen feature, or even leave Uromac 
recording in the background while you run other applications. This is 
useful for longer recordings, since the computer is not tied up doing 
one thing. You do need to be using Uromac at slower recording 
speeds, though, in most cases. 

Recording While Reviewing Data

Normally, when recording in Uromac, the recorded data scrolls across 
the data display area from the right of the window, with new data 
being drawn at the right and the old data moving left. In these 
circumstances, the Scroll button is active and highlighted.

When the Review button is clicked, it highlights, and the controls at the 
bottom of the Uromac window change again: the Time axis and scroll 
bar appear, but the Recording Status indicator is still active, to indicate 
that you are still recording. 

You can use the scroll bar to scroll through previously recorded data: 
the scrolling controls and keyboard shortcuts all work normally. Data is 
still being recorded, but the new data is only visible if you scroll to the 
right-hand end of the record. At faster recording speeds, Uromac may 
disable the review feature, since it requires more computing power 
than normal. 

Review button activeYou can scroll through data already recorded
Figure 2–11 
Control changes when 
reviewing while recording
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▲ Caution

Some activities may 
interfere with the transfer 
of information from the 
Acquidata to the 
Macintosh computer, 
possibly resulting in a loss 
of data. Avoid the 
following when recording 
critical data:

1. Copying to and from 
ßoppy disks.

2. Holding the mouse 
down for a long time in 
menus and dialog boxes.

3. Using applications that 
thrash the hard disk.

4. Using screen savers.

▼ Refer
Data Buffering,  p. 43
Recording With a Split Screen

You cannot split the screen while Uromac is recording, but you can set 
it up before starting. Splitting the screen allows the incoming data to be 
viewed alongside previously recorded data, so that you can compare 
the two. Uromac records normally in the right-hand screen, so you can 
make comments on newly acquired data there, and so on, and you can 
scroll through the record on the left-hand screen to check waveforms 
of interest. You can also use the split-screen feature while reviewing is 
active, which allows two independent scrolling views of the record 
while Uromac is still recording. 

Running Other Applications While Recording 

You can run other applications while Uromac is recording in the 
background. You will need enough memory (RAM) in your Macintosh 
to be able to run multiple applications. How slowly your other 
applications run while background recording is going on depends on 
the recording speed (in general, a slower sampling speed would be 
needed), as well as the type of Macintosh you have. It helps if you 
have a fast Macintosh: the faster your computer, the faster it can handle 
data from the Acquidata, and therefore, the more time it can give to 
another application. 

Duration of Recording

How long you can record for depends primarily on the memory that 
you have allocated to Uromac (unless you are recording to disk using 
data buffering, in which case, free space on the disk is limiting). If you 
find that you run out of memory, you can increase Uromac’s memory 
allocation by quitting it, selecting the application icon in the Finder, 
choosing Get Info from the File menu (or typing Command-I), and 
typing a larger value in the ‘Preferred size’ box. There are also 
application limits of 8000 blocks of data per channel or 64,000,000 
samples per channel, although you are unlikely to reach these in 
practice. If you do, simply start new files as required. 

Note that some Uromac operations, such as generating the Overview 
miniwindow and saving, will take a long time for huge files. To ensure 
optimum performance, keep your files smaller than 10 MB where 
possible (this shouldn’t be a problem for most users). 
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Uromac uses a certain amount of memory for an off-screen buffer to 
speed up data display. If the Uromac window is large and the display is 
grayscale or colour, more memory is used, especially at increased 
colour depths. If the Uromac window filled a 14" monitor displaying 
millions of colours (24-bit colour), the memory used by this would be 
about 1.25 MB. If you find yourself running out of memory, you can 
use less by shrinking the Uromac window to a smaller size and 
changing the display from colour or grayscale to black and white, or at 
least reducing the colour depth: you don’t gain much using millions of 
colours, since Uromac only uses eight. 

Recording is also limited by the sampling speed you have selected, the 
number of channels you are sampling on, and the amount that the data 
is being compressed by Uromac. Data is compressed while it is being 
recorded, the efficiency of compression depending on how the signal 
varies: signals that change very slowly, such as a straight line or gradual 
curve, can be compressed a great deal, while complex and rapidly 
changing signals may not compress much at all. Efficiency is usually in 
the order of 25–33%. The extent of compression can be seen by 
recording some data of the type in which you are interested, then 
selecting the About Uromac… command from the Apple ( ) menu 
(click the About Uromac dialog box to make it go away again). 

Each sample takes at most two bytes of storage, so recording one 
channel at 100,000 samples per second — the worst case — would use 
100,000 × 2 = 200,000 bytes (195 K) of memory per second, without 
compression: about 12 megabyte a minute. 

A more moderate example, recording on eight channels at 1000 
samples per second, would use 8 × 1000 × 2 = 16,000 bytes (16 K) of 
memory per second, without compression, or a megabyte a minute. 
Figure 2–12 
The lower portion of the About 
Uromac start-up screen
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The approximate time in minutes that you can record for at normal 
sampling speeds is given by the following formula: 

Time is in minutes, memory is in bytes, frequency is the number of 
samples per second, and compression is the percentage given in the 
About Uromac dialog box. The 120 is 60 (seconds) × 2 (bytes per 
sample). 

Example. For instance, suppose you have 825 K of remaining memory 
left. You wish to record at 100 samples per second on four channels. 
Sampling some of the data you want to record shows that compression 
is 26%. 

Using the time equation above, the time you could record for would be 
as follows:

If your experiment will run for less than this time, that’s fine; if not, 
then you will need to increase the memory available to Uromac, or use 
data buffering. 

Time Memory
120 Frequency Channels 1 Compression 100⁄( )–( )×××
----------------------------------------------------------------------------------------------------------------------------------------------------------------=

Time 825,000
120 100 4 1 26 100⁄( )–( )×××
---------------------------------------------------------------------------------- 23 minutes= =
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C H A P T E R  T H R E E
3 Setting Up Uromac
c UserÕs Guide
You will probably want to change Uromac settings from their defaults 

for most recordings. This chapter describes basic settings controls such 

as the sampling speed and the channel range, together with features 

such as input ampliÞcation, units conversion, data buffering, 

triggering, and stimulation.
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Division
Setting the Sampling Speed
Uromac uses the visual metaphor of a mechanical Uromac recorder: 
recorded data normally scrolls across the data display area from the 
right of the window as if it were a roll of paper in such a device, with 
new data being drawn at the right and old data moving left. As with the 
paper in mechanical Uromac recorders, the data display area is marked 
into divisions by a graticule, or grid. Divisions are always 20 pixels 
wide with the view at 1:1, and are marked by the dot graticule in the 
data display area (they line up with unit divisions on the Time axis). At 
the default recording setting of 20 samples per division with a view of 
1:1, each pixel width on the screen represents one data point. 

The Speed pop-up menu controls the sampling speed through two 
variables, the time taken for each sampling division to scroll past (the 
scrolling speed) and the number of samples taken during that time. The 
number of samples taken per unit time is always the same for all 
channels, and is shown in the Speed/Time display at the top right of 
the Uromac window if the pointer is over the channel control area. 

The Speed pop-up menu gives you a normal scrolling speed of from 
10 seconds per division up to 200 microseconds per division. The 
Samples/Div submenu in the Speed pop-up menu sets the number of 

Speed/Time display in samples per 
second

Use this submenu to select the 
number of samples per (screen grid) 
division

Select a normal scrolling speed 
directly, or use the submenu to select 
a slow speed
Figure 3–1 
The graticule: with the display 
at 1:1, it is one division wide
Figure 3–2 
The Speed pop-up menu and 
Samples/Div submenu
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data points recorded per division. The settings in this submenu will 
change with the scrolling speed selected, so that together, the two 
settings give a discrete range of normal sampling frequencies (Table 3–1). 
Altering the horizontal scale with the View buttons will make the 
scrolling apparently slower, but does not alter the number of samples per 
division, as you can observe if you change the settings: the Speed/Time 
display will still show the same sampling speed.

Macintosh Type and Sampling Speed

Faster Macintosh computers allow better sampling speeds on a greater 
number of channels: slower ones may limit both maximum continuous 
sampling speed and the number of channels that data can be recorded 
on at fast speeds. Table 3–2 gives typical figures for certain machines, 
which should help you to estimate the likely performance of your 
system. When Uromac starts up, it instigates a number of routines to 
gauge the speed of the Macintosh at certain tasks. Because of the many 
possible configurations of hardware and software on a Macintosh, this 
may result in different figures from those given in the table.  

Time / Samples per Division

20 40 50 80 100 200 400 500

10 s 2 4 Ð Ð 10 20 40 Ð

5 s 4 Ð 10 Ð 20 40 Ð 100

2 s 10 20 Ð 40 Ð 100 200 Ð

1 s 20 40 Ð Ð 100 200 400 Ð

500 ms 40 Ð 100 Ð 200 400 Ð 1000

200 ms 100 200 Ð 400 Ð 1000 2000 Ð

100 ms 200 400 Ð Ð 1000 2000 4000 Ð

50 ms 400 Ð 1000 Ð 2000 4000 Ð 10,000

20 ms 1000 2000 Ð 4000 Ð 10,000 20,000 Ð

10 ms 2000 4000 Ð Ð 10,000 20,000 40,000 Ð

5 ms 4000 Ð 10,000 Ð 20,000 40,000 Ð 100,000

2 ms 10,000 20,000 Ð 40,000 Ð 100,000 Ð Ð

1 ms 20,000 40,000 Ð Ð 100,000 Ð Ð Ð

500 µs 40,000 Ð 100,000 Ð Ð Ð Ð Ð

200 µs 100,000 Ð Ð Ð Ð Ð Ð Ð

Division
Table 3–1 
Normal continuous sampling 
speeds, in samples/second, 
set through the Speed pop-up 
menu (left) and Samples/ Div 
submenu (top); dashes are 
unavailable combinations
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CPU load 
Performance at Fast Speeds

If you keep getting alerts saying the recording speed is too fast, and 
your system seems slower than Table 3–2 suggests, then there are a 
number of possible causes, and remedies. Lack of processing power or 
memory are at the root of most problems. To gauge how much of your 
computer’s processing power is used, look at the CPU load indicator 
that appears in the Marker box during sampling. If this reaches 100%, 
sampling stops automatically, but anything greater than 50% indicates 
the system is under strain. 

Background activities will decrease the ability of the Macintosh to cope 
with the data it gets from the Acquidata, so at high sampling speeds 
(2000 samples per second or greater, depending on the Macintosh), 
Uromac should be the only application running. You should turn off 
file sharing, AppleTalk, PowerTalk, and other electronic mail services, 
and may have to unmount file servers as well.

System extensions are a more likely source of problems: they use up 
memory and processor time, and may interact to cause errors. The 
Apple ones are needed by the system, but it is best to be conservative 
with others. If you did not set up your Macintosh system yourself, you 
may have dozens cluttering things up — the icons that appear across 
the bottom of your screen at start-up time will give a rough head count. 
System extensions that constantly monitor activity, particularly screen 
savers, reduce performance and may cause interruptions at high 
sampling speeds, particularly on the Power Macintosh. If you plan to 
record at high speeds, strip your Macintosh of unnecessary system 
extensions to prevent data loss. (Screen savers ostensibly prevent 
phosphor burn-in, but this occurs rarely with modern grayscale 
monitors, and is almost unheard of for colour ones.) 

Macintosh 
Computer Model

Sampling Speed (samples/second)

2000 4000 10,000 20,000 40,000 100,000

Power Macintosh 8 8 8 4 2 1

Quadra 8 8 8 4 2 1

IIfx 8 8 6 3 1 Ð

IIci, LC III 8 7 4 2 Ð Ð

IIsi 8 6 3 1 Ð Ð

LC, LC II 8 4 2 1 Ð Ð
Table 3–2 
The maximum number of 
channels available for fast 
continuous sampling on some 
Macintosh models 
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▼ Refer
Data Buffering,  p. 43
Uromac will generally perform better with more memory. To increase 
available memory, quit Uromac, select the Uromac icon in the Finder and 
choose Get Info in the File menu (or type Command-I). Type in a new 
value in the ‘Preferred size’ box. Uromac uses memory for an off-screen 
buffer: if the Uromac window is large and the display is grayscale or 
colour, more memory is used, especially at increased colour depths. To 
reduce required memory and speed up display, shrink the Uromac 
window and change the display from colour or grayscale to black and 
white, or at least reduce the colour depth. 

It is a good idea to test extended fast recording before a critical 
experiment, using the sampling speeds at which you intend to record. If 
the computer cannot cope with the amount of data being collected, 
Uromac will stop recording and notify you of the problem. This is 
especially important with data buffering, where the speed of writing to 
disk will decrease as the disk becomes full (and will also decrease over 
time as the disk becomes fragmented). 

Display at Fast Speeds

At sampling speeds of 1000 samples per second or greater, Uromac 
doesn’t continue with the visual metaphor of scrolling data from right to 
left when drawing it on the screen (after all, a mechanical Uromac 
recorder can’t draw that fast). Instead, steps are taken to reduce the 
processing power required for display. Data is drawn on the screen from 
left to right, and when the right edge is reached, drawing starts again at 
the left (a vertical line precedes the newly drawn data as it crosses the 
screen). In addition, the graticule is not drawn while sampling, and the 
data is automatically scaled horizontally as it is drawn, from a view of 5:1 
when recording at 1000 samples per second, up to 500:1 at 100,000 
samples per second. 

Slow Sampling Speeds

Slower scrolling speeds (less than 2 samples per second) are available 
from the Slow Speed submenu of the Speed pop-up menu. For slow 
speeds, the number of samples per division is fixed at 20. 

You can set scrolling speeds from 0.2 min/Div (100 samples per minute, 
about 1.6 per second) down to as slow as 100 min/Div (12 samples per 
hour, or one sample every 300 seconds). The sampling speed is shown in 
Figure 3–3 
The Slow Speed submenu
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the Speed/Time display after you select the scrolling speed. Note that at 
these speeds, the Acquidata actually samples more quickly and returns 
an average value. 

Channel Controls
Each channel in the channel control area has two pop-up menus, 
Range and Channel Function. Pressing on the down arrow button 
brings up the Range menu, from which you select the channel’s input 
range. The default setting is 10 volts (this consistently means from 
–10 V to +10 V in this application). If the signal is too small at that 
range, select a more appropriate value. For the best resolution, the 
amplitude of the signal you are interested in should be close to the 
chosen range without exceeding it. Pressing on the channel title pops 
up the Channel Function menu, which gives access to the other 
channel controls, described below.

Turning Channels Off and On 

Selecting ‘Turn Channel Off’ will turn a channel off. That menu 
command then becomes ‘Turn Channel On’, and if selected, will turn 
the channel on again. Channels can be turned off or on while you are 
recording — this creates a new block in the record. There is a shortcut 
for dealing with multiple channels: if you hold down the Command key 
while selecting the menu command from a particular channel, that 
channel and all those below it will be turned off or on. When a 
channel is turned off, the Range/Amplitude display is replaced by 

Press the 
down arrow 
button to 
bring up the 
Range pop-
up menu

Press the 
channel title 
to bring up 
the Channel 
Function 
pop-up 
menu

➠
➠

Figure 3–4 
Channel pop-up menus: 
Range and Channel Function
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▼ Refer
The AcquiAmpliÞer,  p. 34
Computed Input,  p. 104
Units Conversion,  p. 39

▼ Refer
Off-Line Functions,  p. 103
‘Channel Off’, and the Range pop-up menu button becomes dimmed and 
inactive (see the bottom right of Figure 3–5). 

While recording normally, the amplitude of the signal being recorded is 
usually shown in the Range/Amplitude display at the right of each 
channel, but if a channel is off, this display stays blank. The data display 
areas of channels that are turned off appear gray while recording, and 
afterwards, the areas in the record where a channel was turned off 
appear blank (there is neither graticule nor data). 

Other Functions

The other functions in the Channel Function pop-up menu are described 
briefly below, and more fully elsewhere.

AcquiAmplifier...allows you to change input settings, select transducers, 
apply signal filtering and so on, and  see the effects without recording.
Computed Input… brings up the Computed Input dialog box, which 
allows you to perform on-line processing of signals, taking raw data from 
any channel and displaying the processed signal.
Units Conversion… brings up the Units Conversion dialog box, which 
allows you to scale or convert the standard voltage reading for a channel 
into useful units, such as mmHg, kPa, and so on, and, using waveform 
measurements, to calibrate the channel.
Raw Data is just what is recorded, and is the default setting. 
Figure 3–5 
Data display during recording 
(top) and after recording 
(bottom) with a channel off. 
Note the behaviour of the 
Range/Amplitude display, the 
block line in Channel 4 to 
indicate discontinuity, and the 
blank area in Channel 5 
where nothing was recorded.
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Smoothing… smooths the recorded waveform as you determine. 
Absolute Value displays the absolute value of a waveform rather than 
the positive and negative values. 

Both Smoothing and Absolute Value work off-line, and do not replace 
or permanently change the raw data: the unaltered waveform can be 
retrieved at any time by selecting Raw Data from the pop-up menu. 

The AcquiAmplifier
The AcquiAmplifier dialog box allows, among other things, software 
control of the input amplifiers and filters in the AcquiAmplifier and 
AcquiProcessor for each channel. The signal present at that channel’s 
input is displayed so that you can immediately see the effects of any 
changes. Once you have changed the settings in the dialog box, click 
the OK button if you wish to apply the changes to the Uromac 
window. 

The AcquiAmplifier dialog box appears when you choose the 
AcquiAmplifier… command from a channel function pop-up menu. The 
channel that it applies to is shown at the top of the dialog box, and the 
channel title is shown along the vertical Amplitude axis. 

Signal Display

The input signal is displayed so that you can see the effect of changing 
the settings — no data is actually recorded when setting up the input 
amplifier. The signal value is displayed at the top centre of the display 
area. Slowly changing waveforms will be represented quite accurately, 
whereas quickly changing signals will be displayed as a solid dark area 
showing only the envelope (shape) of the signal formed by the 
minimum and maximum recorded values.

Setting the Range

The Range pop-up menu lets you select the input range or sensitivity of 
the channel. Changing the range in the AcquiAmplifier dialog box is 
equivalent to changing it in the Uromac window: in fact, all dialog box 
changes are made in the Uromac window on clicking the OK button. 
Figure 3–6 
The AcquiAmpliÞer dialogue 
box.
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Filtering

The AC and 50 Hz LP checkboxes provide individual channels with 
signal filtering options. 
Figure 3–7 
The AcquiAmpliÞer range 
menu.
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AC Coupling

Unless the AC checkbox is selected, the input amplifier will be DC 
coupled, and pass both DC and AC signals. When AC coupling is used, 
a 1 Hz high-pass filter is introduced before the first amplification stage 
to remove any DC and frequency components below 1 Hz from the 
input. The AC coupling option is useful if you want to remove a slowly 
changing signal component (when recording a fast signal superimposed 
on a slowly drifting baseline, for instance). 

Low-Pass Filtering

By selecting the 50 Hz LP checkbox, a 50 Hz LP (low-pass) filter is 
connected that removes high-frequency components from an input 
signal when sampling at lower speeds.

Inverting the Signal

The Invert checkbox allows you to invert the signal on the screen. It 
provides a simple way to change the polarity of the recorded signal 
without having to rewire a circuit or reconnect to the signal. 

For example, you might be recording from a force transducer where an 
increase in force downwards gives a negative signal, but you want to 
have a downwards force shown as a positive signal on the screen. 
Checking the Invert checkbox will change the display to do this. 

Units

Clicking the Units… button brings up the Units Conversion dialog box, 
allowing you to specify the units for a channel, and, using waveform 
measurements, to calibrate the channel. The waveform currently in the 
data display area is transferred to the data display area of the Units 
Conversion dialog box. (Use the Pause button to capture any specific 
signal that you want to use.) The units conversion will only apply to 
subsequently recorded signals, so it is more limited than choosing units 
conversion directly, as it does not allow the conversion of individual 
blocks of data. 
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The Line Filter

Mains-frequency interference (in the form of ‘beating’) can occur when 
the sampling speed is equal to or less than the mains frequency. The line 
filter is used to avoid the effect. It is available through the Setup menu: a 
tick beside the menu command means that the filter is operating. The 
line filter applies to all channels simultaneously. (It works by phase-
locking the sampling to the power-line frequency, and is effective with 
mains frequencies of 50 or 60 Hz.) 

In the presence of higher-frequency noise together with power-line-
frequency interference, combining the Line Filter in the Setup menu (for 
all channels) and the low-pass filter in the Input Amplifier dialog box (for 
individual channels) can prove useful. 

Transducer Power

On some channels it is possible to connect an externally powered device 
to the AcquiAmplifier. When this happens it is necessary for the 
AcquiAmplifier to interpret the input signal as DC rather than the AC 
output signal which is returned from AC excited internally powered 
devices. The Internal and External select buttons will usually be defined 
for all Uromac transducers but other Acquidata software may permit the 
optional selection of this feature.

Balance

The balance button in the AcquiAmplifier dialog box permits the user to 
balance only that channel to zero. A master balance of all channel is 
achieved by pressing the Balance button on the front panel of the 
AcquiAmplifier.

LoPass

If an active EMG headstage is used the LoPass option permits the user to 
select a number of filter cutoff values. Presently 100Hz, 300Hz, 1kHz and 
3kHz are available.
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Transducers

Selecting the tranducer for connection to the particular channel input 
sets up the optimum hardware and software gain range and signal 
routing in the system.
Figure 3–8 
TheAcquiAmpliÞer transducer 
selection.
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Units Conversion
Units conversion lets you scale or convert the standard voltage reading 
for a channel into appropriate units. Using waveform measurements, you 
can calibrate the channel. You can apply the conversion before you start 
recording, so that all subsequent recordings are scaled to the required 
units, or you can apply it after you have made a recording, either to the 
entire channel (and all subsequent recordings) or to particular blocks of 
data. You need to set up units conversion separately for each channel. 

There are two ways to bring up the Units Conversion dialog box (Figure 
3–10). You can either choose the Units Conversion… menu command 
from the Channel Function pop-up menu of a channel, or click the 
Units… button in the AcquiAmplifier dialog box. 

When choosing the Units Conversion… option directly, you should select 
an area of data if you want it to be displayed in the input signal display 
area. If there is a selection point or area, you can choose to convert the 
units of the selected block or blocks of data. The signal display area will 

Value 
button

Difference 
button

Units pop-
up menu

Voltage 
values

Units decimal 
place control

New units 
values

Amplitude Mean, maximum, and minimum values in selection

What is 
converted

Channel

Applie
d units
Figure 3–9 
The Units Conversion dialog 
box
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appear gray if there is a discontinuous selection (over two or more 
blocks) or no selection. 

Converting Units

The dialog box has four boxes beneath its title: the actual voltages go 
in the left-hand boxes, and what those readings are equivalent to go in 
the right-hand boxes. All of the boxes must have values, so that you 
have two sets of values to calculate the relationship between volts and 
the new unit (which must be a linear relationship to work). You may 
type in the values in all the boxes directly, or use some measurements 
from the input signal display area in the left-hand boxes and type in 
known conversion values in the right-hand boxes. 

Typing in Values

If you know the exact relationship between what is measured and the 
displayed voltage, then you can type in values in the four boxes 
directly (you can press Tab to move between the fields, left to right, top 
to bottom). 

If, for instance, you are using a temperature transducer and know from 
calibration tests that a temperature of 10 °C gives a reading of 1 volt, 
and 30 °C ≡ 3 V, then you can key in the values (left to right, top to 
bottom: 1 V, 10; 3 V, 30), choose °C from the Units pop-up menu, click 
Apply, and the data will be displayed in terms of temperature (°C) 
instead of volts. 

Defining Units Using Sampled Data

You can set up units conversion using some values derived from 
sampled data. Particular data points, averages, or changes in the 
waveform in the data display area can be used. You can shift and 
stretch the vertical Amplitude axis to make the best use of the available 
display area. It is the same as the Amplitude axis in the main window, 
and the controls function identically. 

If you click in the data display area, a vertical line indicates the active 
point, and an indicator arrow at the right of the data display shows the 
point of intersection with the waveform (Figure 3–10, ➊). If you select 
an area in the data display, the indicator arrow at the right of the data 
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Difference button

Value button

 ➍

 ➌

➋

➊

display shows the average amplitude of the waveform, and two markers 
above and below it indicate the maximum and minimum data points in 
the selection (Figure 3–10, ➍). 

If there is an active point or selected area in the data display, clicking the 
Value button enters the voltage value (at the selection point, or the 
average of the selection) in the left box in its row. Clicking the 
Difference button enters the difference between the maximum and 
minimum of the selection in the left box in its row. Differences are 
indicated by a delta prefix (∆). In each case, the right box of the row is 
selected so that you can type in the known value in the new units. As a 
shortcut, you can double-click in the data display area to transfer the data 
at a point in one step (doing this a second time will automatically enter 
data in the unused row). 

For example, to calibrate a force transducer, you could start recording, 
and apply two known forces to the transducer, getting two voltage 
amplitudes. Stop recording, select the area with the readings of concern, 
and choose Units Conversion… from the Channel Function pop-up 
menu. Select points or areas in the two amplitudes of the waveform 
(Figure 3–10, ➋ and ➌), enter the values in the left-hand boxes using the 
Value button, and type the known forces in the right-hand boxes. 

There may be occasions where you know the relationship between what 
is measured and the displayed voltage, but don’t have exact values. For 
example, some temperature transducers might produce a certain change 
in voltage for a given change in temperature (such as ∆20 mV ≡ ∆4 °C). 
If you have one absolute reading (at least one of the base values must be 
absolute), such as a calibration value, you can use this in one row, select 
an area in the data display where a known temperature change has been 
recorded (Figure 3–10, ➍), use the Difference button to enter the 
difference in values in that area in the left box of the other row, and type 
the known change in the right box.
Figure 3–10 
Selections in the data display 
area of the Units Conversion 
dialog box
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▼ Refer
Superscripts and 
Subscripts,  p. 58
Choosing Units

The Units pop-up menu lets you select the unit name (some common 
units are included in the pop-up menu), define new units, or delete 
unwanted units. Unit names are stored in a preferences file in your 
System folder, in common with units created in the EMG/Scope 
application, and are available to all Uromac and EMG/Scope files once 
created (or unavailable once deleted). 

You can define new units by choosing Define Unit… from the Units 
pop-up menu. The Define Unit dialog box appears, allowing you to 
type in a unit and add a prefix (there is a pop-up menu of common 
prefixes in the dialog box; the default is no prefix). Superscripts and 
subscripts can be used, as with Channel titles. 

You can delete units by choosing Delete Unit… from the Unit Name 
pop-up menu: the Delete Unit dialog box appears. Select the unit to be 
deleted from the scrolling field (Shift-click to select multiple items) and 
then close the dialog box by clicking OK: the unit will no longer be 
available. If you accidentally delete a unit, you must redefine it. 
Double-click a unit to delete it and close the dialog box in one step. 

You can set the number of decimal places of the new units (from 0 to a 
maximum of 6), by clicking the arrows at the top right of the dialog 
box. To see how the units conversion will be applied, click the Apply 
button (this will turn units conversion on). To apply the changes to the 
channel and return to the Uromac window, click OK. You can turn 
units conversion off or on without losing the values you have entered 
by clicking the Off or On buttons by the title of the dialog box. 

Type the unit name in 
here — superscripts 
and subscripts are 
possible

To use a prefix, 
select it from 
this pop-up 
menu
Figure 3–11 
Dialog boxes for deÞning and 
deleting units
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Note
If the current start-up disk 
is saved as the default 
storage disk in a settings 
Þle, then when the Þle is 
opened on a different 
system, that systemÕs start-
up disk will be used. 
Should two or more disks 
have the same name, 
Uromac uses the creation 
(initialisation) date to tell 
which is the storage disk.
Data Buffering
Data buffering allows you to select where data you record will be stored, 
either in the Macintosh’s memory (RAM) — the default — or to a 
nominated disk, which may be a hard disk, or removable media such as 
magneto-optical disks or removable hard disks. If you want to record 
data to disk by default, then open a new file, select a valid storage disk 
as described below, and save the start-up settings (Edit menu, 
Preferences submenu, Start-Up… command). 

Although storing data to memory is faster than storing to a disk, the disk 
option allows storage of much larger recordings (depending on the size 
of the disk) and the data so recorded will survive a power failure or 
system crash. It is very useful for overnight or otherwise lengthy 
recording of experiments with slower sampling speeds. 

To record data to disk rather than into memory, open a new file and 
choose the Data Buffering… command from the File menu. The dialog 
box shown in Figure 3–12 will appear. Click on the On Disk button, and 
select a valid storage disk from the pop-up menu, under which is shown 
the amount of free space available on the disk. 

How it Works

Recording to disk works by creating a new file on the selected disk and 
then writing blocks of data to the file at set intervals. The file remains 

The icon 
shown is a 
disk when 
buffering 
data, or a 
memory chip 
when 
recording to 
RAM

Select a valid disk to 
which to record from 
this pop-up menu

Click the appropriate button to record to memory or hard disk
Figure 3–12 
The Where to Buffer Data 
dialog box
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open until you choose to close and save it. As a general rule, a new 
block is written to disk every 8000 samples or every two minutes, 
whichever comes first. Once recording has finished, you must save the 
file using the standard Save command! Quitting Uromac or opening a 
new file will prompt you to save the file first: if you abandon it at this 
stage, the data will be lost. 

In the case of a power failure or a system crash, Uromac will only lose 
a maximum of the last block of data recorded, that is, 8000 samples or 
the last two minutes of recording. The next time you run Uromac, an 
alert box will indicate that the file you were recording prior to the 
power failure or system crash needs to be recovered (since it will not 
have been saved properly). A file interrupted while recording to disk 
will be called ‘…Data Buffer File…’, and will have a different icon from 
normal (see Figure 3–13). Again, abandoning it loses all data.

Media and Speed

Storage media on a network cannot be used, and these items will be 
dimmed in the pop-up menu in the dialog box. Care should be taken 
that removable media are not removed in the middle of recording! 
When Uromac comes to write to a removed disk, it will bring up the 
standard system dialog box asking you to insert the missing disk, and 
will cease recording until the disk is inserted. 

You can choose to record data to an internal or external hard disk, or 
removable media such as magneto-optical disks or removable hard 
disks. (Floppy disks are not recommended because writing data to 
them is slow, and storage is limited.) Recording to disk will usually be 
slower than recording to memory. Hard disks should be faster than the 
other options, but only the fastest would be able to record data 
sampled continuously at 100,000 samples per second. 

The maximum recording speed for data buffering depends on the 
speed of your Macintosh computer, how fast data can be written to 
disk, and the fullness or fragmentation of the disk. Fragmentation 
means that data is written in small blocks all over the disk rather than 
in one place. When a disk is nearly full, data must be written to leftover 
spaces, so a new file becomes fragmented. As a disk fills up or 
fragments, reading from or writing to it slows down, and the delay may 
slow the speed at which you can buffer data. (As a rule of thumb, hard 
Figure 3–13 
Uromac desktop icons, 
including the data buffer Þle
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disks should always have at least 10% free space, and should be checked 
regularly for data fragmentation with disk-checking software.)

Before recording critical data using data buffering, you should perform 
an extended practice run at the speeds at which you intend to record 
(especially at high speeds). If the disk recording process cannot keep up 
with the amount of data being collected, Uromac will stop recording and 
notify you of the problem.

Triggering
Triggering determines the way in which Uromac starts and stops 
recording. A trigger is an event such as clicking the Start button or a 
voltage above some preset threshold in an incoming waveform. To set 
up triggering, choose Trigger from the Setup menu. The Trigger window 
will appear. You can use the controls to set up the type of trigger event 
you want, the delay until recording, the duration of recording, and so on. 

The Trigger window is a normal window with a close box and title bar, 
and can be moved around the screen or left in the background while the 

Use this pop-up menu to 
choose the event channel

The triggering voltage is 
displayed below the slider 
bar

Click these buttons to choose 
the trigger state change: up 
for positive, down for 

Use this 
pop-up 
menu to 
set the 
starting 
condition

Use this 
pop-up 
menu to 
set the 
stopping 
condition

Use the arrow buttons or text 
entry boxes to set times

Use the slider bar or 
text entry button to set 
values
Figure 3–14 
The Trigger window
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Uromac window is active. By default, the Event and Stop controls are 
set to User. Controls not used under these conditions appear dimmed. 

Setting the Controls

Event

You can select the event that triggers recording from the Event pop-up 
menu, which gives you the choice of Ext Trigger, User, or one of the 
Uromac channels. If you select User, Uromac will start recording when 
you click the Start button (triggering is inactive); when it stops depends 
on the Stop and Record For settings. If you select one of the other 
triggering options, clicking the Start button gets Uromac ready to 
record: the Recording Status indicator will give the message ‘Waiting for 
trigger’, and the Record/Monitor button will be dimmed. The chosen 
trigger event then starts Uromac recording. 

If you select Ext Trigger, the event comes from an external source 
connected via the Trigger connector on the front of the Acquidata. The 
external voltage pulse must be over 2.9 V for 5 µs or longer to start 
Uromac recording. If you select a channel, a voltage above some 
threshold in the signal of that channel starts Uromac recording. 

Slope and Level

When channel triggering is active and a channel is selected in the Event 
pop-up menu, the level and slope of the triggering voltage can be set. 
The trigger level is an absolute voltage: the slope determines whether 
triggering occurs when the voltage goes up (positive) or down 
(negative) through the trigger level. The active Slope button is 
highlighted: click the inactive button to change the slope. 

The Level control is used to set the trigger level voltage. The range of 
voltages available depends on the range set for the trigger channel. The 
slider bar can be used to set the value in the normal way, by dragging 
the sliding handle, or clicking or pressing the arrows or the slider bar 
area (click for a single increment, press to scroll). The value is 
displayed below the slider bar, along with an indication of the slope. 
Alternatively, you can enter a value directly by clicking the Text button 
above the slider bar at its right end: a small text entry box appears. 
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Type in the value you want, and to enter it, either click the close box at 
its left, or press Return or Enter. 

Start

From the Start pop-up menu, you have the choice of At Event, Post-
Trigger, or Pre-Trigger. You can select whether or not there is a time 
delay between the triggering event and the start of recording. 

When At Event is selected, sampling starts as soon as the trigger event 
occurs, and the Start time controls are dimmed. 

When Post-Trigger is selected, sampling starts after the trigger event 
occurs, at a time preset with the start time controls. This is useful in cases 
of delayed response, if the signals you want to record will occur some 
time after the trigger event. When Pre-Trigger is selected, sampling starts 
before the trigger event occurs. This is useful to record the onset of an 
event before the trigger level voltage is reached. The anticipation is 
limited to 2000 samples (at present), since it relies on data buffered in 
memory. Pre-triggering may result in negative values in the Time axis for 
the time preceding the trigger event (which takes place at zero time in 
some time modes).

The Start time controls are used to set the time before or after the trigger 
event at which recording starts, and are only active when Post-Trigger or 
Pre-Trigger is selected in the Start pop-up menu. Click or press the up 
and down arrows to increment or decrement the numbers, or type a 
value in the text boxes directly. The available time range depends on the 
sampling speed. 

Stop

You can select the point at which recording stops from the Stop pop-up 
menu: User, Fixed Duration, or End of Trigger. 

When User is selected, recording continues until you click the Stop 
button (or memory runs out), and the Stop time controls are dimmed. 

When Fixed Duration is selected, recording continues for a set period 
after the trigger event occurs. When End of Trigger is selected, recording 
starts at the trigger event, and continues for a set period after the end of 
the trigger event (when the voltage falls below the trigger level again). 
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▼ Refer
Duration of Recording,  p. 23
For example, you might use this to record while a nerve was firing, and 
for a certain time afterwards: recording would start when the nerve 
potential starts, and stop a set time after the nerve potential stops. 

The Stop time controls are used to set the time for which recording 
continues, and are only active when Fixed Duration or End of Trigger is 
selected in the Stop pop-up menu. Click or press the up and down 
arrows to increment or decrement the numbers, or type a value in the 
text boxes directly. Uromac does not check to see if you have enough 
memory to record for the time you enter, so you should. 

Making Changes in the Uromac Window

If you have selected channel event triggering, you can change the 
trigger level voltage and slope, and the event channel, from the Uromac 
window. If channel triggering is active, the Trigger Marker (an arrow, a 
T, and a triangle) is shown in the (vertical) Amplitude axis of the event 
channel with the triangle pointing at the triggering voltage level. The 
trigger slope is represented by the arrow: up for positive and down for 
negative. 

Double-clicking the Trigger Marker changes the slope. You can drag the 
Trigger Marker up or down to change its settings — a gray box and line 
appear, to indicate where it will go. When the box and line are at the 
desired voltage in the desired event channel, release the mouse button 
to apply the new settings to the trigger. 
Figure 3–15 
The Trigger Marker
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The Stimulator
The Stimulator allows you to generate a pulse or pulses (that is, a 
stimulus or series of stimuli), using the Acquidata analog output. To set 
up stimulation, choose Stimulator from the Setup menu. The Stimulator 
window will appear (Figure 3–16). You can use the controls to set up the 
number of pulses, and their frequency, duration, amplitude, and so on. 
Pulses are generated by the Acquidata via the socket marked ‘Stimulator 
Output’ on the front of the AcquiProcessor. The stimulator settings are 
independent of the sampling speed, but stimuli can only be generated 
while you are sampling. 

The Stimulator window is a normal window with a close box and title 
bar, and can be moved around the screen or left in the background while 
the Uromac window is active. By default, the Stimulator is off, and the 
controls appear dimmed. Click the On button to set up stimulation (the 
button will highlight). You can turn stimulation off or on without losing 
the values you have entered. (The Off and On buttons are duplicated in 
the Stimulator Panel miniwindow to enable convenient starting and 
stopping of continuous stimulation.) 

Values set 
by the 
various 
controls are 
displayed 
below them

Use the slider bar or text 
entry button to set values

Click a radio button to choose between continuous 
stimulation and a set number of pulses

Use the pop-up menus to 
change stimulus 

Use the 
arrow 
buttons to 
increase or 
decrease 
the number
of pulses
Figure 3–16 
The Stimulator window
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Setting the Controls

The slider bar for each of the stimulation parameters can be used to set 
the value in the normal way, by dragging the sliding handle, or clicking 
or pressing the arrows or the slider bar area (click for a single 
increment, press to scroll). The value is displayed below the slider bar. 
Alternatively, you can enter a value directly by clicking the Text button 
above the slider bar at its right end: a small text entry box appears. 
Type in the value you want, and to enter it, either click the close box at 
its left, or press Return or Enter. 

Number of Pulses

By default, the stimulator gives a continuous train of pulses. If you click 
the Set Number of Pulses radio button, the stimulator will produce a 
fixed number of pulses between 1 and 2000. Click or press the up and 
down arrows to increment or decrement the number, or type a value in 
the text box directly. (A finite pulse train is started by clicking the 
Stimulate button in the Stimulator Panel miniwindow.) 

Range, Frequency, and Pulse Duration

The (frequency) Range pop-up menu lets you select the range for the 
Frequency control, from 2 Hz, 20 Hz, 200 Hz, or 200 pulses per minute 
(about 3.3 Hz), since it can sometimes be more convenient to have 
frequency stated in terms of minutes. The Frequency control is used to 
set the pulse frequency within these four ranges, from 2 pulses per 
minute (0.0333 Hz) to 200 pulses per second (200 Hz). 

The Pulse Duration control is used to set the time for which the pulse 
lasts. The time is dependent on the frequency set, since the pulse 
cannot exceed the period of the stimulus waveform. The duration can 
be from 1 ms up to 4 ms at 200 Hz, 49 ms at 20 Hz, 499 ms at 2 Hz, or 
299 ms at 200 pulses per minute (PPM). 

Range and Amplitude

The (amplitude) Range pop-up menu lets you select the range for the 
Amplitude control, from 100, 200, or 500 mV to 1, 2, 5, or 10 V. The 
Amplitude control is used to set the exact voltage, either positive or 
negative, within these ranges.
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The Stimulator Panel

Once you have set up stimulation using the Stimulator window, you can 
easily start or stop stimulation or change settings while sampling, by 
using the Stimulator Panel miniwindow. Choose Stimulator Panel from 
the Setup menu to bring it up. 

The Stimulator Panel miniwindow ‘floats’ in front of the active window, 
can be moved around with its title bar, and can only be dismissed by 
clicking its close box. 

If you choose continuous pulses, then the Panel will have Off and On 
buttons — clicking these is the same as clicking the Off and On buttons 
in the Stimulator window, so you can turn stimulation off or on at will. If 
you have chosen a set number of pulses, then the Panel will have a 
Stimulate button: you start the pulse train by clicking it. 

Click the up or down arrows to increment or decrement the frequency, 
pulse duration, or amplitude during sampling — the currently measured 
value is shown beside the parameter control. To alter the magnitude of 
this change, hold down the Command key while clicking what you want 
to change. A dialog box will appear for that control, in which you can set 
the magnitude of the change by clicking the up or down arrows. 

This button appears when a 
set number of pulses is 
chosen — click to start the 
pulse train
These buttons appear when 
continuous stimulation is 
chosen — click to start or 
stop
Figure 3–17 
The Stimulator Panel 
miniwindow
Figure 3–18 
The Stimulator Panel 
increment dialog boxes
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Constant Output Voltage

In addition to pulse stimulation, you can generate continuous output 
voltages. To set this up, choose the Output Voltage… menu command 
from the Setup menu. The Stimulator Constant Output dialog box will 
appear. You can use the controls to set the voltage amplitude. The 
voltage is generated by the Acquidata via the output socket on the front 
of the AcquiProcessor. 

Presently only Output 1 is available on the Acquidata range of 
products.

The (amplitude) Range pop-up menus let you select the ranges for the 
Amplitude controls, from 100, 200 or 500 mV to 1, 2, 5, or 10 V. The 
Amplitude controls are used to set the exact voltage, either positive or 
negative, within these ranges. 

The constant DC output voltages can be adjusted during recording 
without stopping, just by bringing up the dialog box. 
Figure 3–19 
The Stimulator Constant 
Output dialog box
omac 52



Uroma

C H A P T E R  F O U R
4 Data Display
c UserÕs Guide
Uromac allows you great ßexibility in displaying data. You can 

change the lines, patterns, and colours of the data display. You can 

change the time mode, resize the Uromac window, split the screen, 

change the size of each channelÕs display, and expand or reduce the 

horizontal scaling. You can look at the overall trends in the recording, 

or look at a small section of data in great detail. 

This chapter describes the display options available in Uromac, from 

the basic settings through to Amplitude axis manipulation, channel 

titles, and the Zoom window.
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Channel Separators
To change the size of a channel’s display, position the pointer over one 
of the channel separators (anywhere along its length), so that it 
changes into the separator pointer. Drag the channel separator to the 
desired position — a gray line appears, to indicate where it will go — 
then release the mouse button. You cannot do this while recording. 

If you drag a channel separator past others, it will pick them up — for 
instance, if you drag the separator of a channel to the bottom of the 
data display area in the window, you will drag down all those of the 
channels below it as well. Double-clicking on a channel separator 
divides the data display area evenly, into eight channels if there is a 
connected Acquidata, or the number of channels of data otherwise. 

Note that the resolution of the recorded data is independent of the 
resolution of the display. Unless a channel is turned off, data will be 
logged in it at full fidelity during recording, even if the channel 
separators have been adjusted so that the channel is very thin or not 
visible on the screen. 

Split Bar
You can split the data display area of the Uromac window vertically, 
into two sections or panes, in order to compare different sections of 
recorded data, or to compare recorded data with new data as it is 
obtained. When recording, the new data is shown in the right-hand 
section of the window. 

To split the window, position the pointer on the split bar (anywhere 
along its height), so that it changes into the split pointer. Drag the split 
bar to the desired position, so that the two panes of the window are 
Figure 4–1 
Changing a channelÕs size: 
drag the channel separator 
until the gray line is where you 
want it to be, and release the 
mouse button
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the sizes you want them — a gray line appears, to indicate where it will 
go — then release the mouse button. You cannot split the window or 
change the size of the panes while recording.

You can scroll through the two sections independently during 
examination of recorded data using their scroll bars; the keyboard 
scrolling commands control the right-hand pane. Double-clicking the 
split bar returns it to the ‘off’ position at the left of the data display 
area, and leaves you with a single pane once more. 

The Amplitude Axis
The scale of the (vertical) Amplitude axis of each channel can be 
independently dragged, stretched, or set through a dialog box for 
optimum data display. Scale appearance options can be selected from 
the Scale pop-up menu, the button for which is located on the left-hand 
side of each channel’s Amplitude axis. (The Bipolar and Single Sided 
options are disabled if Units Conversion is already applied.) 

Single Sided. Shifts the vertical axis so that zero volts is located at the 
bottom of the display area. This option can be used if you wish to view 
only the positive voltage signals. Any readings below zero volts will be 
off the screen (to see them, select the Bipolar option).

Bipolar. This is the default mode for each channel in Uromac. It 
displays both positive and negative signals, with zero volts being 
displayed at the centre of the vertical scale if no shifting or stretching 
has been applied.
Figure 4–2 
Splitting the data display area: 
drag the split bar until the gray 
line is where you want it to be, 
and release the mouse button
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Normal pointer

Dragging pointer

Stretching 
pointers
Set Scale. This option allows you to adjust the Amplitude axis directly 
to display the range of values you desire. It works whether Units 
Conversion is on or off. When you choose Set Scale…, the Scale Range 
dialog box appears, allowing you to type in directly the lower and 
upper limits of the scale to be displayed.

Note that Set Scale is meant for fine-tuning the scale setting rather than 
for use as a magnification tool, and will allow expansion or 
compression to no more than twice the original range chosen, with 
neither the upper or lower value being over three times the original 
limit. First set the range approximately from the Range pop-up menu 
for the channel, and then set the axis to the precise values required. 

The scale of the Amplitude axis can be shifted or stretched or both. 
This would allow you to enlarge the signal viewed on the screen, for 
instance, or move it to fit better in the display area. 

The pointer changes as it is moved over the Amplitude axis area. At the 
left of the area, it is a normal, leftward-pointing arrow. To the right of 
the area, though, the pointer points to the right, and a small marker 
appears beside it, indicating its function. Between numbers on the 
scale, a double-headed arrow indicates that dragging will move the 
scale. If the pointer is opposite a number on the scale, two triangles 
point away from the mid-point on the axis, indicating that dragging will 
stretch the scale in the direction they point — and dragging in the 
opposite direction will compress it (when you press the mouse button 
down, the number beside the pointer is outlined by a gray box to 
indicate that it is the dragging point). 

Dragging or compressing the scale allows you to set the axis to three 
times the range limit, and stretching allows you to expand the axis up 
to 20 times. When the scale is altered, the numbers indicating the scale 
in the Amplitude axis of the channel are changed to suit. 

Double-clicking in the Amplitude axis area returns the scale to its 
normal, unstretched position, with zero at the mid-point of the axis. 
Figure 4–3 
The Scale Range dialog box
Figure 4–4 
Pointer changes in the 
Amplitude axis
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Note
Uromac remembers, but 
does not display, the date 
and time of all recordings, 
so if you record new data 
in old Þles, and choose 
ÔFrom start of recordÕ, you 
might end up with very 
large numbers towards the 
right of the Time axis. If 
you append data from 
different Þles, you might 
get even stranger results! 
(Use the Data Pad to check 
the recording dates of 
blocks.)
Double-clicking again toggles between this Bipolar display and the 
Single Sided display, which has zero at the bottom of the display area. 
Note that this shortcut does not take units conversion into account: if 
this is on, then you may have to drag the scale to get the zero point to 
where you want it. 

Time Display Mode
Clicking the clock at the top right of the Uromac window brings up the 
Time Display Mode dialog box, where you can choose the form and 
units of the Time axis — the display mode chosen applies to the whole 
axis, and can be applied at any time before or after recording. The 
clock will only show when the pointer is over the channel control area; 
otherwise the Speed/Time display shows the time at the pointer 
position along the Time axis, in the form chosen in the dialog box. 

The three radio button options are as follows:

From start of block. Time is measured relative to the start of each 
new block of data (this is the default setting). Time is reset to zero at 
the start of each block of newly recorded data, that is, whenever Start is 
clicked or recording is started by triggering. 

From start of record. Time is measured relative to the start of the 
record. This is useful if you want to know the amount of time lost 
between sampling being stopped and started again.

Time of day. Time is displayed as the time of day the sample was 
taken — it uses either 12-hour or 24-hour display depending on the 
settings in the Macintosh control panel. This is useful if you want to 
know the particular time of day that an event occurred.
Figure 4–5 
The Time Display Mode dialog 
box
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When the time gets large enough, it will be displayed in hours, 
minutes, and seconds unless the Always Seconds checkbox is checked. 
This checkbox is dimmed and cannot be chosen when Time of Day is 
selected.

Channel Titles
Normally the titles for each channel displayed at the right of the 
Uromac window are ‘Channel 1’, ‘Channel 2’, and so on, down from 
the top. You can change the titles, if you wish, to indicate what you are 
recording. To do this, select Channel Titles… from the Setup menu. The 
Channel Titles dialog box will appear. 

The Channel 1 text entry box will be selected: simply type in a new 
title to overwrite it. Press Tab to select the next field, and continue. 
Most of the range of characters found in the Chicago font are available 
— use Key Caps if you are unsure about how to get unusual characters, 
such as Ω (Option–Z), the degree sign, ° (Option–Shift–8), or ∆ 
(Option–J). 

Superscripts and Subscripts

Superscripted and subscripted characters, such as occur in Na+ or 
C2H5OH, can be used in a channel title (and also unit definitions). 

¥ To superscript a character or characters, type Shift-6 (^), the caret 
character, before it or them. 

¥ To subscript a character or characters, type Option-6 (¤), the 
section character, before it or them. 

¥ To return to normal characters after superscripting or 
subscripting, type Shift-hyphen (_), the underscore character. 
Figure 4–6 
The Channel Titles dialog box
58



Chapter 4 Ñ Data Display

Note
A space or full stop is 
usually used to separate 
parts of units, to prevent 
confusion. For example, 
the SI units of pressure, 
Pascals, could be written 
as kg m sÐ2 or kg.m.sÐ2; 
they should not be written 
as kgmsÐ2, which could be 
misinterpreted. 
The caret, section, and underscore characters appear in the text entry 
boxes, but not in the channel title. Ten characters at most, including 
those used to superscript or to subscript, can be entered for a title. 

Once you have changed the titles of the channels you wish to affect, 
click OK to exit the dialog box and apply the changes to the Uromac 
window, or Cancel to exit and abandon them. If no title is entered, the 
normal ‘Channel n’ title will appear. If the title is too long to fit in the 
area allocated in the Uromac window (too many letters or the title is 
too wide anyway), it is truncated and an ellipsis (…) replaces the extra 
characters in the display. 

Display Settings
The Display Settings dialog box allows you to set the waveform line 
pattern or colour for each channel, whether blocks and comments are 
marked, and the way that Uromac displays data as it records. You can 
also use it to change the colour of the graticule (the display grid) in all 
windows, or its form in both Zoom and X–Y windows, and choose the 
line pattern or colour of the X–Y plot. To bring up the Display Settings 
dialog box, choose Display Settings… from the Setup menu. 

Display 
control 
checkboxes

Waveform 
pop-up menu

Graticule 
pop-up menu
Figure 4–7 
The Display Settings dialog 
box 
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The B+W and Colour buttons let you choose between a black-and-
white and a colour display of data. The selected option is highlighted 
with a heavy border. Colour is selected by default if you are using a 
colour or gray-scale monitor (whether it is your main monitor or not), 
otherwise black and white is selected. Black and white generally gives 
you a choice of patterns, and colour a choice of colours (or grays, if 
you have a gray-scale monitor), in the various pop-up menus. Colours 
and grays can be printed as well as displayed, if you have an 
appropriate printer.

The Waveform Menus

The Waveform pop-up menus for each channel give you the choice of 
displaying the data points joined by lines or as unjoined dots, and in a 
particular pattern or colour. Press them to bring up the options. 

To show a waveform as dots, select Show Points as Dots from the 
Waveform pop-up menu for a channel: a dot will be shown at each 
sampled data point. The menu command changes to Join Points with 
Line: selecting this gives you a continuous waveform (the default for 
Uromac). The waveforms below the menu dividing line should give 
you some idea of how your data will look. 

There are seven colours or patterns of waveforms in three thicknesses 
below the menu dividing line: click one to select it (a box indicates the 
selection). While the colour or pattern applies to the waveform 
anywhere, the thickness applies only in the Zoom or X–Y windows, 
and not in the Uromac window (or Overview miniwindow for that 
matter), where waveforms are always drawn as one-pixel-thick lines or 
single-pixel dots. 
Figure 4–8 
Waveform pop-up menus and 
Graticule pop-up menu
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▼ Refer
The XÐY Window,  p. 101
The X–Y Plot

The Waveform pop-up menu for the X–Y plot is identical to those for 
the various channels, but applies only to the plot of data from one 
channel against data from another in the X–Y window. 

The Graticule

The graticule (or display grid) can be changed for the Uromac, Zoom, 
and X–Y windows. Choosing Off from the Graticule pop-up menu turns 
off the graticule in all three windows. 

When colour or gray-scale is chosen (the Colour button is on) the 
Graticule pop-up menu gives a choice of colours (or grays), shown as 
solid lines. The Uromac window will always show a dot graticule (of 
the chosen colour or gray), but whether the Zoom and X–Y windows 
show graticules as solid lines or dots depends on which of the radio 
buttons under ‘Zoom & X–Y Windows’ is selected. 

When working in black and white, the Graticule pop-up menu gives a 
range of line-and-dot patterns which apply only to the Zoom and X–Y 
windows, and only if the Line Graticule radio button is selected 
(otherwise just dots will be used). The Uromac window will show a 
black dot graticule in this case. 

Display Control Checkboxes

By default, all the checkboxes are checked and active. Click a 
checkbox or its control title to toggle it off or on, and so disable or 
reinstate a particular feature. 

Lines Between Blocks. Normally Uromac draws a solid black vertical 
line between blocks of data to indicate some form of discontinuity, 
such as sampling being stopped and then restarted, a channel being 
turned off, or a channel’s scale being altered. You can, if you wish, turn 
off this control and have no separation line between blocks. This is 
useful when you are recording for limited durations at very fast 
sampling speeds, and so getting very short blocks. 

Show Comments. The numbered comment boxes that appear when a 
comment is added during or after recording can be hidden by turning 
Figure 4–9 
A recording of short 
segments: top, with block 
markers; bottom, without
61



Chapter 4 Ñ Data Display

▼ Refer
Printing Comments,  p. 90

▼ Refer
Display at Fast Speeds,  p. 31
this control off. This may be useful for printing, if you don’t want data 
obscured by the boxes. (By default, a numbered list of comments is 
included at the end of a print-out anyway, with the time marked beside 
each comment.)

Draw Comment Line. A dotted vertical line is usually drawn through 
the data point associated with a particular comment to make location 
easier. Turning this control off may again be useful for printing, if you 
don’t want data obscured. If the Show Comments control is turned off, 
this control is as well, and the control title dimmed, but otherwise 
comment lines can be hidden while leaving comment boxes showing. 

Scroll While Sampling. Normally, recorded data scrolls across the 
data display area from the right of the Uromac window as if it were a 
roll of paper in a mechanical Uromac recorder, with new data drawn at 
the right and old data moved towards the left. You don’t have to live 
with an old Uromac recorder’s way of doing things, though. If the 
Scroll While Sampling control is turned off, data is drawn on the screen 
from left to right, and when the right edge is reached, drawing starts 
again at the left (a vertical line precedes the newly drawn data as it 
crosses the screen). Data is easier to view while it is being recorded if it 
is not moving at the same time. 

At faster speeds (1000 samples per second or greater), data is drawn 
like this regardless of the control’s setting, but the graticule is not 
drawn, and the data is compressed horizontally as well. 

The Overview Miniwindow 
The Overview miniwindow allows you to see all of a channel’s data at 
once, to make finding particular events easier. It is useful for large 
recordings where you don’t want to keep using the View buttons: you 
can look at all the channels in the main Uromac window at a view of 
1:1, while still having an overview of a channel to see longer-term 
Figure 4–10 
A recording with comments: 
left, Show Comments and 
Draw Comment Line on; 
middle, Draw Comment Line 
off; right, both off
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Note
Once the Overview 
miniwindow has been 
generated, Uromac caches 
it in memory for 
subsequent fast access. It 
will be kept there unless 
memory runs very low. 
trends in the data. To bring up the Overview miniwindow, choose 
Overview from the Windows menu, or type Command-M.

The Overview miniwindow ‘floats’ in front of the active window, can 
be moved around with its title bar, and can only be dismissed by 
clicking its close box. It can be resized using the size box at its bottom 
right corner. The displayed channel can be changed by clicking the 
Channel Number buttons at the bottom left corner of the miniwindow 
— they correspond to the numbers in the default channel titles. The 
number of the displayed channel is highlighted. 

The data currently displayed in the Uromac window is highlighted 
(black on white) in the Overview miniwindow. You can scroll the 
contents of the Uromac window by dragging this highlighted rectangle. 
If you click outside the highlighted area on a particular segment of the 
recording, the highlighted area is centred where you click, and the 
event is also centred in the Uromac window. This enables you to find 
events of interest quickly in large recordings. You can keep track of 
where you are by shrinking the miniwindow to a small size and leaving 
it in an unused area of your screen. If you are using it on a huge file, 
the inverted area may be quite narrow: if so, drag the size box to 
enlarge it.

If the data display area of the Uromac window is split into two panes, 
the highlighted area in the Overview miniwindow only shows the 
display area of the right-hand pane. 

The Overview miniwindow might initially take a long time to draw on 
very large files containing millions of data points. If you want to 
interrupt the process, type Command–period: if you do this, the 
Overview miniwindow will appear gray. Clicking a Channel Number 
button or the display area makes it draw an overview once more. 

Displayed Channel Number Area shown in Uromac 
Figure 4–11 
The Overview miniwindow
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The Zoom Window
With the Zoom window, you can look at a small section of data in 
great detail, either in one channel or in several channels at once over 
the same period of the recording. To zoom in on a data selection, drag 
to select an area of interest in the Uromac window, and then choose 
Zoom Window from the Windows menu or click the Zoom Window 
button in the Tool Bar: the Zoom window appears.

The Zoom window is a normal window with a close box and title bar, 
and can be moved around the screen or left in the background while 
the Uromac window is active. It can be resized using the size box at its 
bottom right corner. By default, the Overlay button is on, and if 
multiple channels are selected, their waveforms are superimposed. The 
numbers of the Channel Number buttons at the bottom left corner of 
the window correspond to channel numbers, and a short bar of the 
pattern or colour chosen for the channel waveform is displayed above 
the button to aid identification. Buttons for channels not selected 
appear dimmed. 

Tracking 

Overlay 
button

Marker

Stack 
button

Channel Number 

Time and value 

Wavefor
m Cursor

Pointer

Identification 
Figure 4–12 
The Zoom window
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▼ Refer
Measuring From the 
Waveform,  p. 94
If the selection contains less than 5 or more than 32,000 data points, the 
Zoom window will appear gray. If this happens, increase or decrease 
the extent of your selection. 

The Stacked Display

If the selected area of interest in the Uromac window covers more than 
one channel, then multiple channel waveforms are superimposed in the 
Zoom window by default (the Overlay button is on). If the Stack button 
is clicked, then selected channels are displayed stacked one below the 
other in much the same way that they are displayed in the Uromac 
window. The height devoted to each channel is in the same proportion 
as in the Uromac window. Clicking the Overlay button turns off the 
Stack button and superimposes channel waveforms again. 

Data Display

The highlighted Channel Number button indicates the waveform that 
the Waveform Cursor tracks, whether the channels are overlaid or 
stacked. The time (t) and value (V) readings at the tracking point are 
indicated at the top of the window, in the appropriate time mode and 
units, as set by the time mode display and units conversion. 

Stack 
button 
selected
Figure 4–13 
The Zoom window with the 
Stack button on Ñ this is the 
same selection as shown in 
Figure 4Ð12
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▼ Refer
Display Control 
Checkboxes,  p. 61

▼ Refer
Using the Marker,  p. 95
The tracking channel can be changed by clicking one of the 
(undimmed) numbered buttons at the bottom left corner of the 
window, or clicking on a different waveform. In either case, the button 
of the selected channel will be highlighted to indicate the new tracking 
channel. 

The Marker from the Uromac window is duplicated in the Zoom 
window — moving it onto a waveform in one will do the same in the 
other, double-clicking it will send it home, and so on. Its behaviour is 
also similar in the Zoom window, although there is a slight difference 
because the waveform cursor only tracks one waveform, if there are 
several. When the tracking waveform is the one on which the Marker 
rests, relative measurements (preceded by ∆) are given in the readings 
for both time and value; when the Marker rests on one of the other 
waveforms, the display is of relative times but absolute values. 

If the selection in the Uromac window is discontinuous (straddling two 
or more blocks), then the Zoom window displays a gap and a thin line 
to indicate such discontinuity, unless you have chosen to turn off the 
display of lines between blocks. 

Double-clicking in the Zoom window transfers relevant data at the 
active point to the Data Pad, just as it does in the Uromac window: the 
expansion of the waveform in the Zoom window display obviously 
allows greater accuracy in selecting data points. 

If you hold down the Command key when clicking a data point in the 
Zoom window, that data point is located and centred (if possible) in 
the Uromac window. This is useful if you have selected a large area in 
the Uromac window to zoom in upon, so that the data in the Zoom 
window ends up compressed. Additionally, if you have zoomed in on a 
particular segment of data, and then scrolled through the Uromac 
window to somewhere else, then if the selection has not changed, you 
can click in the Zoom window to return to where you were. 

Printing the Zoom Window

When the Zoom window is active, then the Print option in the File 
menu changes to Print Zoom, and if the command is selected, the 
contents of this window are printed rather than those of the Uromac 
window. 
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Display and Expectations
Interpretation of many measurements, particularly biological ones, is 
based on empirical evidence: thousands of measurements have been 
made over the years and a profile built up of normal and abnormal 
readings. Because the expected shape of a waveform is based on what 
has been seen previously, it may be difficult at first to interpret 
waveforms presented in a new manner. 

For example, electrocardiographs have been around for at least 75 
years, and have a more-or-less standard output on graph paper with 
millimetre and five-mm divisions, where the recording speed is 25 
mm/s and a millivolt signal would typically measure 10 mm vertically. 
Uromac allows a flexible data display, so that a waveform can be 
reshaped and resized at will. It is not difficult to get used to, especially 
since unit scales are always visible, but may make the waveform look 
abnormal if one expects it to have the same size and aspect ratio of a 
standard ECG.

The screen display on a monitor is generally about 72 dots per inch, so 
the apparent resolution is not that good if the display is kept small (as 
it would be, say, if you were trying to accord with decades of tradition 
and keep an ECG the same size as those of yesteryear). The signal 
might appear jagged and unresolved on screen. The resolution of the 
recorded data is independent of the resolution of the display, though: 
even if the channel is very thin or not visible on the screen, sampled 
data is recorded at full fidelity. 

High-resolution printing will show the selected waveform accurately. A 
print-out might not appear as smooth as the pen output of a standard 
electrocardiograph, say, precisely because it is at a higher resolution, 
but could easily be smoothed using Uromac’s off-line Smoothing 
function to give a more standard-looking result. 

It is important to check display settings carefully when examining a 
waveform, to be sure that what you are looking at is what you think 
you are looking at, especially if the settings on your machine might 
have been altered. A waveform may end up looking very strange if it 
has been stretched vertically, compressed horizontally, had a computed 
function applied, and then been smoothed! 
67



Chapter 4 Ñ Data Display
 68



Uroma

C H A P T E R  F I V E
5 Working With Files
c UserÕs Guide
Uromac recordings can be edited, printed, and saved to disk in 

various formats. This chapter describes these operations, and such 

features as creating a single Þle summarising results from many Þles, 

and saving settings to allow easy repetition of an experiment. Other 

topics covered include the transfer of data to other Macintosh 

applications and the use of comments and the Notebook. 
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Selecting Data
If you click in the Time axis, a blinking vertical line indicates the active 
point over all channels; if you click in a channel, the blinking line and 
active point are confined to one channel (Figure 5–1, top). An active 
point is distinct from a selected area, and is used for adding comments, 
transferring information to the Data Pad, and so on. Although you can 
copy a single data point to the Data Pad, you cannot copy it to the 
clipboard, save it as a file, or zoom in on it. 

To select an area of data in one channel, position the pointer and drag 
to highlight a rectangular area (Figure 5–1, bottom). The extent of 
vertical selection affects display in the Zoom and X–Y windows, but 
will not affect transfer of information to the Data Pad, printing the 
selection, or saving the selection as a file: these operations will use the 
full array of data points over the recording period of the selection. 
Command-drag to select the full height of a channel. 

To add channels to a selection, hold down the Shift key and drag in the 
display area of the channels you want: the vertical extent of the 
selected rectangle in other channels can be varied, but the horizontal 
extent will be the same as that in the first selected channel. (The 
recording period over which selections are made in multiple channels 
must always be the same.) Command-Shift-click in the display area of a 
channel you want to add, to select its full height. Option-Shift-click to 
select the same relative area of an added channel as in the first channel. 
This latter function takes into account any stretching or scaling of a 
channel’s Amplitude axis, making direct comparison of waveforms 
overlaid in the Zoom window easy. It only deals with the raw data, and 
does not take units conversion into account. 
Figure 5–1 
An active point (top) and a 
selection rectangle in a 
channel of the Uromac 
window
Figure 5–2 
Selecting data in multiple 
channels: left, from the Time 
axis; right, Shift-dragging in 
the channel you want to add
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▼ Refer
Display Control 
Checkboxes,  p. 61
To select all channels, position the pointer in the Time axis area: the 
pointer will change to a double-headed arrow. Drag in the Time axis 
area to highlight a rectangular area over all channels: Shift-click along 
the Time axis to extend the selection from the point at which you 
started to drag. Shift-click in the display area of a channel to deselect it. 
Double-clicking in the Time axis selects an entire block of recorded 
data (the whole file, if it is continuous). 

When there is a selection in the data display area, some of the menu 
commands available change to reflect this. In the File menu, the basic 
Print command changes to Print Selection…, and Save Selection… 
becomes undimmed. In the Edit menu, Copy Selection and Delete 
Selection become undimmed also. 

Deleting Data
There are two sorts of data deletion available when the Uromac 
window is active: you may clear a selected area of data for all channels, 
or you may clear all of the data recorded in a particular channel. (You 
cannot just delete an area of data in one channel.) These operations 
cannot be undone, so alert boxes ask you to confirm your decisions. If 
you do accidentally delete vital data, and you have saved the file 
previously, you should immediately close the file without saving the 
changes — the file will revert to the last version saved. You may lose 
some changes, but the data just deleted will be there on reopening the 
file. 

To delete an area of data common to all channels, drag along the Time 
axis to select the area corresponding to the period between two points 
on the axis. (This would be useful to delete stretches of a recording 
where nothing particularly interesting occurred.) Choose Delete 
Selection from the Edit menu, or press the Delete key. In fact, if there is 
any selection in the Uromac window in one or more channels, then 
these actions will clear the data block from all channels, subject to 
confirmation through the alert box. If there is only an active point 
rather than a selection in the Uromac window, then pressing the Delete 
key or choosing Delete Selection from the Edit menu does nothing. 

Because you have created a discontinuity in the record by deleting the 
recording over a specified period, a new block is formed, and marked 
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by a solid vertical line (unless this option is turned off in the Display 
Settings dialog box). 

To clear all of the data from a particular channel, choose Delete 
Channel… from the Edit menu. A dialog box appears, in which you can 
click the number of the channel from which you want to delete all 
data. The numbers for channels with no data are dimmed.

Transferring Data
It may be useful at times to transfer data from Uromac to other 
applications, such as a spreadsheet or drawing program. A file, a 
selection, or the contents of the Data Pad can be saved as a standard 
text file able to be opened by any application that can import text, such 
as a word processor, spreadsheet, or statistics package. (To do this, 
choose the Save As… menu command from the File menu.) 

You can also copy selected data from Uromac and paste it directly into 
another application. The Copy command in the Edit menu changes to 
indicate the options available when different windows are active. 

If the Data Pad is the active window, then you can copy all of it, or 
selected rows, to the Clipboard as text. (The menu command will be 
Copy All or Copy Selection, depending on what you have selected.) 

If either the Zoom or X-Y window is active, then the Copy command 
changes to Copy Zoom or Copy X-Y respectively. These commands 
copy the contents of the window to the Clipboard as a QuickDraw 
picture. This could be dealt with in a drawing application, if you 
wanted to use the extra features available to modify the picture for a 
presentation or display. 
Figure 5–3 
The Delete Whole Channel 
dialog box
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If the Uromac window is active and you select an area of data, Copy 
Selection is available in the Edit menu. It copies the data as text. When 
chosen, the Copy to Clipboard dialog box appears. 

Time. When the Time checkbox is selected, then the time at which 
each sample was taken is listed in addition to the data points 
themselves, preceding the channel data (as the first column in the file). 

Channels. The Channel Number buttons are used to select which 
channels are to be saved (and correspond to the numbers in the default 
channel titles). The buttons corresponding to channels containing no 
data will be dimmed. Highlighted buttons indicate which channels will 
be included in the text file (by default, all with data). Click the buttons 
to select or deselect channels. The data for channels will appear as 
columns in the text file, in numerical order, left to right, separated by 
tabs. 

Comments. When the Comments checkbox is selected, comments at 
any data point are included as the last column in the text. If there are 
no comments in the file, this option will be dimmed. 

Reduction. By default, the text selection includes a data point for every 
sample in the file. You might not want all this detail, for instance, if you 
have recorded something at a very high sampling speed, and there are 
too many data points for your graphing application to cope with. By 
entering a number other than 1 (the default) in the Reduction box, you 
can choose to use fewer samples. If you enter 2, the text file would 
include the data points for every second sample, if you enter 3, the text 
file would include the data points for every third sample, and so on. 
Figure 5–4 
The Copy to Clipboard dialog 
box
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Comments are not lost, even if the particular data points they were 
attached to are not included. 

The Clipboard

Whenever data is cut or copied from Uromac, it is stored in the 
Clipboard. You can choose Show Clipboard from the Edit menu to see 
what is copied: the Clipboard window appears. The Clipboard window 
is a normal window with a close box, size box, zoom box, and title bar, 
and can be moved around the screen or left in the background while 
the Uromac window is active. 

The Clipboard window shows either a representation of a picture (sized 
to fit the window), the text copied from the Data Pad, or a message 
indicating what has been copied from the Uromac window, depending 
on what has been copied. The Uromac window copying message is 
more helpful than an array of thousands of data points, since it 
indicates the file name, time parameters, and number of rows and 
columns — data points and channels — in the text. (Looking at the 
Clipboard in other applications will just show text.) 

If a very large selection is made, the process of copying may take some 
time. Just as occurs with a file being saved as text, a progress indicator 
and the percentage of the file currently copied as text is shown in the 
text box of the Tool Bar. To stop the process, type Command–period. 
Figure 5–5 
The Clipboard window after 
copying: right, Zoom; left 
bottom, Data Pad; left top, 
selection in Uromac window
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Saving Options
To save a file of recorded data, choose Save from the File menu, or 
type Command-S. When this is done, an already existing file will have 
any changes made to it saved to disk. The first time that you save a file, 
or on any occasion that you choose Save As… from the File menu, the 
Save As directory dialog box will appear. 

The directory dialog box allows you to navigate through the filing 
system of the Macintosh to choose where your file will be saved. (You 
should be familiar with this process; if not, see your Macintosh User’s 
Guide for directions.) Once you have typed in a name for the file and 
selected a file format from the File Format pop-up menu in the lower 
portion of the directory dialog box, you can then save the file by 
clicking the Save button. The formats are data file, settings file, and text 
file; and you also have the option of saving the data pad as a text file. 
You can save multiple copies of a file in any format or formats, if the 
copies have different names or are in different places. 

Data File

This format, the default, saves both data and settings (including 
macros). The file chronicles the entire recording, and is the usual way 
to save data. Opening a data file using the Open directory dialog box 
with the Load Data checkbox on opens the file, first closing any current 
file, since Uromac can open only one file at a time. 
Figure 5–6 
The Save As directory dialog 
box
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Settings File

This format does not save any recorded data, but stores the current 
settings. These include those that affect recording, such as the sampling 
speed, channel ranges, triggering, and stimulation settings, and those 
that affect the way the data looks, such as the window size, channel 
areas, display settings, and menu configuration. Macros are also stored 
as settings. 

Using settings files, you can build up a library of settings for many 
different experiments, to enable quick and easy preparation for 
recording. 

Settings files have a different icon from other Uromac files. Double-
clicking on a settings file icon from the Finder will automatically load 
the settings from that file into a new untitled Uromac file. Opening a 
settings file using the Open directory dialog box with the Load Settings 
checkbox selected loads the settings into the current file. 

Text File

This format saves data as a standard text file able to be opened by any 
application that can import text, such as a word processor, spreadsheet, 
or statistics package. Each sample recorded is stored as a row of data 
readings for each channel, separated by tabs and ending in a return 
character (that is, taking up a single line). When opting to save a 
Uromac file as a text file, the Save As Text File dialog box appears 
when you click Save: it allows you to choose how many columns of 
data you end up with, and what is in them. (It is almost identical to the 
Copy to Clipboard dialog box.) 
Figure 5–7 
The Save As Text File dialog 
box
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Note
The Translate application 
can translate Uromac, 
EMG/Scope, and text Þles 
into one another, and also 
into other program formats.
Time. When the Time checkbox is selected, then the time at which 
each sample was taken is listed as the first column in the file in 
addition to the data points themselves. 

Channels. The Channel Number buttons are used to select which 
channels are to be saved (and correspond to the numbers in the default 
channel titles). The buttons corresponding to channels containing no 
data will be dimmed. Highlighted buttons indicate which channels will 
be included in the text file (by default, all with data). Click the buttons 
to select or deselect channels. The data for channels will appear as 
columns in the text file, in numerical order, left to right, separated by 
tabs. 

Comments. When the Comments checkbox is selected, comments at 
any data point are included as the last column in the file. If there are 
no comments in the file, this option will be dimmed. 

Reduction. By default, the text file includes a data point for every 
sample in the file. You might not want all this detail, for instance, if you 
have recorded something at a very high sampling speed, and there are 
too many data points for your graphing application to cope with. By 
entering a number other than 1 (the default) in the Reduction box, you 
can choose to use fewer samples. If you enter 2, the text file would 
include the data points for every second sample, if you enter 3, the text 
file would include the data points for every third sample, and so on. 
Comments are not lost, even if the particular data points they were 
attached to are not included. 

The size of a text file is much greater than the size of the Uromac data 
file it is created from, and saving a data file as text can be slow. While a 
file is being saved as text, a progress indicator and the percentage of 
the file currently saved is shown in the text box of the Tool Bar. To 
stop the process, type Command–period: you get a text file with as 
much data as had been dealt with at the time you stop. Uromac cannot 
read text files, and so cannot open text files it has created or convert 
them back to their original data file format. 

Data Pad as Text File

The contents of the Data Pad can be saved as a standard text file able 
to be opened by any application that can import text, such as a word 
processor, spreadsheet, or statistics package. Each row in the Data Pad 
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becomes a line in the text file, with the contents of the column cells in 
the row separated by tabs. Empty columns are not included in the file. 
Titles can be added to the top of each column by using the Data Pad’s 
Add Titles command. 

Saving a Selection
You can choose to save a selected area of data instead of the whole 
file, allowing you to extract only the part of the recording that you 
need and place it into a new file. You can select one channel, all 
channels, or any combination of channels to be saved between any two 
points on the Time axis. 

If you have an area of data selected in the Uromac window, then the 
Save Selection… command is available in the File menu; otherwise it is 
dimmed and cannot be chosen. If you choose the command, then the 
Save Selection directory dialog box appears. 

This directory dialog box is similar to the Save As directory dialog box, 
except that you have a choice of only two file formats, data file and 
text file, from the File Format pop-up menu: the other options are 
dimmed. Once you have typed in a name for the file and selected a file 
format from the File Format pop-up menu in the lower portion of the 
directory dialog box, you can then save the file by clicking the Save 
button. 
Figure 5–8 
The Save Selection 
directory dialog box
 Files 78



Chapter 5 Ñ Working With
If you save the file as a text file, then the Save As Text File dialog box 
appears when you click Save (Figure 5–7). If there are any comments in 
the file, the Comments checkbox there will not be dimmed. If, 
however, none are in the selection, then a created text file will have 
tabs at the end of each line (since these would have preceded any 
recorded comments). Turn the checkbox off to prevent this. 

In conjunction with the Append feature, you could use the ability to 
save a selection for quick creation of new files containing summarised 
results from much larger recordings. 

Appending Data Files
This feature allows any Uromac data file to be appended to the end of 
an already open file in order to produce a single file with the desired 
contents. By combining this feature with Uromac’s ability to save 
selections of data as files, summary files can be created using only 
those segments of recordings that have significance. To append a file to 
an existing, saved file containing data, choose Append… from the File 
menu. The Append directory dialog box will appear. 

Select the Uromac file you wish to append to the currently open file 
(only Uromac files will be shown), and click the Open button to 
perform the operation. 

All comments will be copied across and renumbered, following on after 
the last comment in the original file. Most display settings in the 
Figure 5–9 
The Append directory dialog 
box
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appended file will not be copied across, but recording settings will be: 
different ranges for the channels, units set with units conversion, and so 
on will be retained. Each appended file is treated as a new block, with 
a solid vertical line drawn in, or a new scale if a channel’s range has 
changed. You can keep appending files to the currently open file as 
long as there is enough memory to perform the operation. 

Printing
Printing a Uromac file or parts of it will give you a hard copy of your 
data for use in write-ups of experiments, reports, presentations, and so 
on. There are three menu commands in the File menu concerned with 
printing: Page Setup…, On-Line Printing…, and the basic Print 
command (with a keyboard equivalent of Command-P), which changes 
depending on what can be printed at the time. 

Page Setup

The Page Setup dialog box that appears when you select the Page 
Setup… command will depend on your chosen printer. The user’s 
guide that came with your printer will explain most of what is involved. 
Choose the paper size that you will be using and so on. 

The default orientation for printing is Portrait (the left button, showing 
a man standing up). You need not change this: if you print a selection 
or a whole file from the Uromac window, Uromac itself alters the 
orientation to Landscape for you (without changing the selected 
button). Unless you have special printing requirements, you should 
leave Portrait as the selected orientation. 
Figure 5–10 
A Page Setup dialog box for a 
LaserWriter
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Faster printing on Urom
bit im

Uromac file
Uromac has four specific options in the Page Setup dialog box, below 
the dividing line. 

High-Resolution Printing

Checking this option allows you to print the Uromac, Zoom, or X–Y 
windows at the maximum resolution of the selected printer. For 
example, if you are using an ImageWriter, Uromac can print at 144 dots 
per inch (this is twice the 72 dpi the ImageWriter is rated for, since it 
can make two passes with the print head). If you are using a 300-dpi 
LaserWriter, Uromac will print with a resolution of 300 dots per inch. 
This will result in print of the best possible quality, but, since every 
data point and connecting line is drawn at full resolution, printing may 
be quite slow, especially for the Uromac window. 

Without high-resolution printing, the accuracy of positioning items on 
the page is limited to the 72-dots-per-inch resolution of the Macintosh 
screen. This is, however, adequate for drafts and overviews, and will 
result in quicker printing — especially for overviews where the file is 
horizontally compressed, since a lot of data must otherwise be drawn 
unnecessarily. We recommend that you use high resolution only for the 
final copy in most cases. 

Faster Printing

If Faster Printing is not selected, Uromac passes the recorded data to 
the printer driver, which generates either a set of QuickDraw 
commands for QuickDraw printers like the ImageWriter or StyleWriter, 
or a PostScript file for a LaserWriter or other laser printer with 
PostScript. If there are many data points in the file, the printer driver 
software has to work fairly hard at converting the data points into the 
appropriate resolution for printing, which can take some time. 

When Faster Printing is selected, Uromac attempts to speed up printing 
by creating a bitmapped image of the data to be printed. Since the file 
itself, the chosen resolution, the printer, and the type of Macintosh 
computer all have a bearing on the speed of the process, this will not 
always result in faster printing. You should try a few samples with your 
setup to establish relative speeds of printing using this method and 
printing normally. 

ac-generated 
age

Bit image to printer 
driver

Rasterised printer image 
(converted to dots)

QuickDraw or non- 
PostScript printer

PostScript printerPostScript data 
to printer

QuickDraw commands to 
printer driver

Faster printing 

Printer 
driver
Figure 5–11 
The Uromac printing process
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Note
For the fastest possible 
printing, ensure that you 
are using the latest printer 
driver, and turn off 
Background Printing in 
the Chooser.

▼ Refer
Printing Problems,  p. 168
When faster printing and high-resolution printing are both selected, 
Uromac determines the resolution of the selected printer and generates 
a bitmap at that resolution (otherwise, it just generates a 72-dpi 
bitmap). This rasterised image is then transferred to the printer directly 
rather than having to be converted to PostScript. The time saving can 
be quite significant on files with large numbers of data points, with little 
or no loss in resolution: it is possible, though, that it could take longer 
with some setups. Uromac must be given enough memory to image a 
page of data at high resolution. An alert box will warn you if memory is 
insufficient. 

Print Comments at the End of Uromac

When this option is selected, a numbered list of comments is printed 
following on from the end of the data print-out when you are printing 
a whole file or a selection. Only those comments in a selection will be 
included. 

Print Using Colour

Checking this option enables colour printing of your data. You can set 
up data display colours using the Display Settings dialog box. Some 
colours may not be supported by certain colour printers, or the colours 
actually printed may differ from those that appear on a colour monitor. 
Try a few samples with your setup to establish colour compatibility. 

The Print Command

If the Trigger, Stimulator, or Clipboard windows are active, the Print 
command is dimmed and cannot be chosen. In other circumstances, 
though, the command will be enabled and will appear in various 
incarnations depending on which is the active window and whether 
any data has been selected. Clicking the Print button in the Tool Bar is 
in all ways equivalent to choosing the basic Print command. 

Print Command Active Window What Prints

Print AllÉ Uromac The whole Þle

Print SelectionÉ Uromac The selected area

Print ZoomÉ Zoom Zoom window contents

Print XÐYÉ XÐY XÐY window contents
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Table 5–1 
Printing commands
Print All… prints the whole Uromac file, even if you specify a more 
limited printing range in the Print dialog box. When using a compatible 
continuous-feed printer such as an ImageWriter, this provides a 
continuous record just like that obtained from a mechanical Uromac 
recorder (a ‘page’ in this context really means the length of the Uromac 
record). Print Selection… prints the selected area in the Uromac 
window. If nothing, or just an active point, is selected in the Uromac 
window, then Print All… is the command available. If you have used 
the View buttons to compress a file horizontally (up to 2000:1), then 
the file or selection will print at the chosen compression. 

When printing the contents of the Zoom or X-Y windows, the Page 
Layout dialog box pops up first to let you adjust the size, location, and 
proportions of the image. Drag the image to reposition it on the page 
(the gray border shows where it will go), and drag the gray box at the 
bottom right of the image to adjust its size. You can also double-click 
the image to scale it to the maximum size that will fit on the page. If 
the Keep Shape checkbox is checked, then the image is scaled in 
proportion to its original dimensions (which depend on the Zoom or 
X–Y window settings), otherwise it can be reshaped at will. 

Print CommentsÉ Comments List of comments in Þle

Print Data PadÉ Data Pad Data Pad contents

Print NotebookÉ Notebook Notebook contents

Print Command Active Window What Prints

Drag 
the 
image 
to 
where 
you 

Drag the gray 
box to resize the 
image 

Turn off this 
checkbox to 
reshape the 
image
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Comments are printed out as a numbered list, with the numbers boxed 
as they are in the Uromac window. The Data Pad is printed out looking 
much like it does on screen, but empty columns are not included in the 
hard copy. The Notebook pages are also printed out much as they 
appear on screen. The Print dialog box allows you to print the entire 
contents of the Notebook, or any selected page range (Uromac will not 
print empty Notebook pages). 

All printed text will appear in the Geneva font, unless you have a 
PostScript LaserWriter and check Font Substitution in its Page Setup 
dialog box, in which case Helvetica will be used. If you are using the 
TrueType Geneva font in your System, the text will be printed at the 
maximum resolution of the printer on any printer. 

The Print dialog box that appears when you select the Print command 
will depend on your chosen printer. Note that while the Print dialog 
box allows you to select a page range, this works only for the 
Notebook: when you have chosen Print All…, for instance, this always 
prints the whole Uromac file. 

While the file is printing (or being spooled, if you are printing in the 
background) a small dialog box appears. Click its Cancel button to stop 
printing (or type Command-period or press the Return, Enter, or Esc 
keys). You can cancel from the Print Monitor too, of course (see the 
user’s guide that came with your Macintosh for details). 

On-Line Printing

Uromac can be set up to print out data at the same time as it is being 
recorded, giving you the advantages of a computer-based system and 
still giving you real-time hard copy as well. When using a compatible 
continuous-feed printer such as an ImageWriter, this provides a 
continuous record just like that obtained from a mechanical Uromac 
recorder. On-line printing is designed to give an overview, not to 
provide a high-resolution hard copy. You can print out sections of 
interest in more detail when you have finished recording. 

First, you should select an appropriate printer from the Chooser (Apple 
menu). You will need an ImageWriter or compatible printer directly 
connected to the Macintosh. Laser printers, or networked printers such 
as an AppleTalk ImageWriter, cannot be used. If you are using your 
Figure 5–12 
The Page Layout dialog box
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printer port for networking, then you should connect the printer to the 
modem (serial) port on the Macintosh. 

If you choose On-Line Printing… from the File menu, the On-Line 
Printing dialog box is displayed. With the appropriate printer chosen, 
this dialog box will allow you to turn on-line printing off or on, and set 
the printing rate. The Rate pop-up menu will show inches or 
centimetres per time division, depending on your system setup. When 
on-line printing is turned on, clicking the Start button in the Uromac 
window will start both recording and printing. 

On-line printing prints an overview while data is being recorded. The 
sampling speed must be reasonably slow. If the printer cannot keep up, 
it could start skipping data: if so, choose a slower sampling speed or 
compress the file using the View buttons. The printer’s built-in buffer 
may prevent skipping in the first minute or two, so you should let it 
run awhile to check if it can keep up. 

Comments
The comments feature allows you to annotate your recording, and 
provides a quick and accurate method of locating specific data points 
in a file. Comments are normally used to note, briefly, information 
specific to a particular time, channel, or data selection. (The Notebook 
allows you to make more general and extensive comments about the 
recording as a whole.) They can be edited in the Comments window. 

Adding Comments While Recording

During recording, comments can be entered as required, and are 
automatically numbered as they appear. Type in the text entry area at 
Figure 5–13 
The On-Line Printing dialog 
box
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▼ Refer
Adding Comments While 
Recording,  p. 21
the bottom of the Uromac window, and press the Enter or Return key 
to add the comment to the file at the time the key is pressed. 

By default, the comment applies for all channels: when this is the case, 
the numbered comment box is preceded by an asterisk. To comment 
on a specific channel, either press the Tab key (which selects the 
asterisk) and type the channel number, or click in the data display area 
of the channel: the number of the channel appears. To apply a 
comment to all channels again, press the Tab key and type 0, or click 
in the gray area at the bottom of the Uromac window (it replaces the 
Time axis during recording). 

Comments are stored and saved along with recorded data. Numbered 
comment boxes are inserted in the appropriate channel on the record, 
or along the Time axis, and marked by a dotted vertical line (unless 
these options are turned off in the Display Settings dialog box). 

Entering Comments After Recording

Comments can be added after recording. The comment is added at the 
active point or at the midpoint of a selection. You may choose at the 
outset to apply a comment to all channels or a specific one by clicking 
in the Time axis area or the channel of interest. Once an active point or 
area is selected, choose Add New Comment… from the Commands 
menu, type Command–K, or click the New Comment button in the Tool 
Bar. The Add New Comment dialog box appears. 

Channel the comment 
applies to (* for all)

Comment 
number box

Comment text 
entry area
Figure 5–14 
Comment entry during 
recording
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A comment can be typed (or pasted into) in the text entry box. For 
practical purposes, the text should not exceed 60 to 70 characters, since 
more than that will neither be clearly visible in the pop-up comment 
box nor print in full when a list of comments is printed. 

The Channel pop-up menu will indicate the position of the active point 
or selection area, but you can use it to change the channel the 
comment will apply to, or to apply the comment to all channels. Click 
the Add button, or press the Enter or Return keys, to add the comment 
to the file at the active point or the midpoint of the selection, in the 
channel shown in the pop-up menu. Comments are numbered in the 
order in which they are added, and not necessarily left to right across a 
file. 

Reviewing Comments

Once a recording had been made, you can read the comments in it by 
positioning the pointer over the comment box and pressing the mouse 
button (Figure 5–16). The pop-up comment box shows the number and 
text of the comment, as well as the time at which it is located along the 
Time axis. If you want to look at several comments at once, locate a 
comment in a large file, or delete or edit comments, you should use the 
Comments window. 
Figure 5–15 
The Add New Comment 
dialog box
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The Comments Window

To use the Comments window, choose Comments from the Windows 
menu. The Comments window is a normal window with a close box, 
size box, and title bar, and can be moved around the screen or left in 
the background while the Uromac window is active. It can be resized 
using the size box at its bottom right corner. Click the zoom box to 
toggle the window between the set size and the full size of the screen. 

The comments are listed down a scrolling field in the order that they 
appear left to right across a file (and so not necessarily in numerical 
order). The comment numbers appear in boxes, as they do in the 
Uromac window, with the box preceded by the number of the channel 
it applies to, or an asterisk if it applies to all channels. Use the scroll 
bar to the right of the window to go through long lists of comments. 

The Channel Number buttons at the top of the window allow you to 
choose which channels’ comments appear in the list, to help in 
searching in large files. The comments for channels with highlighted 
buttons appear (by default, all of them): click to deselect or reselect a 
channel. Comments applying to all channels always appear. 

The Show Times checkbox (on by default) precedes comments with 
the times that they appear. If you turn it off, the Time column does not 
appear: this might be useful to give more room if comments in the list 

Channel 
Number 
buttons

Channel 
the 
comment 
applies to 

Commen
t number 
box

Comment 
text
Figure 5–16 
General and channel-speciÞc 
comments, and the pop-up 
comment box
Figure 5–17 
The Comments window
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are truncated. If there is still not enough room for comments with Show 
Times off, use the size box to widen the window. The checkbox also 
determines whether times are included in the list of comments printed 
using the Print Comments… command or after a Uromac file.

Once a comment in the list is selected (by clicking it), then it may be 
edited or deleted, or located in the Uromac window. The pointer 
changes to an I-beam over text in a single selected row, and the text 
can be dealt with normally. The channel identifier, comment number, 
and time cannot be altered. If the Delete button is pressed, a selected 
comment is deleted. To delete multiple comments at the same time, 
Shift-click or Shift-drag to select contiguous comments, or Command-
click to select or deselect multiple comments individually. 

If a comment is selected and the Go To button is pressed, the comment 
is located and centred in the data display area of the Uromac window, 
which becomes active. This is very useful for locating commented 
features in the file. If you have multiple comments selected, as many as 
possible are fitted into the data display area, starting from the top of the 
list. If the data display area is split into two panes, comments are 
located in the right pane. 

Comment Numbering

When comments are deleted, the numbers for the remaining comments 
in a file do not change (this helps to prevent confusion when editing 
files). When a file is appended to another file, the comments in the 
appended file remain in the same order, but are renumbered following 
on from the highest comment number in the file to which it was 
appended. 

Identifying a Data Point

If the Marker is dragged to a comment box shown in the Uromac 
window and then released, the Marker will locate itself on a data point 
recorded at the exact time that the comment was made. If the comment 
is channel-specific, the Marker will be located on the waveform of that 
channel; if the comment applies to all channels, the Marker will be 
located on the waveform of the uppermost channel. 
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▼ Refer
Print Comments at the 
End of Uromac,  p. 82
Printing Comments

If ‘Print Comments at the End of Uromac’ is selected in the Page Setup 
dialog box, comments are printed following on from the end of the 
data print-out when you are printing a whole file or a selection. If you 
are printing a selection, only the comments that appear in that selection 
are printed. Comments are printed out as a numbered list, with the 
numbers boxed as they are in the Uromac window. 

When the Comments window is active, then the Print option in the File 
menu changes to Print Comments…, and if the command is selected, 
the contents of this window are printed rather than those of the 
Uromac window. Again, comments are printed out as a numbered list, 
with the numbers boxed as they are in the Uromac and Comments 
windows. Only those comments chosen for display in the Comments 
window will print, so you can select the range of comments you want 
printed using the Channel Number buttons. If the Show Times 
checkbox is off, then the times will not be printed. This is useful if you 
have long comments, since comment text longer than one line will be 
truncated (an ellipsis in the print-out indicates text not able to be 
printed). 

The Notebook
The Notebook resembles the Note Pad available in the Apple menu. It 
is just like an ordinary notebook attached to (and saved along with) a 
particular Uromac file. The Notebook allows you to make more general 
and extensive comments about the recording as a whole than you can 
with the Comments feature, which is normally used for briefly noting 
information specific to a particular time, channel, or data selection. To 
use the Notebook, choose Notebook from the Windows menu. 

The Notebook window is a normal window with a close box and title 
bar, and can be moved around the screen or left in the background 
while the Uromac window is active. 

The Notebook has a total of eight numbered pages that can be used for 
jotting down general notes about a file. Each page can contain up to 
32,000 characters, and you can scroll vertically through the contents 
using the up and down arrow keys on your keyboard. 
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Clicking the ‘dog-ears’ at the lower left of the window turns the pages 
back and forth. Click the Date or Time buttons at the bottom of the 
window to add the date or time to your notes at the insertion point. 
The commands Cut, Copy, Paste, and Clear can be used to edit text 
normally, although you cannot paste graphics into the Notebook. The 
contents of the Notebook window are saved with a particular Uromac 
file when you save that file. 

Printing the Notebook

When the Notebook window is active, then the Print option in the File 
menu changes to Print Notebook…, and if the command is selected, 
the contents of this window are printed rather than those of the 
Uromac window. The Print dialog box allows you to print the entire 
contents of the Notebook, or any selected page range (Uromac will not 
print empty Notebook pages). The pages are printed out as they appear 
on screen. You can copy the contents of the Notebook, page by page, 
to the Clipboard for pasting into a word processor if this is more 
convenient. 

Click here 
to move to 
next page

Click here 
to move 
back a 
page

Click this button to 
add the date at the 
insertion point

Click this button 
to add the time at 
the insertion 
point

Write your notes 
here
Figure 5–18 
The Notebook window
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Uroma

C H A P T E R  S I X
6 Data Analysis
c UserÕs Guide
The whole purpose of recording data, of course, is to Þnd things out 

through analysis of the recording. This chapter discusses the analysis 

options that Uromac provides. Many of the features discussed here are 

not applicable to the Uromac or Urodynamics but are discussed for 

completeness and consistency with other Acquidata software 

applications. Waveforms can be measured directly using the 

Waveform Cursor, to give direct or relative readings. Off-line 

functions such as smoothing can be applied to the raw data. A 

sophisticated and ßexible Data Pad calculates and stores statistics 

about recorded data. The XÐY window gives you a plot of data from 

one channel against that of another. A range of computed input 

functions can be applied to data as it is measured to give even more 

information. 
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▼ Refer
Cursor,  p. 120
Measuring From the 
Waveform
When you have finished recording, you can scroll though your data 
and make measurements directly from the recording — since 
everything is digital, you are given a direct read-out, with no chance of 
the measurement errors that could occur in analysing a paper-and-ink 
record. You can make direct or relative measurements. 

When the pointer is over the data display area (or Time axis), the 
Waveform Cursor for each channel tracks the waveform at the time 
position of the pointer. In this case, the Speed/Time display shows the 
time at the pointer location, and the Range/Amplitude display for each 
channel shows the amplitude of the waveform at the Waveform Cursor 
location. The Waveform Cursor only gives discrete measurements, 
jumping from data point to data point (you can see this more clearly in 
the Zoom window). It cannot provide a reading on the line that is 
drawn between the points for display purposes. 

The pointer appears as a cross over the data display area (or a double-
headed selection arrow along the Time axis). The Waveform Cursor’s 
shape is a cross by default, but can be changed in the file preferences 
to suit the waveform. 

Time at pointer 
(and Waveform 
Cursor) position

Amplitude at 
Waveform 
Cursor position

Pointer

Waveform 
Cursor
Figure 6–1 
Measuring waveform data
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Using the Marker

The Marker can be found in a box above the memory box, at the 
bottom left of the Uromac window. It is used to set a particular data 
point as a zero reference point, so that relative measurements can be 
made with respect to that point. 

To set the reference point, drag the Marker into the channel of interest; 
it will lock onto the waveform there when you release the mouse 
button. Or, if there is an active point in the Uromac window, choose 
Set Marker from the Commands menu to locate the Marker at the active 
point, either in a specific channel, or in the top channel if the active 
point extends over all channels. Use the Speed/Time and 
Range/Amplitude displays to help to select a data point. If you need 
finer control of where the Marker ends up, use the Zoom window to 
look at a selection in more detail: the Marker is duplicated there, and 
can more easily be assigned to a particular data point. 

If there is a selected area in the Uromac window, Set Marker will locate 
the Marker at the lowest point on the waveform in the selection (in a 
specific channel or the top one). This is useful in conjunction with the 
Data Pad Integral, to calculate the sum of data points relative to the 
lowest one. Double-clicking the Marker or clicking its box at the 
bottom left of the Uromac (or Zoom) window sends it back to its lair. 

Once the Marker is in position, measurements relative to it (preceded 
by ∆) are given in the readings for time in the Speed/Time display as 
the pointer is moved. The reading in the Range/Amplitude display for 
the channel where the Marker is located is also relative to the Marker, 
but the values at the Waveform Cursor positions for the waveforms in 
other channels are absolute. The ‘∆’ symbol before a value indicates 
that it is a difference, not a direct reading.

The Speed/Time display indicates if the pointer is not in the same 
block as the Marker, and if the block has a different scale or different 
units to the one the Marker is in, the Range/Amplitude display reads 
‘Not Valid’ as well.
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If the Marker is dragged to a comment box shown in the Uromac 
window and then released, the comment box will highlight and the 
Marker will locate itself on the data point recorded at the exact time 
that the comment was made, either in the channel of a channel-specific 
comment, or the top channel otherwise. (This does not work in the 
Zoom window.) 

Setting and Removing Baselines

The Set Baseline command is used for setting relative amplitude 
measurements where the voltage (amplitude) baseline of a channel is 
not zero. Once you have recorded a waveform, you may find that the 
baseline value is not zero volts (or set units) when it should be — that 
is, there is some slight offset. To remedy this, select an active point or 
area along the waveform where the measurement should be zero, and 
choose Set Baseline from the Commands menu. The value at that point 
or the average of the selection is set at zero, and scale units of the 
Amplitude axis change to show this. The position of the waveform in 
the channel display does not change: if you want it moved, simply drag 
the scale. 

The baseline is set for the particular block or blocks of data in a 
channel that the selection intersects. To set the baseline across the 
whole channel for all blocks of data, hold down the Command key 
while choosing Set Baseline from the Commands menu. 

Time at pointer 
position relative to 
Marker

Amplitude at 
Waveform Cursor 
position relative to 
Marker

Marker

Absolute amplitude (i
different channels to 
Marker)
Figure 6–2 
Measuring relative waveform 
data
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Remove Baseline removes a baseline previously set, and also affects the 
selected block or blocks of data in a channel. Holding down the 
Command key while choosing Remove Baseline from the Commands 
menu removes any set baselines across the whole channel. 

The Data Pad
The Data Pad is easy to use and provides a sophisticated and flexible 
means of analysis. In it, you can record up to 16 columns of data, either 
direct waveform values or calculated values from any channel, from 
active points or over selected areas. The Data Pad can store large 
amounts of data — up to 32,000 rows, with each row having a 
maximum of 255 characters over the 16 columns. Its contents can be 
saved as a text file or copied in whole or part to the Clipboard for 
transfer to another application. To bring up the Data Pad, choose Data 
Pad from the Windows menu.

The Data Pad window is a normal window with a close box, size box, 
and title bar, and can be moved around the screen or left in the 
background while the Uromac window is active. It can be resized using 
the size box at its bottom right corner. Click the zoom box to toggle the 
window between the set size and the full size of the screen. 

Cell button
Data on the 
current 
selectionColumn 

headings

Pop-up 
menu

Recorded 
data

Row button
Figure 6–3 
The Data Pad window
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Information on the current selection or active point is displayed 
immediately above and beneath the column headings: the readings 
beneath the column headings are separated from recorded data by a 
heavy line, and are centred rather than left-justified to help to 
distinguish them. As data is added to the Data Pad, new rows of values 
are created below existing rows in the data area. Use the scroll bars to 
move down or across through rows and columns. 

There are two tools that can be used to deal with the data in the pad, 
indicated by the buttons at the top left of the window. By default the 
Row tool is selected (and the leftmost button, with the pointer-like 
arrow, highlighted): in this case, the pointer changes to a heavy cross 
when over the data area. Click to select a row, Shift-click or Shift-drag 
to select contiguous rows, or Command-click to select or deselect rows 
individually; the data can then be cleared, or cut or copied to the 
Clipboard as tab-separated text, using the commands in the Edit menu. 
If the Cell button (with the A) is clicked, the pointer changes to an I-
beam when over the data area, and text in each cell can be edited in 
the normal way. Clicking the Cell button deselects all selected rows. 

The pop-up menu to the right of the window allows you to add blank 
lines (rows) to the Data Pad, or to add the current column headings to 
it as three lines — useful to keep track of changed settings, or when 
transferring data to other applications. (Superscripts and subscripts in 
column headings are converted to plain text when added to the Data 
Pad.) You can also choose whether or not to save the Data Pad settings 
when a new file is opened: a tick appears beside this menu command 
when it is active. It applies only to the current file. 

The width of columns can be changed to suit the displayed data and 
headings. You might want to narrow columns to display more on 
screen, for example, or have a wide column to the right in which to 
add comments. Position the pointer on the heavy dividing line between 
column headings, so that it changes into the resizing pointer, drag until 
the column is the desired width — a gray line appears, to indicate 
position — then release the mouse button.

Adding Data to the Data Pad

To add data on a selection in the Uromac window to the Data Pad, 
choose Add to Data Pad from the Commands menu, or type Command-
D. As a shortcut, you can double-click in the data display area to 
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transfer data at a point (double-clicking in the Time axis selects a block, 
though, and transfers no data). Data can be transferred from the Zoom 
window; the magnification it provides may prove useful in locating 
particular data. The data at the position of the pointer is transferred 
(you cannot select an area in the Zoom window). 

The data recorded will depend on the choices made in the Data Pad 
Column Setup dialog box. By default, the first eight channels are set to 
record the mean of a channel (this will be the value of a data point on 
the waveform when there is an active point rather than a selection), 
and the other eight are blank.

Setting Up the Columns

As previously noted, the data recorded will depend on the choices 
made in the Data Pad Column Setup dialog box. This dialog box 
appears on clicking a column heading, and will have the column 
number (1–16) in its title. 

To move to the dialog boxes of adjacent columns (and set up many 
columns quickly), click the arrows by the dialog box title, or press the 
right or left arrow keys on the keyboard. The channel that data is taken 
from is selected in the Channel pop-up menu at the right of the dialog 
Figure 6–4 
The Data Pad Column Setup 
dialog box
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Note
Other functions may be 
added to the Data Pad 
through Uromac 
extensions.
box. Two scrolling lists let you select from the many forms of 
information that could be recorded, whether derived or direct. The left-
hand list gives the general information type, and the right-hand one 
options available in that set. The selected option is briefly explained in 
a box beneath the two lists. 

Off simply turns the column off: no data is recorded in it. 

General Statistics offers calculation of the mean, standard deviation, 
standard error of the mean, and various integrals of the selection. The 
value of the largest and smallest data points in the selection (and the 
difference between them), the times at which they were recorded, and 
the number of data points in the selection can also be obtained.

Selection Information, if there is a selection, obtains its start time, 
end time, and duration.

Cursor & Comments gives the time and value of the active insertion 
point, if there is one. It also provides comments, comment numbers, 
numerical values within comments, and comment times at or to the left 
of the active point; if there is a selection, it works left starting from the 
right edge of the selection. 

Slope gives the maximum and minimum slopes of a selected area of 
the waveform, and the average slope of a selection (the first 
differential), or the slope at the active point.

Block Information gives general information about the block 
containing the active point or selection. If a selection straddles two or 
more blocks, then the selection will be noted as discontinuous. 
Otherwise, the range used when recording the block, the time between 
samples when recording, and the block number can be provided, 
together with the total time taken to record the block, the total number 
of samples in the block, and the time of day and the date at the start of 
the block. 

The three radio buttons indicate when data is to be recorded. If the top 
one is selected, then if there is any data selected in the Uromac 
window, information will be recorded about the channel selected in the 
Channel pop-up menu (if you have selected an area in Channel 2, 
information on Channel 3 might still be recorded, for instance). If the 
middle radio button is selected, information is recorded about the 
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column channel only if that channel is included in the selection. If the 
bottom radio button is selected, information is recorded only about the 
lowest-numbered channel if more than one is selected (Channel 2 if 
channels 2 to 4 are selected, for example). Data transfer from the Zoom 
window is always as if the top radio button were selected, regardless of 
the settings. 

The Compact Data checkbox works in conjunction with the middle 
radio button: if you select data from different channels at different 
intervals after the same stimulus, for instance, it will place all the data 
on the same line in the Data Pad (if the checkbox is off, then each 
entry will be recorded on a new line). 

Its various functions make the Data Pad very useful for quickly finding 
out information about a file or blocks in it: you can leave the Data Pad, 
set up to display the required information, as a small visible 
background window that will be constantly updated. 

In addition, miniwindows can be created to display the current values 
of statistics or measurements set up in particular columns from the Data 
Pad. Click the Miniwindow checkbox in the Data Pad Column Setup 
dialog box to show or hide the miniwindow for a column, or drag a 
column header to tear it off. Drag the miniwindow by its title bar to 
where you want it on the screen, click the close box to dismiss it, or 
click its body to bring up the dialog box again. 

Printing

When the Data Pad window is active, then the Print option in the File 
menu changes to Print Data Pad…, and if the command is selected, the 
contents of this window are printed rather than those of the Uromac 
window. The Data Pad will print across two or more pages if it is wide 
enough, but individual columns will remain intact. 

The X–Y Window
By using the X–Y window, you can plot data in one channel against 
that of another over the same period of the recording. To bring up the 
X–Y window, drag in the Time axis to select an area of interest (over 
two or more channels) in the Uromac window, and then choose X–Y 
Window from the Windows menu. 
Figure 6–5 
A Data Pad Value miniwindow
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The X–Y window is a normal window with a close box, size box, and 
title bar, and can be moved around the screen or left in the background 
while the Uromac window is active. It can be resized using the size box 
at its bottom right corner. Click the zoom box to toggle the window 
between the set size and the full size of the screen. The Channel 
Number buttons at the bottom left (horizontal x-axis) and right side 
(vertical y-axis) of the window correspond to the numbers in the 
default channel titles. Buttons for channels not included in the 
selection, or without data, appear dimmed. The highlighted Channel 
Number buttons indicate which two channels are used in the plot: the 
bottom one provides the x-values, and the one on the right the y-
values. The channels plotted against one another can be changed by 
clicking the (undimmed) numbered buttons, whereupon the buttons of 
the newly selected channels will be highlighted.

The values along the x-axis (Vx) and y-axis (Vy) at the pointer position 
are indicated at the top of the window, in volts or the units set by units 
conversion. (The waveform is not tracked: there is no Waveform 
Cursor.) 

Y channel

Channel 
Number 
buttons

X and Y 
values at 
the pointer 
position

Pointer

X channel
Figure 6–6 
The XÐY window
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▼ Refer
Display Settings,  p. 59
The X–Y window will appear gray if no channels are selected in the 
Uromac window or if no Channel Number buttons are selected. The 
X–Y window does not indicate if the selection in the Uromac window 
is discontinuous (straddling two or more blocks), but the X–Y plot will 
probably look strange if it is. The pattern or colour for the waveform is 
chosen in the Display Settings dialog box. 

Printing the X–Y Window

When the X–Y window is active, then the Print option in the File menu 
changes to Print X–Y…, and if the command is selected, the contents of 
this window, rather than the Uromac window, are printed. 

Off-Line Functions
There are two off-line functions available in the Channel Function pop-
up menu, Absolute Value and Smoothing. Neither replaces the raw 
data: the unaltered waveform can be retrieved at any time simply by 
choosing Raw Data from the pop-up menu. A tick beside the menu 
command shows which is in operation (only one can be at any time). 
While recording, neither function applies or can be applied, but if one 
is chosen, it takes effect when recording ceases. 

Absolute Value

Any channel can be set to display the absolute value of a waveform 
rather than the positive and negative values by choosing Absolute Value 
from the Channel Function pop-up menu. This function applies to the 
entire record length of the channel. 

Smoothing

Data can be smoothed in any channel, allowing the removal of 
unwanted high frequencies, noise, or clutter in the waveform. Data 
smoothing applies to the entire record length of the channel. 

To use data smoothing feature on a particular channel, choose 
Smoothing… from the Channel Function pop-up menu. The Off-Line 
Smoothing dialog box appears: you can then type in the degree of 
smoothing, from 1 to 20, in the text entry box. The larger the number 
Figure 6–7 
A waveform (top) and its 
absolute value(bottom)
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entered, the greater the smoothing performed. Smoothing will affect 
different waveforms in different ways: quickly changing waveforms 
cannot be smoothed too much without distortion, but those that change 
slowly can be smoothed a lot more. 

Computed Input
By default, Uromac records the raw signal and does not apply any 
computed function. Sometimes, though, some derivation of the raw 
data is of more interest, or can throw more light on the original signal. 
For instance, it might be more useful to record the rate at which a heart 
beats rather than the heartbeat waveform itself. Uromac has a number 
of powerful computed input functions that allow on-line data 
processing before a signal is recorded. 

The Computed Input dialog box lets you set up on-line data processing 
of various sorts for each channel. The current input signal and the 
computed function are both displayed for optimal settings adjustment. 
The Computed Input dialog box appears when you choose the 

Original waveform with no data smoothing

Increasing the 
number in the 
Amount box 
increases the 
number of 
points used to 
smooth the 
waveform

Off-line 
Smoothing 
dialog box
Figure 6–8 
The effects of data smoothing 
on waveforms
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mputed Function
p-up menu
Computed Input… command from a Channel Function pop-up menu. 

The channel that it applies to is indicated at the top left of the dialog 
box (Display 2 for Channel 2, for example). 

The dialog box has two main areas: the left side shows the signal 
display for the raw data (similar to that in the AcquiAmplifier dialog 
box), and the right shows the signal display for the computed input. 
Initially the right display is gray, and few controls appear; if something 
other than Raw Data is chosen from the Computed Function pop-up 
menu, then computed input is active, the calculated signal is shown in 
the right signal display area, and more controls are available. Different 
functions have slightly different controls. 

Sampling Speed

Computed input functions cannot be used at sampling speeds faster 
than 2000 samples per second. Otherwise computed inputs are 
independent of the sampling speed: to maintain accuracy, all are 
calculated from data taken at 2000 samples per second and then 
averaged in the Acquidata to give results at the sampling speed set for 
Uromac from the Speed pop-up menu.

Signal Displays

The raw and processed input signals are displayed so that you can see 
the effect of changing the settings — no data is actually recorded when 
setting up computed input. The current signal value is displayed at the 
top left of each display area. Slowly changing waveforms will be 
represented quite accurately, whereas quickly changing signals will be 
displayed as a solid dark area showing only the envelope (shape) of 
the signal formed by the minimum and maximum recorded values. 

You can shift and stretch the vertical Amplitude axis of each signal 
display to make the best use of the available display areas. Apart from 
being at the right, each is the same as the Amplitude axis in the 
Uromac window, and the controls function identically; the Scale pop-
up menu to the right of each axis is also the same as in the Uromac 
window. 

Co
po

Choose the raw 
data channel here

Sensitivity 
control

Threshold 
control

Channel number for 
the computed display
Figure 6–9 
The Computed Input dialog 
box Ñ click OK to apply the 
changes to the channel in the 
Uromac window
Figure 6–10 
The Computed Input dialog 
box (right side) with an 
integral function selected
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Raw Data Controls

The Raw Data Channel pop-up menu lets you choose any Acquidata 
input channel as the source signal on which computations are 
performed. You may want to use one channel to display the computed 
input and another the raw data, to compare the two, or you may want 
to display only the computed signal. In this case you would choose the 
same channel for raw data as computed input: only the processed 
signal would be recorded in Uromac, and the raw data would not be 
available for further analysis. 

Clicking the AcquiAmplifier… button brings up the AcquiAmplifier 
dialog box, allowing convenient access to filtering options, the display 
offset, and so on for the raw data signal.

The Range pop-up menu lets you select the input range of the channel 
to get the best signal display. Changing the range in this dialog box is 
equivalent in all respects to changing it in the Uromac window: the 
pop-up menu is duplicated here for convenience. 

The Threshold and Sensitivity and the Baseline Tracking controls are 
available when one of the rate functions (Ratemeter, Period, Frequency, 
and Counter) or cyclic functions (Cyclic Mean, Cyclic Minimum, and 
Cyclic Maximum) is selected. 

Threshold and Sensitivity

The Threshold control sets the minimum level at which the signal will 
trigger the computed input for a rate or cyclic function. The incoming 
signal must cross through the threshold level in order to register an 
event. The Sensitivity (or hysteresis) control allows you to adjust how 
sensitive the trigger is to small signal fluctuations. 

The Threshold control is initially set to zero: if the signal has a lot of 
noise in this region, it is best to move the trigger away from zero. You 
can drag the Threshold control up or down to change its settings — a 
gray box and line appear, to indicate where it will go. When the box 
and line are in the desired position, release the mouse button to apply 
the new settings. 
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Threshold control

Sensitivity control
The Sensitivity control is automatically moved with the Threshold 
control. It can itself be dragged up to adjust the sensitivity bandwidth 
symmetrically above and below the threshold level — again, a gray box 
and line appear. When the box and line are in the desired position, 
release the mouse button to apply the new settings. A highlighted area 
indicates the hysteresis region. For a signal to trigger the computed 
input function, it must go above the highlighted area and cross back 
through it: a signal remaining within the region will not trigger the 
computed function. 

Once the incoming raw data signal is stabilised for rate and cyclic 
functions, a threshold and hysteresis should be defined. Because the 
signal is periodic for functions where this applies, it doesn’t matter in 
most cases where the threshold is, because it will occur in the same 
place in each cycle, but it is best to move the trigger if there is a lot of 
noise around zero, or if the repeating waveform has multiple peaks. 

Baseline Tracking

Baseline tracking is used to remove any constant or slowly changing 
signal from the raw data before triggering is applied. In effect, it acts as 
a variable-frequency high-pass filter, ensuring that the threshold and 
sensitivity settings follow the waveform. It works by applying a 
sophisticated averaging technique to the raw data and then subtracting 
the result to modify the signal. The amount of averaging depends on 
the Baseline Tracking radio button selected (Slow gives a little, Fast 
gives a lot). The modified data is shown in the data display. 

Figure 6–12 shows the differences at slow and fast tracking speeds 
when applying a sudden change to the input signal. The signal is 
outside the trigger band for much longer with slow tracking selected. 

Valid trigger pulse

Hysteresis region

Noise
Figure 6–11 
Using the Sensitivity control to 
stop noise triggering the 
computed input
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When using the faster baseline tracking settings, the shape of the signal 
may become distorted, but because data is only being used for 
triggering when baseline tracking is available, the distortion does not 
affect calculation accuracy. Figure 6–13 shows the distortion of a square 
wave when fast tracking is selected. 

The gray data limit area that can appear at the top and bottom of the 
data display area indicates the full scale of the Acquidata input at the 
current range setting. If the gray area moves down and meets the 
signal, the channel input amplifiers are overloaded (this is the same as 
having the signal go off scale in the AcquiAmplifier dialog box). If this 
occurs, you should select a higher input range value. 

In general, the baseline tracking rate should be set as fast as is possible 
without decreasing the reliability of triggering. 

Computed Input Controls

The Computed Function pop-up menu gives the range of available 
functions. Raw Data is the unprocessed signal. The other functions are 
in four groups: rate (Ratemeter, Period, Frequency, and Counter); cyclic 
(Cyclic Mean, Cyclic Minimum, Cyclic Maximum, and 1/3Max+2/3Min); 
envelope (Envelope Minimum and Envelope Maximum); and calculus 
(Differential and the five forms of Integral: normal Integral (∫), ∫ 

Data 
limit area

Slow tracking Fast tracking

Data 
limit area
Figure 6–12 
Applying a sudden change to 
the input signal at slow and 
fast tracking speeds
Figure 6–13 
A square wave (left) distorted 
at fast tracking speeds (right)
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Absolute Value, ∫ Positive Only, ∫ Negative Only, and ∫ Reset Each 
Cycle). They are discussed in detail below.

The Units and Range controls are available when one of the rate or 
calculus functions is selected, and the Average control is available when 
Ratemeter, Period, or Differential is selected. The Time control is 
available when one of the integral functions is selected, with the 
exception of ∫ Reset Each Cycle, and the Reset control is available for 
all of the integral functions.

Clicking the Units… button brings up the Units Conversion dialog box, 
allowing you to change the given units for the computed channel to the 
units of your choice. The waveform currently in the right data display 
area is transferred to the data display area of the Units Conversion 
dialog box. The units conversion will only apply to subsequently 
recorded signals, so it is more limited than choosing units conversion 
directly, since you cannot convert individual blocks of data. Units 
conversion is performed on the computed data, not the raw data. 

The Range pop-up menu lets you select the input range of the channel 
to get the best signal display. Changing this range is the same as 
changing it normally, except that the range applies to the computed 
signal, and the numbers and units may be different: the Range pop-up 
menu in the Uromac window duplicates this one when a computed 
function is selected. 

The Average control allows smoothing of the data when you want to 
see a trend in a Ratemeter or Period waveform rather than sample-by-
sample changes. Click the up and down arrows to increase or decrease 
the averaging: the sequence is 1, 2, 4, 8, with 1 being none. The 
Average control is also available for the Differential computed function, 
with the sequence reaching 64. The control works by averaging the 
values of the preceding samples (you specify how many data points), 
and so may give rise to a slight phase shift in the waveform, especially 
with the Differential function. 

The Time control allows you to choose, for the integral functions, the 
time at which the computed input resets to zero. (For periodic waves, 
resetting corrects for cumulative errors.) If the checkbox is unchecked, 
the text box is dimmed and inactive; otherwise you can enter a value of 
up to 3600 seconds. The figure you enter is rounded off to match the 
nearest number of samples when used: if you sample at 10 samples per 
Figure 6–14 
The Computed Function pop-
up menu
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second, then the reset could be up to 10 times every second (the time 
value would be 0.1 seconds). If the time value entered is much smaller 
than the sampling speed, it will be rounded down to zero, and no 
resetting will be performed. 

The Reset button, next to the Cancel button at the bottom of the 
Computed Input dialog box, resets the signal in the computed input 
data display area to zero when clicked. It is only used for convenient 
zeroing of the display while in the dialog box. 

Computed Input Functions

Ratemeter

The Ratemeter function gives output in beats per minute (BPM) up to 
2000 BPM, and is suitable for lower-frequency periodic signals such as 
heartbeats and the like. The Ratemeter function calculates the 
waveform period (see below) and then works out the reciprocal and 
does some scaling. 

Since the period is the difference between valid triggering signals, if 
triggering is lost, then the period will get larger. In this case, the period 
is constantly updated to show that it is currently at least a certain 
length. The computed signal thereupon falls exponentially (since it is 
based on the reciprocal of the period), which gives an indication that 
triggering has been lost: if just a straight line were presented, 
continuing to show the last valid rate, it might be assumed incorrectly 
that things were still all right. 
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Period

This computed function is basically the ratemeter without the 
reciprocal, and gives information about the period behaviour of a 
waveform. Note that the measurement is independent of where the 
trigger point is in the cycle (Figure 6–17, left). 

Since the period is the difference between valid triggering signals, if 
triggering is lost, then the period will get larger. In this case, the period 
is constantly updated to show that it is currently at least a certain 
length, and will increase until the maximum period for the set range is 
reached. Period can be more a useful measure than frequency for 
waveforms with very slow cycles, such as waves in water or earth 
tremors. 

Frequency

The Frequency function measures the frequency of the waveform in 
hertz (cycles per second) up to 2000 Hz, and is suitable for measuring 
periodic signals of higher frequency than those for which the Ratemeter 
is used. The calculation is done in a different manner than it is for the 
Ratemeter, to ensure accuracy. The Frequency function works by 
breaking each second into 20 ‘bins’. Each time the threshold is crossed 
from lower to higher, the count in the current bin is increased by one. 

period period
Figure 6–15 
Ratemeter: left, the raw data 
(a heartbeat); right, the 
computed input in BPM
Figure 6–16 
Loss of Ratemeter triggering 
signal: left, raw data; right, 
computed input
Figure 6–17 
Period: left, raw data (showing 
two threshold settings); right, 
computed input for the same 
waveform
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(That is, it counts the number of times the signal crosses the threshold 
in one direction every 0.05 seconds.) Uromac shows the sum from the 
last 20 bins. This gives a faster and smoother result than if summing 
were just done for one second. 

For example, if recording a 100 Hz signal that changed to 200 Hz over 
one second, you would see the frequency gradually changing from 
100 Hz to 200 Hz. If results were summed over one second, you would 
just see a jump from 100 Hz to 200 Hz, with an intermediate value (the 
average of the two signals). 

Counter

The Counter function just counts transitions from below to above the 
threshold, displaying up to 2000 registered events versus time. It wraps 
back to zero when it gets to 2000 counts, regardless of the current 
range. If you set the range to 200, for example, then when the count 
exceeds 200, the waveform will disappear and will not reset to zero 
until the count reaches 2000. This function has a number of useful 
purposes, for instance tallying the radiation blips registered by a Geiger 
counter. 

Cyclic Mean

The Cyclic Mean function sums the data points between two successive 
threshold transitions and divides by the number of points summed. This 
calculation is only useful for cyclic signals, say, for determining the 
displacement in mean blood pressure or respiration rate. The threshold 
controls where the mean starts and ends, but because the input is a 
cyclic wave, the result should not depend on threshold position. Only 
when the waveform has some other periodic signal superimposed on it 

1 second 1 second

Change from 100 to 200 Hz Change from 100 to 200 Hz
Figure 6–18 
Frequency: left, the gradual 
change used by Uromac, 
right, if summation were 
coarser
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does the actual threshold affect accuracy of calculation. The results you 
get from the cyclic mean are the same as if you selected an exact 
period of the raw data and integrated that selection. 

Note that in Figure 6–19, the threshold is in different places so the 
summing starts and ends at different times, but the result from each 
summing is the same. It would be much better with this waveform to 
leave the threshold setting in the centre of the waveform, because it 
will stay correct even if the amplitude of the signal changes slightly. In 
the right-hand example, if the amplitude were much smaller, the 
triggering would be lost.

Cyclic Maximum and Minimum

In the Cyclic Maximum function, the trigger threshold is used to identify 
cycles. At the end of a cycle, the maximum data point found within that 
cycle is shown until another cycle has been measured. The Cyclic 
Minimum function works similarly except that the minimum value of a 
cycle is found, and displayed during the next cycle. These functions are 
useful for displaying the cycle-by-cycle minimum or maximum values 
for quantities such as diastolic or systolic pressure. 

1/3Max+2/3Min

The 1/3Max+2/3Min function adds, for each cycle, one third of the 
maximum amplitude of the waveform to two thirds of the minimum, to 
give a form of approximate weighted mean. This is used in cardiology, 
where the waveforms tend to have a certain shape: an initial high 
spike, some smaller troughs and peaks, and a flat plateau of variable 
duration (it puts less emphasis on the spike and ignores the plateau). 
This function should not be confused with a true mean. 

Area of summing (shaded)
Figure 6–19 
Cyclic Mean: summed area 
for different thresholds
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With modern computer-based systems such as the Acquidata system, 
sophisticated area analysis of the peaks (using integral functions) can 
be performed to get more useful and accurate information. The main 
reason to use a rough-and-ready function like 1/3Max+2/3Min is for 
quick initial estimates, and compatibility with historical results and 
results calculated by those unlucky enough to be working by hand. 

Envelope Maximum and Minimum

Envelope Maximum stores the maximum data point since the last time 
it sent data to the Macintosh (the time depends on the sampling speed 
set by the user), and sends it at the end of that time. For example, if the 
user had set a sampling speed of one sample per second in Uromac, 
then the maximum value of the samples in the previous second would 
be shown each second in the display. Information is not required about 
cycles or periods in the incoming data, so the triggering controls don’t 
appear. 

The Envelope Minimum function works similarly except that the 
minimum value over a time is found, and displayed during the next 
time period. These functions are designed for recording signals near or 
above the Acquidata sampling speed. They are useful if the specifics of 
the signal are of no interest, but the maximum or minimum is 
important. For instance, this could be used to record the temperature of 
a procedure to see if a critical temperature had been exceeded, thus 
changing reaction conditions. 

period

Maximum from previous cycle
Figure 6–20 
Cyclic maximum: the largest 
value obtained by the 
waveform in the previous 
cycle is retained
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Differential

The Differential function gives the first-order derivative of a selected 
channel’s waveform. It is useful when the slope, or rate of change, of a 
signal is more informative than the raw signal itself. For instance, the 
volume of fluid in a container could be measured as it is collected, 
using a force transducer to record pressure. The differential of this plot 
would give the rate of change of volume, that is, the flow rate. 

The Differential function is particularly sensitive to noise, so the data 
smoothing provided by the Average control has been made more useful 
by extending it beyond that offered for Ratemeter or Period functions, 
with your choice of 1, 2, 4, 8, 16, 32, or 64 preceding samples being 
averaged. 

Integral

The Integral measures the area under a waveform, the cumulative sum 
of the data points. The ∫ Reset Each Cycle resets the integral to zero 
every time the original waveform passes through zero from below; 
other integrals reset the integral to zero after the time set in the Time 
control box. Additionally, all integrals reset to zero when they reach the 
positive or negative limits set by the Range control. 

Time between Acquidata samples

Maximum from time between previous Acquidata samples

Acquidata sample times
Figure 6–21 
Envelope maximum: note the 
Acquidata sample times are 
independent of the waveform 
period
Figure 6–22 
Differential: the derivative of a 
triangular wave (left) is simply 
a square wave (right)
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The integral is available in five forms, each of which is useful for 
particular purposes.

Integral (∫). This, the normal integral, simply sums the data points 
under a waveform over time. The integral over a time with equal 
positive and negative summed values would be zero. It is useful, for 
instance, to calibrate the void volume and flow transducer.

∫ Absolute Value sums the absolute values of the data points under a 
waveform over time. The integral over a time with equal positive and 
negative summed values would be double the summed values of either. 
It could be used with a spirometer to measure the total volume of air 
passing through the lungs during exercise. 

∫ Positive Only sums the positive values of the data points under a 
waveform over time. The integral over a time with positive and 
negative data points would only include the summed values of the 
positive data points. It could be used with a spirometer to measure total 
expired air in a respiratory cycle.

∫ Negative Only sums the negative values of the data points under a 
waveform over time. The integral over a time with positive and 
negative data points would only include the summed values of the 
negative data points. It could be used with a spirometer to measure 
total inspired air in a respiratory cycle.

∫ Reset Each Cycle, like the normal integral, sums the data points 
under a waveform over time. The integral over a time with equal 
positive and negative summed values would be zero. It also resets the 
integral to zero every time the original waveform passes from below to 
above zero, so it is particularly useful for periodic waveforms liable to 
drift with time. (This would compensate for calibration errors or 
condensation in the flow head of a spirometer, for instance.)

The 
volume 
calculated 
from flow 
using the 
integral
Figure 6–23 
Using the Integral computed 
function to calibrate a 
spirometer to a volume
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The integral functions could be used for many other purposes, of 
course: take a circuit with a capacitor, resistor, and two diodes with 
different polarity, with an AC current input. The integral would show 
the charge stored in the capacitor with time. The positive and negative 
integrals would each show the current passing through one of the 
diodes. The square of the absolute integral would indicate the heat 
generated in the resistor. The resetting integral would be useful to 
compensate for a DC component in the current.
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Urom

C H A P T E R  S E V E N
7 Customising & 
Automating Uromac
ac UserÕs Guide
Uromac offers extensive means to customise and to automate 

functions, greatly increasing its convenience and ease of use. It can be 

simpliÞed or modiÞed by locking, hiding, or altering controls, menus, 

and menu commands. Macros can be created to speed up and to 

automate complex tasks, and added to menus or the Tool Bar; and 

new menus can be created. A time schedule can be deÞned to control 

recording, voltage output, and so on. External devices can be 

controlled, and comments inserted automatically in response to 

external stimuli, using digital output and input. Uromac extensions 

are available to add extra functionality to Uromac. 

This chapter looks in detail at Uromac preferences, customising 

options, and recording automation and control functions. 
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Preferences
The various options in the display settings and recording controls allow 
basic customising of Uromac. You can also choose to lock, hide, or 
alter controls, menus, and menu commands (and their keyboard 
equivalents). 

The Preferences submenu in the Edit menu contains five menu 
commands, Tool Bar…, Cursor…, Menus…, Controls…, and Start-Up…, 
allowing you to manage various aspects of Uromac performance and 
display. 

Cursor

Cursor… simply allows a choice of Waveform Cursor. On selecting the 
submenu command, a dialog box presents you with four choices of 
cursor shape: the default shape is highlighted with a heavy border. 
Click one of the cursor shape buttons to choose a cursor shape that is 
easy to see when tracking the waveform. Click the OK button to apply 
your choice. 

Tool Bar

On selecting the Tool Bar… submenu command, a dialog box lets you 
choose whether the Tool Bar appears, which buttons appear in it if it is 
visible, and how they are arranged. Initially, the Visible scrolling list 
displays all the standard buttons that appear, and the Hidden scrolling 
list displays, for all available macros, the name of the menu that the 
macro is in, a colon, and the name of the macro. Names that are too 
wide are truncated: an ellipsis (…) replaces extra characters. 
Figure 7–1 
The Waveform Cursor dialog 
box
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Turning off the Show Tool Bar checkbox hides the Tool Bar. This is 
useful if you don’t have much room on your screen. 

The order of items from top to bottom in the Visible scrolling list 
indicates the order of buttons from left to right in the Tool Bar. A 
separator (dotted line) in the list adds a space between buttons, so that 
buttons with similar functions can be logically grouped. 

Items can be moved to alter the default arrangement. Just drag an item 
by its title (to the left of the vertical bar) to move it. The pointer 
changes to an arrow-headed cross, and as you drag, a gray outline 
indicates where the item will go. When items are moved to or about in 
the Visible scrolling list, a horizontal line and left-pointing triangle 
indicate the insertion point. Items moved to the Hidden scrolling list are 
just added to the bottom; separators are discarded, since new ones can 
always be added to the Visible list by dragging from the (left side of 
the) permanent one at the top of the Hidden list. 

The icon for a standard item cannot be changed, but a macro item can 
be assigned an icon by dragging one from the Icon scrolling list. The 
pointer changes to an arrow-headed cross, and a gray outline shows 
where the icon will go. The item highlights, and the icon appears at its 
left, replacing any already there, and will appear on its button if it is in 
the Visible scrolling list. 

Use an item’s pop-up menu (to the right of the vertical bar) to assign 
one of the 15 Function keys to a button (the default is none, a blank), 
for use with an extended keyboard. Pressing the assigned key is 
equivalent to pressing the button, even if the Tool Bar is hidden. 

Choose a 
button icon 
from the Icon 
list

Assign a 
Function-key 
equivalent from 
the pop-up menu

Drag to place a 
separator in 
the Visible list
Figure 7–2 

The Tool Bar Settings dialog 
box
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Controls

On selecting the Controls… submenu command, the Controls dialog 
box appears. By default, all the checkboxes are highlighted, and their 
functions active. Click the checkbox or the function beside it to toggle 
the function off and on. The dialog box allows you to remove Uromac 
functions that could be confusing, or are unnecessary, for a new user, 
who might easily feel lost and bewildered by choice. Click the OK 
button to apply your changes. 

Allow Printing of Whole File. Turning this checkbox off disables the 
Print All… command in the File menu — other printing commands 
such as Print Selection… are still available, but the whole file cannot be 
printed. This is useful in student labs, where generally only a small 
portion of a file would require printing. Printing all of a large file could 
tie up a printer unnecessarily for a long time, when others might well 
want to use it. 

Record/Monitor Control. When this checkbox is turned off, the 
Record/Monitor button is hidden. This can be useful to prevent new 
users losing their data by accidentally clicking the button and switching 
from recording to monitoring, or to prevent recording altogether. Make 
sure that the Record/ Monitor button is set to what you want before 
you hide it. 

Scroll/Review Controls. When this checkbox is turned off, the Scroll 
button and Review button (which normally replace the View buttons 
while recording) are hidden. Neophytes might, again, click the Review 
Figure 7–3 
The Controls dialog box
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Note
To start up Uromac with 
its default settings on a 
one-time basis, hold down 
the Command key as you 
open it (straight after 
double-clicking the icon). 
Release the key when the 
alert box appears, and click 
the OK button.
button without knowing what it does and then panic when the 
comment entry controls disappear, and they don’t see data scrolling in 
from the right of the window. 

Computed Inputs. When this checkbox is turned off, the Computed 
Inputs… menu command disappears from the Channel Function pop-
up menu, and the Computed Input dialog box is no longer accessible. 
This simply eliminates a potential source of confusion for new users. 

Off-Line Calculations. When this checkbox is turned off, the 
Smoothing and Absolute Value off-line functions are removed, and, 
since Raw Data is then the only option left for a channel, all three 
alternate menu commands — Raw Data, Smoothing…, and Absolute 
Value — disappear from the Channel Function pop-up menu. This 
eliminates something that beginners are unlikely to want to use. 

Start-Up

Settings are of two sorts: those that affect recording, such as the 
sampling speed, channel ranges, triggering, and stimulation functions; 
and those that affect the way the data looks, such as the window size, 
channel areas, display settings, and menu configuration. To save or 
clear customised settings, select the Start-Up… submenu command: the 
Start-Up Settings dialog box appears. 

Clicking the OK button will save all current settings in a preferences file 
in your System folder (Chart Settings) so that they are used each time 
you start up Uromac. Clicking the Clear button will clear any settings 
currently stored in the Chart Settings file: when Uromac next starts up, 
it will use its default settings, taking the whole screen for its display, 
with all channels having a 10 V range, and so on. (The settings in use 
remain until you quit and restart Uromac.) 
Figure 7–4 
The Start-Up Settings dialog 
box
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Menus

The six Uromac menus (File, Edit, Setup, Commands, Windows, Macro) 
and their commands can be modified from the default settings by using 
the Menus dialog box, which appears on selecting the Menus… 
submenu command. You can hide or lock any menu or menu 
command to create a very simple Uromac setup, if you want to limit 
the actions that can be performed. 

The dialog box will initially display the File menu: to move to the 
dialog boxes of adjacent menus, click the arrows by the dialog box 
title, or press the right or left arrow keys on the keyboard. Click the OK 
button to apply any changes you have made. 

Menus too long to fit entirely within the dialog box will have an arrow 
pointing down at their bases: click it (or press the down arrow key on 
the keyboard) to move down through the menu, then click the arrow 
that appears at the top of the menu (or press the up arrow key) if you 
need to move back up again. By default, the menu title and all items 
within the menu will have a tick to their left, and all menu commands 
Figure 7–5 
The Menus dialog box
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▼ Refer
Keyboard Shortcuts,  p. 158
will have an open padlock beside them as well, indicating that 
everything is visible and unlocked. 

Clicking a tick will change it to a cross, and hide the item beside it. 
Clicking the tick beside the menu title will hide the menu: it will not 
appear in the menu bar when you return to the Uromac window. 
Clicking the tick beside a menu command or a dividing line will hide it: 
it will not appear in the menu, and neither will any Command-key 
equivalent work. Clicking a cross will change it to a tick, and show the 
previously hidden item beside it. 

Clicking an open padlock (with a U for unlocked on it) changes it to a 
closed padlock (with an L for locked on it), and locks the menu 
command beside it. The command will still appear in the menu, but is 
dimmed and cannot be chosen; neither will any Command-key 
equivalent work. Clicking a closed padlock changes it to an open 
padlock, and unlocks the previously locked menu command beside it. 
The padlock beside a hidden menu command is dimmed, since there is 
no point in locking or unlocking it. 

Command-Key Equivalents

Command-key equivalents for menu commands can be added or 
changed. Click a menu command to select it: the Cmd Key area of the 
dialog box becomes undimmed. Type a single lower-case letter or 
number in the text entry box (letters are automatically capitalised; 
invalid characters will be rejected) and click the Set button to assign a 
keyboard equivalent. If you choose a character already in use, an alert 
box will warn you of the fact and tell you where it is assigned. If you 
choose the character anyway, your choice overrides the previous 
assignment, and the Command-key equivalent will only work for (and 
appear beside) the menu command that you have chosen.

If the menu command already has a Command-key equivalent, this key 
appears selected in the text entry box, and you can either change it, or 
delete it so that no Command-key equivalent is available. 

Emergency Access!
Because it is possible to change menu preferences so that vital menu 
commands are locked or menus themselves hidden, it is necessary to 
have a back door in. Access to dialog boxes often needed, and often 
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made unavailable in order to safeguard files, is available through the 
Show Dialog Box dialog box, which appears on typing Command-/ 
(the slash character is on the same key as the question mark). 

Clicking the Menu Editor… button will bring up the Menus dialog box, 
allowing you to show hidden menus, and to unlock menu commands, 
and otherwise alter the settings you have made. This is obviously useful 
if you have accidentally locked yourself out. 

Clicking the Start Up… button will bring up the Start-Up Settings dialog 
box, allowing you to save the current settings in the file (including 
menu layouts and so on) as those Uromac will use when it starts up. 
This means that quitting and restarting Uromac will not face the user 
with a Uromac file that could have quite different settings, and none of 
the safeguards you may have set up. 

Clicking the Save As… button will bring up the Save As dialog box, 
which allows you the complete range of options in saving a Uromac 
file. It is useful where you have disabled the ability to save a file, and 
particularly to save the file as a Settings file with the hidden or locked 
menu items remaining as specified when the file was saved. 

Macros
Macros are used to group sets of commands together conveniently, 
enabling you to speed up repetitive and tedious tasks, such as changing 
the settings for various parts of an experiment, and to automate 
recording and analysis. They record the results of your actions step by 
step, then reproduce them when played back. If you find yourself 
regularly doing the same series of operations in Uromac, whether 
simple or complex, macros can ease things considerably. 
Figure 7–6 
The Show Dialog Box dialog 
box
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Macros can record any Uromac operation: setting dialog box and 
window controls; changing the display format; copying waveform data 
to the Data Pad; saving data as a new file; printing the Zoom window 
display of selected data, and so on. There are some differences 
involved in recorded and real operations, but in general, dialog boxes 
will guide you through your options. 

It is important to understand how macros work: they record the results 
of your actions, not individual keystrokes and mouse clicks, and record 
the simplest possible interpretation of those actions. Even if you spend 
some time fiddling with control settings during the recording of a 
macro, only the final settings you obtain will be used. Macros are not 
able to be edited, and are generally incompatible between different 
versions of Uromac. Macros created in Uromac 3.2 cannot be used in 
later versions; Uromac 3.3 macros can be used by Uromac 3.4, but not 
vice versa. 

You should keep a written record, in a notebook, HyperCard stack, or 
whatever you find most convenient, of the steps involved in your 
macros, and their purpose: it is easy to forget which macro does what 
when you haven’t used them for a few weeks. Noting the steps down 
before actually recording will help when constructing complex macros, 
since it can prove easy to miss out a step or end a repeated sequence 
in the wrong place, with detrimental effects. 

Macros are saved as part of a file. They are loaded into memory 
whenever data or settings from the file that contains them are loaded, 
effectively adding to the Uromac application (this is one reason why 
they are stored in as compact a way as possible). Hence if you load 
three files in succession, with a different macro in each, then all three 
macros will be available until you quit and restart Uromac, or delete the 
macros. When a file is saved, all currently available macros are saved 
with it, becoming part of the file. 

Recording a Macro

To record a macro, choose Start Recording from the Macro menu, or 
type Command-R (the menu command then changes to Stop 
Recording…). When a macro is being recorded, for the most part 
Uromac remembers rather than executes operations, but opening files, 
changing channel ranges, or turning channels off, for example, are 
done as you record. 
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▼ Refer
Keyboard Shortcuts,  p. 158
During the process, a progress indicator is shown in the text box of the 
Tool Bar, to remind you that your actions are being recorded, not 
necessarily effected. Perform each action to be recorded, then choose 
Stop Recording… from the Macro menu, or type Command-R again. 
Once you stop recording, the Add Macro to Menu dialog box appears. 

The pop-up Menu button allows you to select the menu in which your 
macro will appear from a list of existing menus. By default, the macro 
will be added as a new menu command to the Macro menu. You can 
create a new menu by entering its title in the Menu text entry box: the 
menu will be added to the right of existing menus in the menu bar. The 
name of the macro (up to 20 characters) should be entered in the Item 
text entry box. 

An optional Command-key equivalent can be assigned to the macro as 
well: type a single lower-case letter or number in the text entry box 
(letters are automatically capitalised; invalid characters will be rejected). 
If you choose a character already in use, an alert box will warn you of 
the fact and tell you where it is assigned. If you choose the character 
anyway, your choice overrides the previous assignment, and the 
Command-key equivalent will only work for (and appear beside) the 
menu command that you have just created. 

The Size indicator tells you the number of steps recorded (useful if you 
can’t remember which step you are up to in the middle of a complex 
macro), and the memory taken by the macro, so far. The amount of 
memory used depends on the complexity of the procedure. Click the 
Discard button to discard the macro you have just recorded. Click the 
Cancel button to continue recording more steps in the macro. Click the 

Type a name for the macro 
here

Press here to select a menu to 
which to add the macro

Assign a Command-key 
equivalent here

Type here to create a new 
menu
Figure 7–7 

The Add Macro to Menu 
dialog box
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Add button to add the macro to the bottom of the selected menu; the 
Add button is only active and undimmed when the macro is named 
and a menu is chosen. 

Until you save the file, the macro exists only in memory and is not 
permanently stored. If you open another file and save that, the macro 
(and all other currently available macros) will become part of the new 
file. When you quit Uromac, you will not be asked to save changes if 
the changes are all concerned with macros (since they can float around 
in memory in this way), so it is a good idea to save the file each time 
you create a macro. 

Playing a Macro

Once assigned a name and location, macros act much as if they were 
menu commands. Select them from their menu or type their Command-
key equivalent to use them. While a macro plays, the title of the menu 
in which it resides is highlighted, and no other functions can be 
performed within Uromac, nor can one switch to another application 
and leave Uromac in the background. To stop a macro playing, type 
Command–period: the macro stops at its current step. 

Deleting a Macro

You can delete existing macros by choosing the Delete Macro menu 
command in the Macro menu. On selecting it, the Delete Macro dialog 
box appears. 
Figure 7–8 
The Delete Macro dialog box
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A scrolling list displays the name of the menu that the macro is in, a 
colon, and the name of the macro, for all available macros. To delete a 
macro, select it and click the Delete button. To delete multiple macros, 
Shift-click or Shift-drag to select contiguous macros, or Command-click 
to select or deselect multiple macros individually. The dialog box will 
close and the macro or macros will be gone. As a shortcut, double-click 
a macro to delete it and close the dialog box in one step. 

As was mentioned, macros are part of a particular file, and when a file 
is saved, all currently available macros are saved with it. When you 
delete a macro, you delete it from memory. If it has been assigned a 
button in the Tool Bar, the button disappears. If the macro is part of the 
current file, it is permanently deleted from that file only when the file is 
saved (although it will not be available while the file remains open). 
Copies of the macro attached to other files are not deleted. 

Macros That Call Other Macros

Once a macro has been created, it can be used by other macros (when 
it is loaded in memory) as a step in the recording of the new macro. 
This enables modular construction of complex procedures. Macros can 
only be nested up to ten deep, however. An alert box will appear 
during the playing of your macros if the combination becomes too 
recursive, and the macro sequence will stop at that stage. 

If a macro is called by other macros, Uromac warns you if you attempt 
to delete it. If you delete it without replacing it, then if the deleted 
macro is called, an alert box will tell you that it cannot be found, and 
the calling macro will halt. 

Options When Recording Macros

Operations involving files and dialog boxes can be made to behave in 
different ways when playing macros, depending on whether you want 
to do the same thing all the time, allow user modification, and so on. 

Changing Dialog Box Settings

Macros can be used to change dialog box settings to values specified 
when you record, or to open a dialog box for the user to change 
settings when the macro is played. If you want a macro that changes 
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the settings in a dialog box, then select the dialog box as you would 
normally while recording the macro. Change the settings, and then click 
OK in the dialog box. (If you click Cancel, the changes made in the 
dialog box will be ignored.) When playing the macro, the settings are 
changed without displaying the dialog box. 

If you want a macro that opens a dialog box for the user to change 
settings when the macro is played, hold down the Option key when 
selecting the command that shows the dialog box while recording the 
macro, then click the OK button. Do not make any setting changes. 
When you play back the macro, the dialog box is displayed so that its 
settings can be changed by the user. Clicking the OK or Cancel buttons 
in the dialog box will allow the macro to continue, with the user-
defined settings or the original settings respectively. 

When changing control values in dialog boxes, absolute values are 
recorded, not relative changes. For example, if you move a scroll bar 
that increases voltage by 50%, from 2 V to 3 V, the new voltage (3 V) is 
recorded, not the change in voltage (+1 V) or the percentage change in 
voltage (+50%). 

Starting Sampling

Macros can be used to control when sampling starts and stops. Should 
you click the Start button when recording a macro, the Macro Sampling 
dialog box will appear. 

In general, you would probably want to retain the default setting in the 
upper part of the dialog box (that is, stop the macro while sampling), 
but in some cases you might want to perform steps as sampling 
Figure 7–9 
The Macro Sampling dialog 
box
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proceeds (adjusting some settings, for example). The lower part of the 
dialog box allows you to specify when sampling stops. This could be 
useful to override, for a certain portion of an experiment, a limited 
duration set in the Trigger window. 

Opening and Appending Files

A macro can be used to open the same file each time it is played, or to 
allow the user to choose which file to open. To open a particular file 
with a macro, choose Open… from the File menu while recording a 
macro: the Macro Open directory dialog box is displayed. You have the 
usual choices of loading data or settings, and you can choose to 
append files as well (in fact, this dialog box also appears when you 
select Append… from the File menu while recording a macro). 

To allow the user to choose which file is to be opened when the macro 
is played, press the Option key when selecting the Open… command 
while recording the macro. The Open directory dialog box will be 
displayed when the macro is played (see Figure 2–2). 

When opening the same file each time, the full hierarchical file name 
(the ‘pathname’) of the file, from the disk through any number of 
folders, is noted. If the file has been moved (or deleted) since the 
macro was recorded, then Uromac searches in the most recently used 
Figure 7–10 
The Macro Open directory 
dialog box
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folder and in the same folder as Uromac. If the file is in neither of these 
locations, an alert box lets you know that Uromac cannot find the file, 
and the Open directory dialog box is displayed to allow you to find it 
yourself. If you choose a different file at this stage, that one will be 
opened instead; if you click the Cancel button, the macro will abort. 

Saving Files

When playing a macro, you can save data in a file or in a series of files. 
Choosing the plain Save command will save a current named file (you 
might want to do this at specified intervals to minimise data loss in case 
of possible power loss; just remember that data is not recorded during 
the time it takes to save a file to disk). 

You can specify where and in what form you want the data to be saved 
by using the Save As… command when recording the macro. The 
Macro Save As directory dialog box appears (Figure 7–11). The formats 
are data file, settings file, and text file; and saving the data pad as a text 
file, just as in the normal Save As directory dialog box. 

Three checkboxes in the ‘Append filename with’ section of the 
directory dialog box allow you to specify unique file names. If no 
checkboxes are selected, then each time you play the macro, the file 
will be overwritten, just as it is when saved normally. 
Figure 7–11 
The Macro Save As directory 
dialog box
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If the Unique number checkbox is selected, a different number is 
added to the end of the given file name each time the file is saved 
during the playing of the macro. Numbers are added in numerical 
sequence starting with ‘1’. For example, if the file name is Patient, then 
the next files generated will be Patient1 and Patient2. 

Selecting the Time checkbox appends the current time to the file name. 
Selecting the Date checkbox appends the current date to the file name. 
The two may be combined. These checkboxes are dimmed and 
unavailable if the Unique number checkbox is selected. 

Macro Commands

Control structures for macros are provided in the Macro Commands 
submenu; the menu commands are only available while recording a 
macro. They allow you to provide user feedback in the form of dialog 
boxes or sounds, set up repeat sequences, change units, and so on. 

Update Screen

Normally, when a macro is played, the screen is updated after each 
macro step (a tick beside the Update Screen menu command indicates 
that it is active). Choosing the command from the menu as the first step 
in a macro causes the macro to play without redrawing the screen each 
time the data display is altered in some way (the tick disappears). 
Update Screen can be turned off or on at any stage of a macro (the 
settings toggle). If Update Screen is off, the screen will be redrawn only 
when the macro is finished, or it is turned on again. 

This may considerably speed up some macros, for example, those 
involving multiple changes to view and display settings, or repetitive 
selection of data and its transfer to the Data Pad: in this case, the data 
on screen will still be seen to be selected, but data off screen will not 
be scrolled through before selection, as would occur if Update Screen 
were off. Since you cannot edit macros, you cannot change the Update 
Screen settings once the macro is finalised. You can, however, record 
another macro that consists of two steps: turning update screen off, 
then calling the original macro. 
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Wait…

Selecting the Wait… macro command brings up the Wait dialog box. A 
pop-up menu lets you select from Wait For, Wait Until, and Wait Until 
the Next, to wait for a set length of time (say, 55 seconds), wait until a 
certain time (say, 11:20 a.m.), or wait until the next time division (say, 
at the next hour) before the macro continues. 

The checkbox allows you to choose whether a dialog box with a 
progress bar appears during the wait (generally a good idea). The 
dialog box gives a visual indication of wait progress, and gives you the 
options of proceeding immediately to the next step of the macro by 
clicking the Skip the Wait button, or aborting the macro by clicking the 
Stop Macro button (equivalent to typing Command-period). 

This feature is useful if you want to perform some steps of an 
experiment at certain intervals, or to record multiple samples with a 
specific interval between samples.
Figure 7–12 
The Macro Wait dialog box, 
with the three options 
selected
Figure 7–13 
The Macro Wait dialog box 
during the playing of the Wait 
step of a macro
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Play Sound…

Selecting the Play Sound… macro command brings up the Macro Play 
Sound dialog box, which allows you to select from the range of sounds 
in your Macintosh System to set audible alerts in macros. 

Click the name of a sound in the scrolling list to select it. If you wish to 
hear the selected sound, click the Play button. To have it actually 
played in the macro, click the OK button. To choose more than one 
sound option, Shift-click or Shift-drag to select contiguous sounds in the 
list, or Command-click to select or deselect multiple sounds 
individually. Sounds appear in the list in the order they were installed 
in the system, and are played back in that order. To save time in 
creating multiple sounds, you can create a library of sound combination 
macros, and simply incorporate one or more of them in the macro that 
needs them. 

You might wish to have three beeps signal when the Acquidata starts 
recording data, or a bell and a whistle when a trigger point has been 
reached. You can even record short verbal cues using the Sound 
control panel (if your Macintosh has a microphone input) and use these 
in your macros. 

If a macro attempts to play a sound not in the System file (created on a 
computer with a different setup, or since removed from the System), 
then an ordinary system beep will be substituted for the sound 
originally specified. 
Figure 7–14 
The Macro Play Sound dialog 
box
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Note
It helps to notify a user 
that something is up if you 
precede an alert box with 
an audible signal (using 
the Play SoundÉ macro 
command), since he or she 
may not be looking at the 
screen when an alert box 
appears. 
Message…

If you select the Message… macro command, the Macro Message dialog 
box appears. This allows you to cause alert boxes requiring user 
response to appear at certain stages within the macro. 

You can type in the message of your choice (up to 255 characters). The 
dialog box produced will have an OK button, and if the checkbox at 
the top is highlighted, a ‘Cancel’ button as well (for exiting the macro). 

There are four choices of icon: the default shape is highlighted with a 
heavy border. Click one of the icon buttons to choose it. You can use 
the icons to indicate the urgency of an important message (hand, 
exclamation mark, and face, in order of decreasing urgency), and the 
Uromac icon for general messages which indicate Uromac’s state. Click 
the OK button when you have chosen an icon and typed in the 
message. 

Speak Message…

If you select the Speak Message… macro command, the Speak Message 
dialog box appears. Using it, you can give audible messages in macros, 
if your Macintosh has speech abilities (if it is an AV model or otherwise 
has appropriate software). After the message is spoken, the macro 
carries on playing. 

You can type in the message of your choice (up to 255 characters). If 
the Macintosh on which the macro plays has no speech abilities, then if 
Figure 7–15 
The Macro Message dialog 
box
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the checkbox is off, a standard system beep will be used in place of the 
spoken message. If the checkbox is on, an alert box appears, just as if 
the Macro message dialog box were used: this will stop the macro until 
its OK button is clicked. 

The volume at which the message is spoken can either be the default 
system volume set in the Sound control panel, or can be set 
independently to any of the sound levels, from 1 to 7, available in the 
Sound control panel, by clicking or pressing the arrow controls. 

Begin Repeat

The Begin Repeat macro command is used to repeat groups of steps in 
a macro. You may repeat any group of commands up to 100,000 times. 
This could be used, for example, to set up fast sampling at staggered 
intervals overnight. For each Begin Repeat you should specify an End 
Repeat. If you do not specify enough End Repeats, they are 
automatically added when you select Stop Recording…, but if you have 
a complex macro, the repeated sequences might not end up in the right 
places. Writing down the macro before recording it will help avoid such 
problems. 
Figure 7–16 
The Speak Message dialog 
box
Figure 7–17 
The Begin Repeat dialog box
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Repeat Select Every…

This macro command allows you to select sequential periods of data in 
a Uromac file and to perform some operation on them. When you 
select the Repeat Select Every… macro command, a dialog box 
appears, allowing you to set a selection period and choose whether the 
command applies to a selected block or to the whole file. 

You could, for example, transfer data to the Data Pad for every ten-
second period of the recording. If the recording period is not an exact 
multiple of the selected time period, the last selection will be a shorter 
time making up the balance — for example, if the file were 45 seconds 
long and the selection period 10 seconds, the last selection would be 
the remaining five seconds. 

For instance, Figure 7–19 shows a macro selecting a period of data (0.1 
seconds) sequentially through a Uromac file: each selection of data is 
dealt with before moving on to the next one. When this macro 
command plays, it will scroll through the Uromac file and highlight 
each new selection, which may take a while unless the Update Screen 
command is turned off. 

Period of selection 
(0.1 seconds here)
Figure 7–18 
The Repeat Select Every 
dialog box
Figure 7–19 
The Repeat Select EveryÉ 
macro command in action
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▼ Refer
Units Conversion,  p. 39
You cannot nest this command within itself, but you could nest it 
within the Repeat Select Each Block command, if, for instance, you 
wanted to copy the mean of a channel for each ten-second period in a 
block to the Data Pad, and write the data of each block to a new file. 
As with the Begin Repeat macro command, you should specify an End 
Repeat after the instructions you want performed in the repeated 
sequence. 

Repeat Select Each Block

This macro command allows you to perform some operation on each 
block of data in turn in the Uromac file. For instance, you may want to 
get the mean of a channel for each block and copy the information to 
the Data Pad. When this macro command plays, it will scroll through 
the Uromac file and highlight each new block, which may take a while: 
turn off the Update Screen command to avoid this. As with the Begin 
Repeat macro command, you should specify an End Repeat after the 
instructions you want performed in the repeated sequence. 

End Repeat

Each Begin Repeat, Repeat Select Every…, or Repeat Select Each Block 
macro you specify should be paired with an End Repeat. If you do not 
specify enough End Repeats, they are automatically added when you 
select Stop Recording…, but if you have a complex macro, the repeated 
sequences might not end up in the right places. Writing down the 
macro before recording it will help avoid such problems. 

Set Units Conversion…

The Set Units Conversion… macro command allows you to automate 
units conversion. It is usually more convenient to use this command in 
a macro rather than the proper Units Conversion dialog box. On 
choosing the command, the Set Units Conversion dialog box (Figure 
7–20) appears. In the From Value area, you can choose the raw input of 
a channel, or the mean, maximum, or minimum values from a selection 
of recorded data, using the Input and Selection pop-up menus. The 
converted value should be typed into the To Value text entry box. Click 
on the top or bottom pair of boxes to select the first or second pair of 
values (as in the Units Conversion dialog box). Choose or define units 
from the Units pop-up menu. 
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To get a macro that converts the units of a channel into a percentage of 
the maximum reading, for example, you should perform the following 
steps:

1. Select data containing the greatest and smallest data points in the 
channel you want to affect. 

2. Choose Start Recording from the Macro menu.
3. Choose Set Units ConversionÉ from the Macro Commands 

submenu.
¥ Click the Selection button in the dialog box that appears (if it is 

not already selected).
¥ Choose Min from the pop-up menu beside it.
¥ Click on the top boxes to select the Þrst conversion value (they 

become highlighted).
¥ Enter Ô0Õ in the ÔTo ValueÕ box.

4. Click ÔOKÕ.
5. Choose Set Units ConversionÉ from the Macro Commands 

submenu.
¥ Click the Selection button in the dialog box that appears (if it is 

not already selected).
¥ Choose Max from the pop-up menu beside it.
¥ Click on the bottom boxes to select the second conversion value.
¥ Enter Ô100Õ in the ÔTo ValueÕ box.

6. DeÞne units of Ô%Õ using the Units pop-up menu.
7. Click ÔOKÕ.
8. Choose Stop Recording from the Macro menu.
9. Name the Macro (ÔPercentÕ, or whatever) and assign a keystroke if 

you wish.
Figure 7–20 
The Set Units Conversion 
dialog box
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On finishing recording, you can apply this macro to any channel as 
required. Remember that it only applies to the current selection, so you 
will have to select a range of data including the largest and smallest 
points recorded to have the scale set correctly. To select an entire 
channel, Command-drag to select a rectangle the full height of a 
channel at the start of the record, scroll to the end of the record, and 
Shift-click to extend the selection — this will ensure all data points are 
included. 

This feature can also be used for automatic calibration of transducers 
during setup. To do this, set up a macro with prompting messages. You 
must select the channel you are going to use, which means you must 
have started recording — simply start and stop, then click the channel 
to which the transducer will be connected. For example, in the case of 
a pressure transducer, the macro should be of the form: 

1. Macro Message: ÔSet Channel 1 to 0 grams and click OK.Õ
2. Macro Set Units Conversion. (Set to 0.)
3. Macro Message: ÔSet Channel 1 to 100 grams and click OK.Õ
4. Macro Set Units Conversion. (Set to 100, and set units to g.)
5. Macro Message: ÔThe transducer is now calibrated.Õ

Once the macro has been recorded and named, it can be invoked 
when starting to record. The message box will appear, at which time 
the user should ensure the transducer has zero mmHg pressure applied 
to it. When the second message box appears, the user should apply 100 
grams weight to the transducer, after which it will be calibrated. 
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Timed Events
The Timed Events feature allows you to create a list of actions you 
want performed at particular times from the start of recording, 
including setting the analog output or digital output: once the list is set 
up, Uromac will perform the actions at the times you have specified. To 
set up a list of timed events choose Timed Events… from the Setup 
menu. The Timed Events dialog box will appear. 

Click the Add button to create a new event row in the scrolling list. To 
set the time from the start of recording at which you want the event to 
occur, click in the cell of the row in the Time column, and enter the 
time, in one of two formats: 

¥ Seconds from the start of recording. For example typing 10 will 
result in the time being set to 0:10. If you type in 120, the value 
will be converted into 2:00, that is, two minutes.

¥ Hours, minutes, and seconds from the start of recording. Type in 
the value in the format hh:mm:ss. For example, if you want an 
event to occur at one minute and twenty seconds, type 1:20. To set 
a time of two hours and forty Þve minutes, type 2:45:00.

Choose an event 
from the pop-up 
menu in the Action 
column

Enter the time after the start of recording that the event will occur here

Click here to 
remove the 
highlighted row

Click here to add a 
new event row
Figure 7–21 
The Timed Events dialog box
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▼ Refer
Comments,  p. 85
You can perform actions at the start and end of recording, such as 
resetting the analog output or digital output, by clicking the Start and 
End buttons. Alternatively, you can type in the letter S, for start, or E, 
for end, in the time entry field. 

The timed events list will automatically resort rows in chronological 
order once you have finished a new row. This allows you to add new 
events to the list at any time, while being able to view the list in order 
of events. You can have two or more events scheduled at the same 
time: Uromac will execute one after the other at that time. 

Timed Event Actions

Pressing down the mouse button when the pointer is in the Action 
column brings up a pop-up menu of events that can be chosen for the 
row. There are three types of events that can be carried out:

¥ Setting an analog output voltage level from the Acquidata.
¥ Adding a comment to the recording.
¥ Applying a digital output conÞguration.

To set the analog output voltage level from the Output socket at the 
front of the Acquidata, choose the Set Analog Output… command from 
the Action pop-up menu. The Timed Event Stimulator Output dialog 
box will appear, allowing you to adjust the constant output voltage.

To add a comment to the recording at a specified time, choose the Add 
Comment… item from the pop-up menu in the Action column. The 
Add New Comment dialog box will appear. You can type in the 
comment you want to add, and choose to apply it to all channels or to 
a specific channel through its Channel pop-up menu. 

If you have not created a list of digital output configurations, the 
bottom menu command will read ‘No Digital Output bits’ and will be 
Figure 7–22 
The Timed Event Stimulator 
Output dialog box
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▼ Refer
Digital Output Control,  
p. 146
dimmed and inactive. If you have previously defined a list of digital 
output configurations, they will be included as menu commands at the 
bottom of the Action pop-up menu, and can be applied at scheduled 
times by selecting them as event actions. 

The ‘Repeat Sequence’ command can be used to make the timed events 
sequence start from the beginning again. When Uromac encounters the 
Repeat Sequence action, it goes back to the beginning of the event list 
and performs each event in order, starting the sequence from the time 
the Repeat Sequence was set for. This allows you to pause between 
repeating events. 
0:00 Analog output 0.00 V;  p

Analog output 2.50 V;
Figure 7–23 
An example of a repeat 
sequence and the associated 
time line
& Automating Uromac 145

5:00

10:00

15:00

20:00

add comment ‘Pump Sta

Analog output 0.00 V;  p

Analog output 0.00 V;  p

Analog output 2.50 V;
add comment ‘Pump Sta

Analog output 0.00 V;  p

Analog output 0.00 V;  p

Sequences keep repea
until recording stopped



Chapter 7 Ñ Customising 
The example in Figure 7–23 shows how the Repeat Sequence can be 
used. The event list in the dialog box consists of performing two 
actions at the beginning of recording, two actions at 1 minute 40 
seconds, and two actions at 5 minutes. The event sequence, as far as 
the experiment is concerned, finishes here. By placing a Repeat 
Sequence action at 10 minutes we get the whole sequence repeated 
again 5 minutes after the end of the last one. Figure 7–23 shows the 
sequence of events from the list on a time scale. Note that the sequence 
is repeated immediately after the repeat sequence action.

Editing Timed Events

To add a new event, click the Add button again: create the new event 
you need at the time you want, and once it is entered, Uromac will 
resort the event list in chronological order. To change an existing event, 
select the time or action you want to change and enter the new 
parameters. To remove an event, click a row to select it (it becomes 
highlighted) and click the Delete button. Shift-click or Shift-drag to 
select contiguous rows, or Command-click to select or deselect multiple 
rows individually, for mass deletion.

The Accuracy of Timed Events

The timed events feature is not intended for uses requiring very high 
accuracy. Since it is controlled from the Macintosh computer, its 
accuracy will depend on how busy the Macintosh is: very fast sampling, 
a slow processor, or running intensive applications in the background 
will all delay it. Holding down a menu while timed events are about to 
occur forces a delay until the menu is released. In general, though, it 
should be accurate to within a quarter of a second. 

Digital Output Control
You can make use of the digital output port at the back of the 
Acquidata while recording in Uromac (don’t confuse this with the 
Output sockets at the front of the Acquidata). By creating a list of 
digital output configurations, you can use either macros or timed events 
to control the state of the digital output while recording. This feature is 
primarily meant for turning on and off external devices, for example, 
pumps, relays, and indicator lights, or to signal to some other device. 
Up to eight such devices can be controlled through the eight ‘bits’ of 
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the digital output (each ‘bit’ controls a separate device or circuit). The 
digital output bits of the Acquidata are designed to drive light, low-
current loads (such as logic circuits with a 2–2.5 V logic transition). The 
output bits cannot themselves directly drive power-hungry devices such 
as relays. 

The digital output circuitry must be physically connected before the 
controls set through the software will work: this requires some 
technical expertise, and is best left to a technician if you have little 
experience with electronics.

Configuring the Digital Output

To create from one to eight digital output configurations, choose the 
Configure Digital Output… command from the Setup menu. The 
Configure Digital Output dialog box will appear. 

To create a new setting or configuration, click the Add button. This will 
create a new output configuration row in the scrolling list. Type the 
desired name for the configuration in the Configuration Name column 
of the row (Pump On, say, if you were using this setting for turning on 
a pump). This name is used by other parts of Uromac to refer to that 
particular output setting, so it should be unique. 

The state of each output bit (from 1 to 8) for a configuration row is 
defined by clicking the correspondingly numbered bit columns. The 
default selection is a gray diamond, which means that that bit will not 
change state. All digital outputs are set to a zero state (an off state) 

Define the 
action of the 
configuration 
by clicking 
the control 
diamonds

Enter the 
name of the 
configuration 
in these cells
Figure 7–24 
The ConÞgure Digital Output 
dialog box
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Turn bit on

Turn bit off

Leave bit unchanged
when Uromac is first started. A single click on a particular bits diamond 
will toggle it through three states. Black indicates the digital output bit 
is to be turned on for this configuration. White indicates the digital 
output bit is to be turned off for this configuration. Gray indicates the 
digital output bit will stay in the state it was during the last 
configuration.

As an example, take the digital output configurations shown in Figure 
7–25. The first configuration sets bit 1 of the digital output to an on 
state, sets bit 2 to an off state, and leaves all other bits the way they 
were set before. As this is the first entry in the list since Uromac was 
started, these bits remain off. The second entry turns off bit 1, but 
leaves bit 2 the way it was previously, that is, off. 

The digital outputs on some Acquidatas will all be on when the 
Acquidata is first switched on. When Uromac is opened, these bits will 
all be turned off. This change of state when Uromac starts up can cause 
external equipment to be triggered or started before it should be. If this 
problem is evident, then either connect the external equipment to the 
Acquidata after Uromac has been started or keep the equipment off 
until you run Uromac. 

Controlling the Digital Output

There are several methods by which to apply the configurations 
defined in the Configure Digital Output dialog box: manually, with a 
macro, or using timed events. 

Once you have defined a configuration or a set of configurations, you 
can select any one of them manually by choosing it from the Digital 
Output submenu. Figure 7–26 shows the submenu that would result 
from the configurations set up in Figure 7–24. 
Figure 7–25 
Example of digital output
Figure 7–26 
The Digital Output submenu
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▼ Refer
Timed Events,  p. 143
You can apply Digital Output configurations in a macro. During the 
execution of the macro, the configurations that you chose while 
recording the macro are applied to help to automate the process by 
indicating to external devices that some point in the macro has been 
reached. Timed events can be used to change to different output 
configurations at predefined times after the start of recording. 

Automatic Comments
You can make use of the digital input port at the back of the Acquidata 
to generate predefined comments while recording. The settings for the 
digital input are independent of any settings for the digital output. By 
setting up a list of comments that correspond to certain states or 
changes of state of the digital input bits on the Acquidata, you can have 
Uromac automatically insert the appropriate comment when the digital 
input bits change to a particular state, thus keeping notes of all state 
changes during automated recording. The timing of automatic 
comments is very accurate (unlike the timed events feature). 

The digital input bits of the Acquidata are designed to respond to the 
signals from contact closures such as those generated by relays and 
switches, and standard logic circuits with a 2–2.5 V logic transition. As 
with the digital output, up to eight devices can be connected through 
the eight ‘bits’ of the digital input (each ‘bit’ responds to a separate 
device or circuit). 

The digital input circuitry must be physically connected before the 
automatic comments set up through the software will respond 
appropriately: this requires some technical expertise, and is best left to 
a technician if you have little experience with electronics. 

Setting Up Automatic Comments

To create one or more automatic comments, choose the Auto 
Comments… command from the Setup menu. The Automatic 
Comments dialog box appears. 

To create a new automatic comment, click the Add button in the dialog 
box. This will add a new row to the scrolling list. Type the desired 
comment text in the Comment Text column of the row. The comment 
can be applied to any of the available channels or to all channels, by 
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selecting the appropriate item from the pop-up menu in the Chan 
column. 

The pop-up menu in the Bit column lets you choose which one of the 
digital input bits causes the comment on the row to be added. 
Alternatively, click one of the bit indicators at the top of the dialog box 
to apply that bit to the selected row. The bit indicators show if 
particular bits are on (highlighted) or off (plain), so that you can 
change the digital input and observe effects while setting up automatic 
comments. When nothing is connected to a digital input line, the 
Acquidata will register an ‘on’ state. 

Click the state change icon to toggle it up or down, representing the 
input signal change that will cause the comment to be added to the 
recording: up for an off-to-on transition (from a low to a high state), 
and down for an on-to-off transition (from a high to a low state). 

To add more automatic comments, click the Add button again. To 
remove an automatic comment, click a row to select it (it becomes 
highlighted) and click the Delete button. Shift-click or Shift-drag to 
select contiguous rows, or Command-click to select or deselect multiple 
rows individually, for mass deletion. 

Bit indicators 
— bits 1–5 are 
on, bits 6–8 are 
off

Enter the 
comment here

Choose the channel in which 
the comment will be recorded 
from this pop-up menu

Click to 
toggle the 
state icon

Choose the bit the 
comment responds to 
from this pop-up 
Figure 7–27 
The Automatic Comments 
dialog box 
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Once the OK button in the dialog box is clicked, Uromac will insert the 
automatic comments as the changes with which you have associated 
them occur. You can have more than one comment attached to the 
same bit, in which case Uromac simply cycles through them. You might 
want to indicate ‘first heating phase’, ‘second heating phase’, for 
instance, to keep track of a particular bit’s state change. 

Repeated automatic comments can be numbered to help keep track of 
them. If you set up an automatic comment that contains the # character, 
then when this comment is added, an incrementing number replaces 
the #. An automatic comment ‘Pump on #’ would give ‘Pump on 1’, 
‘Pump on 2’, and so on in the recording. Up to ten independent lists of 
numbered repeat comments can be generated, by adding a number (0 
to 9) immediately after the # (#0 is the same as just using # by itself). 

You can use macros to change the automatic comments list as part of a 
recording sequence. This allows you to set up a sequence of recordings 
that respond in different ways to the digital input bits. In order to 
change the list, you must first stop recording. 

Connections and Multiple Copies
It is generally assumed that most users will be using a single Acquidata 
connected to a single Macintosh, on which they will be running one 
copy of Uromac. It is possible, although not recommended, to use 
multiple copies of Uromac on, and connect multiple Acquidata to, one 
Macintosh. 

To do this, you need some way to tell each copy of Uromac which 
Acquidata to interact with. When Uromac opens normally, it assumes 
the Acquidata was where it was found last; if not, then it looks at the 
other port (SCSI or serial, in that order). If you rename the Uromac 
application itself — not an alias — by adding one of three prefixes, 
Analysis, Serial, or SCSI #, where # is the SCSI ID number, Uromac will 
open in a specific way. 

Analysis Uromac will automatically open Uromac in analysis mode, 
without looking for a Acquidata ; this avoids the  ‘Acquidata 
Unavailable’ dialog box, which can be annoying if you are constantly 
doing analysis without a Acquidata connected, say, at home on your 
PowerBook. 
& Automating Uromac 151



Chapter 7 Ñ Customising 

▼ Refer
Figure 1Ð3, p. 6
Serial Uromac will look for and set up an  Acquidata connected 
through the serial port. The application will not search on the SCSI port 
if there is no Acquidata connected serially, but will instead give you the 
‘Acquidata Unavailable’ dialog box. 

SCSI # Uromac will look for and set up an Acquidata with the SCSI ID 
number specified: if you had two Acquidata connected as SCSI devices 
with ID numbers of 2 and 5, ‘SCSI 2 Uromac’ would use the former 
one. 

If you really must record on 32 channels simultaneously, and you have 
the latest in fast Macintoshes and the screen real estate to display it all, 
you will need to synchronise the recording. To do this, use the same 
triggering setup in each Uromac file, and use an external triggering 
device connected in common to the trigger input at the front of each 
AcquiProcessor to start recording. 

Extensions
Extensions are small additions to the Uromac program, transparent to 
the user, that add extra functionality to Uromac — Data Pad functions, 
off-line functions, and general utilities. They are separate files, loaded 
into memory when the program starts up. Some are shipped with 
Uromac, others sold separately; it is expected that more will be 
available in the future. (Extensions sold separately are documented 
separately.)When Uromac is first installed, the ‘Uromac’ folder you 
created on the hard disk includes a Chart Extensions folder. Extensions 
in the folder are loaded on start-up. The Chart Extensions folder must 
be in the same folder as the Uromac application (not an alias), and 
should not be renamed, or no extensions will load. This folder itself  
may contain another folder, Unused Extensions, which is a handy place 
to put extensions you temporarily do not wish to use. 

To find which extensions are operative while Uromac is running, select 
the About Uromac… command from the Apple ( ) menu (click the 
startup screen when you have finished to make it go away again 
afterwards). Click the Extensions button to bring up a dialog box that 
lists currently loaded Uromac extensions and explains what they do. 
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To turn off Uromac extensions temporarily for one session, hold down 
the Shift key when starting up, just after double-clicking the Uromac 
icon. It is assumed that most users will be using a single Acquidata 
connected to a single Macintosh, on which they will be running one 
copy of Uromac. It is possible, although not recommended, to use 
multiple copies of Uromac on, and connect multiple Acquidatas to, one 
Macintosh. 

To turn off Uromac extensions temporarily for one session, hold down 
the Shift key when starting up, just after double-clicking the Uromac 
icon. 
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A P P E N D I X  A
A Menus & Commands
ac UserÕs Guide
Menus
The menus shown here are the default settings, and your copy of 
Uromac may be set up differently, since Uromac menus are able to be 
customised to a great extent. Uromac has six menus: File, Edit, Setup, 
Commands, Windows, and Macro; macros and extensions can add 
more. Some of the menu commands shown will change or be disabled 
depending on the active window and what, if anything, is selected. An 
ellipsis (…) after a menu command indicates that it brings up a dialog 
box; a tick to its left indicates that it is currently active; and a keyboard 
equivalent, if there is one, is shown to its right.
Create a new Uromac file
Open an existing file
Append an existing file to the current file
Figure A–1 
The File menu
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Close the current file
Save the current file
Save the file with a new name
Save the current selection as a file or text

Choose between storing data to memory or to disk

Set up page size and so on to suit the printer
Print to a continuous-feed printer while sampling
Print the selected data

Quit Uromac



Undo previous action (if possible)
Figure A–2 
The Edit menu
Cut selected data to the clipboard
Copy selected data to the clipboard
Paste selection
Clear selection

Delete selected data from all channels
Delete all data in a channel

Customise Uromac options (see submenu)

Show contents of clipboard

Set up the Tool Bar
Choose the shape of the Waveform 
Cursor
Figure A–3 
The Preferences submenu
Modify Uromac menus
Modify various Uromac features and 

Modify display settings, grids, lines, etc
Change channel titles
Figure A–4 
The Setup menu
Set up what triggers and stops sampling

Set up the Stimulator
Display the Stimulator control miniwindow
Set the constant output voltage (Stimulator)

Set up the state of the digital output
List of digital outputs set up (see submenu)
List actions to be performed at certain times

Create comments to insert as certain events 
occur
Figure A–5 
The Digital Output submenu: 
the list will depend on what 
you have created with 
ConÞgure Digital OutputÉ 
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Insert a comment at the selected time
Move the marker to the active point
Figure A–6 
The Commands menu
Add data on the selection to the Data Pad

Set scale zero to active point or average
Revert to settings before baseline set up

Display Notebook window, for taking general notes 
Figure A–7 
The Windows menu
Return to or open the main Uromac window
Display a selection in the Zoom window
Display the plot of one channel versus another 

Display the Comments window 
Display all of the data for a channel, compressed

Display the Data Pad window, for setup or analysis

Start or stop recording a macro
Delete a macro from the current list of macros
Figure A–8 
The Macro menu
Choose macro control actions (see submenu)

Redraw the screen during the macro playing 

Pause the macro for a set time 
Set an audible alert using the System sounds
Display a message dialog box 
Figure A–9 
The Macro Commands 
submenu
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Speak a written message 

Select each period of data to action..
Select each block of data to perform action... 
Start a repeat sequence
Finish a repeat sequence or repeat select 
sequence
Change the scale units
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Table A–1 
Uromac keyboard shortcuts: 
the list is alphabetical so that 
you can see at a glance which 
keys have been used for 
menu commands
Keyboard Shortcuts
The Command-key equivalents shown in Table A–1 are default settings, 
and your copy of Uromac may be set up differently, since Uromac is 
able to be customised to a great extent. Some of the Command-key 
equivalents shown will change or be disabled depending on the active 
window and what, if anything, is selected. Their functions are discussed 
elsewhere in this user’s guide. 

The standard Macintosh keyboard shortcuts for dialog boxes also apply: 
Tab moves the insertion point to next text entry box; Enter or Return is 
the same as clicking the OK button; and Esc or Command-period (.) is 
the same as clicking the Cancel button. 

Keystrokes Function

CommandÐB Clear data

CommandÐC Copy to Clipboard

CommandÐD Add information on selection to Data Pad

CommandÐK Add comment

CommandÐL Comments window

CommandÐM Overview window

CommandÐN New

CommandÐO Open

CommandÐP Print

CommandÐQ Quit Uromac

CommandÐR Start/stop macro recording

CommandÐS Save Þle

CommandÐV Paste

CommandÐW Close active window

CommandÐX Cut selection

CommandÐZ Undo/redo

CommandÐ/ Access to dialog boxes (Menu, Save As, Start-up)

CommandÐPeriod (.) Stop sampling, stop macro recording or playing

CommandÐSpacebar Start/stop sampling

CommandÐRight arrow Go to end of Þle

CommandÐLeft arrow Go to start of Þle

Delete Delete selection
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A P P E N D I X  B
B Troubleshooting
c UserÕs Guide
Technical Support
Uromac has been extensively tested to make sure that it runs smoothly 
and without difficulties. Occasionally, however, problems may arise or 
something unexpected may occur. The second part of this appendix 
gives a list of possible problems and likely solutions: you should look 
there first to see if your needs are addressed specifically. (This can save 
you some money in telephone calls or faxes!) 

If you are experiencing difficulties with Uromac that are not covered in 
this user’s guide, or you need technical assistance with your Acquidata 
system in some form, then Neomedix Systems and its authorised 
Acquidata distributors are glad to help. The About Uromac dialog box 
gives access to dealer and distributor addresses and the required system 
configuration information. To bring it up, select the About Uromac… 
command from the Apple ( ) menu (click the dialog box when you 
have finished to make it go away). 

Release date

Click these buttons 
for information on 
contacts, extensions, 
and hardware 
configuration
Figure B–1 
The About Uromac dialog box
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Dealer and Distributor Information

If you need help or information from an authorised Acquidata 
distributor, click the Telephone button to bring up the Acquidata Dealer 
and Distributor Addresses dialog box. Click in the scrolling list on the 
right of the dialog box to select your country, or the nearest one to it, 
and contact information will appear to the left. Feel free to contact your 
Acquidata dealer to discuss hardware and software requirements 
generally, and find out more about the latest releases, upgrades, and 
software maintenance information. 

System Configuration Information

In general, we will need quite specific information about your 
hardware and software to help to isolate and to solve problems 
effectively. Since this type of information can be tedious to collate, 
Uromac does it all for you. Click the Macintosh button to bring up the 
About This Macintosh dialog box. There will be a short delay while it 
gleans the required information from your system. 

Click to print a copy of 
this dialog box

Acquidata model 

Click to copy this 
dialog box for pasting 
Figure B–2 
The Acquidata Dealer and 
Distributor Addresses dialog 
box
Figure B–3 
The About This Macintosh 
dialog box
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The dialog box gives information on which version of Uromac is 
running, together with a list of system extensions and ‘inits’. Also 
provided is a detailed description of your Macintosh, your Acquidata 
and how it is connected, special hardware configurations, and other 
peripheral devices connected to the computer. 

Click the Print button to print the picture (it brings up the Print dialog 
box), or the Copy to Clipboard button to copy the picture for pasting 
into a letter or fax to your Acquidata dealer. 

General

We welcome customer comment. You don’t have to wait until you can 
send a software problem report or want to return damaged hardware! If 
you have comments or suggestions you would like to make about the 
Uromac application or this user’s guide, please feel free to write to us 
directly in Australia, or through your local Acquidata dealer. We value 
your responses, and they are taken into account when future releases 
are being worked on. 

Solutions to Common Problems
Uromac has an extensive array of dialog and alert boxes, and these will 
probably appear in most cases where problems arise. Very often they 
will suggest appropriate courses of action. Where they do not, or where 
the actions they suggest fail to alleviate the problem, this section of the 
guide should prove useful. 

Starting Up

Start-up errors are mostly hardware problems, and are dealt with in 
detail in your Acquidata Owner’s Guide, but are briefly covered here. 

The Macintosh canÕt Þnd the Acquidata

The Acquidata is off or the power is switched off at the wall, the power 
cable is not connected firmly, or a fuse has blown. 

¥ Check switches, power connections, and fuses. 
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Poor cable connection between the Acquidata and the Macintosh, or a 
bad cable. 

¥ Ensure that the cable is Þrmly attached at both ends and try again. 
If there is still a problem, try a new cable. 

The Acquidata has an internal problem or has ÔhungÕ

¥ Turn off the Macintosh, the Acquidata (and any other devices in 
the SCSI chain), and then turn the Acquidata back on again after at 
least ten seconds. Turn on the Macintosh and try using Uromac 
again. 

SCSI problems: two SCSI devices on the bus have the same SCSI ID, or 
termination is incorrect. 

¥ Check that each device has a unique ID number and that the SCSI 
chain is terminated correctly.

Uromac ÔhangsÕ or gives an alert on start-up

SCSI problems: two SCSI devices on the bus have the same SCSI ID, or 
termination is incorrect. 

¥ Check that each device has a unique ID number and that the SCSI 
chain is terminated correctly.

It may be that the application has become damaged in some way.

¥ Try reinstalling Uromac from the original locked disks. 

Uromac starts up with strange settings and macros

You started Uromac by opening a data file with custom settings or a 
settings file, or the start-up settings have been customised. 

¥ Start up again from the application itself. To start up Uromac with 
its default settings, hold down the Command key as you open the 
application (straight after double-clicking it). Release the key 
when an alert box appears. 
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To revert to the default start-up settings, choose the Start-Up… 
submenu command from the Preferences submenu of the Edit menu 
and click Clear in the dialog box that appears. The next time Uromac 
starts up, it will open with the default settings. 

Interface Problems

Some data display areas show gray

Uromac channels show gray while recording when they are turned off. 
Most dialog boxes and windows require a selection of data in the 
Uromac window to display a waveform. The Zoom window has upper 
and lower limits on the amount of data it can display (5 to 32,000 
points). The X–Y window needs to have the x and y channels selected 
so that they can be plotted against each other. The Overview 
miniwindow shows gray if you stopped it in the process of drawing. 

¥ Select data in the Uromac window if there is no selection, change 
the extent of the selection if the Zoom window is gray; click the 
numbered buttons bottom left and top right in the XÐY window to 
get an XÐY plot; click the Overview display or a numbered button 
for it to redraw. 

The Time axis shows very large or negative values

The file with which you are working is an old one with new data 
recorded in it, or one created by appending files or selections, and the 
time is displayed from the start of the record. 

¥ Uromac remembers, but does not display, the date and time of all 
recordings. Hence a section recorded before the one at the start of 
the Þle and subsequently appended to it, say, will appear with a 
negative time relative to the start of the record. Very large values 
to the right of the Time axis reßect a large lag between the time the 
record was created and the latest recording. If the values are a 
problem, simply change the time mode display to show time from 
the start of each block. 

DeÞned units display strangely

Uromac will deal with a unit prefix correctly only if it is chosen from 
the Prefix pop-up menu in the dialog box for defining units: if defined 
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▼ Refer
Choosing Units,  p. 42
as part of a unit, it is ignored. A Helen is a standard unit of beauty. If 
you type in mHelen — the facial beauty required to launch one ship — 
as one word with no prefix, then Uromac will display a waveform of a 
thousandth of a Helen — sufficient to launch a model boat — with 
units of mmHelen. If the prefix m were chosen, Uromac would scale 
the unit prefix properly, to give unit measurements in µHelen. 

The indentation of defined units in the Units pop-up menu in the Units 
Conversion dialog box shows if a prefix has been used properly.

Commands seem to have no effect, or a strange one

Macro recording might have been turned on, so that you record what 
you are doing rather than actually doing it. If so, then a small indicator 
will turn next to a message in the text box in the Tool Bar. 

¥ Choose Stop RecordingÉ from the Macro menu, and discard the 
macro, since it will likely be of little use. 

Command-key equivalents donÕt work, or do strange things

Menu commands may have been deleted, or reassigned to other menu 
commands or macros. 

¥ Look at the menus and compare them with Table AÐ1. See below 
for resetting procedures. 

Menus, controls, or settings donÕt resemble those in this guide

You started Uromac by opening a data file with custom settings or a 
settings file, or the copy of Uromac you are using has been extensively 
customised, and the settings saved as start-up settings. (Some menu 
commands may be disabled, or have disappeared altogether, some or 
all may be replaced by macros.)

¥ Start up again from the application itself. To start up Uromac with 
its default settings, hold down the Command key as you open the 
application (straight after double-clicking it). Release the key 
when an alert box appears. 
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To revert to the default start-up settings, choose the Start-Up… 
submenu command from the Preferences submenu of the Edit menu 
and click Clear in the dialog box that appears. 

Uromac extensions may also add menus and alter some options. 

¥ To start up Uromac without loading its extensions, hold down the 
Shift key straight after double-clicking it. Release the key when an 
alert box appears (there will be an alert box for each extension). 

To stop any extensions being loaded, move those in the Uromac 
Extensions folder into the Unused Extensions folder. 

IÕve altered menus and locked myself out, canÕt save, and so on

Type Command-/ to bring up a dialog box that allows emergency 
access to the menu settings, start-up settings, and saving options.

Dialog boxes donÕt appear where I want them

Uromac dialog boxes usually appear on the main monitor (the one with 
the menu bar). There are times, however, when you want one to 
appear on a secondary monitor, for instance, if that monitor is colour 
and you are changing display colours. 

¥ Uromac in fact brings up dialog boxes on the monitor where the 
pointer is positioned. To make a dialog box appear on a secondary 
monitor, place the pointer there and use a Command-key 
equivalent to bring up the dialog box (or if there is no keyboard 
equivalent, deÞne a macro with one to do it). 

Recording Problems

I keep getting alerts saying the recording speed is too fast

Uromac has a maximum continuous sampling speed of 100,000 samples 
per second on one channel, lower speeds on others. Your computer’s 
speed may limit the number of channels used (see Table 3–2). 

¥ Ensure that the Macintosh is appropriate to the sampling speed 
and number of channels you want.
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▼ Refer
Performance at Fast 
Speeds,  p. 30
¥ Channels do not need to be visible to record data, so check that 
any bunched at the bottom of the Uromac window are actually off.

¥  Increase available memory: you may be running out.

Background activities — other applications, electronic mail, screen 
savers, and other system extensions — will decrease the ability of the 
Macintosh to cope with the data it gets from the Acquidata. 

¥ Turn off anything other than Uromac that could slow down or 
interrupt data sampling. 

If you are recording not to RAM but to disk using Data Buffering, 
sampling will be slower: how much depends on the Macintosh and the 
medium to which you are recording (hard disks tend to be the fastest 
of the options). 

¥ Ensure that your disk is not too full and is not fragmented: either 
slows down the speed of writing to disk. 

¥ If you need more speed, record to RAM rather than to disk. 

Nothing seems to be recording

The Record/Monitor button (bottom right of the Uromac window, by 
the Start button) may be set to Monitor; there will be a cross through it 
if this is so, and the Recording Status indicator, above the Time axis, 
will read ‘NOT recording’.

¥ Click the Record/Monitor button to make the cross disappear, and 
then data shown on screen will be recorded normally. If the button 
is not visible, then use the Controls dialog box (Edit menu, 
Preferences submenu) to show it. 

Uromac may be recording, but nothing visible is going on. This 
happens when Uromac is reviewing rather than scrolling. The 
Recording Status indicator will read ‘Recording’, and the Review button, 
not the Scroll button, will be highlighted. 

¥ Simply click the Scroll button to record normally. 
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The Trigger may not be set to User, and Uromac may be waiting for a 
trigger event: in this case the Recording Status indicator, above the 
Time axis, will read ‘Waiting for trigger’.

¥  Choose Trigger from the Setup menu and set the Event in the 
Trigger dialog box to User. 

The Macintosh ÔhangsÕ while recording, or there is data loss

There may be a poor cable connection between the Acquidata and the 
Macintosh, or a bad cable, or incorrect SCSI termination. Network 
connection problems or a strange system extension could also be 
causing the problem.

¥ Ensure that the SCSI chain is terminated correctly.

¥ Ensure that the cable is Þrmly attached at both ends and try again. 
If there is still a problem, try a new cable.

¥ Check your network connections, if you are on a network.

¥ Check your system extensions.

I keep running out of memory

Uromac records to RAM by default. If you increase its memory 
allocation, you will have more of the RAM in your System available to 
record data. 

¥ To increase available memory, quit Uromac, select the Uromac 
icon in the Finder and choose Get Info in the File menu (or type 
Command-I). Type in a new value in the ÔPreferred sizeÕ box. 

¥ If increasing RAM allocation is not enough and your data 
acquisition rate is not very fast, you can instead record to disk Ñ 
hard disk (the fastest alternative), removable hard drive, magneto-
optical, and so on, using data buffering.

Uromac uses a reasonable amount of memory for an off-screen buffer: 
if the Uromac window is large and the display is grayscale or colour, 
more memory is used, especially at increased colour depths. 
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¥ Shrink the Uromac window and change the display from colour or 
grayscale to black and white, or at least reduce the colour depth. 
This may also help to increase maximum sampling speeds in some 
cases. 

Printing Problems

The whole Þle printed, although a page range was speciÞed

Uromac acts like a mechanical pen-and-ink Uromac recorder, which 
uses a continuous roll of paper; a ‘page’ in this context really means the 
length of the Uromac record. This is why the menu command says Print 
All… when the Uromac window is active and there is no selection. 

¥ If you want to print less than the whole Þle, then select the portion 
of interest in the Uromac window before printing (whereupon the 
menu command changes to Print SelectionÉ). 

Comments are truncated when printed

¥ Turning off the Show Times checkbox in the Comments window 
will allow a little extra space for printing comments either at the 
end of a Uromac Þle or on their own. 

¥ If you have a PostScript laser printer, choose ÔLarger Print AreaÕ in 
the page setup options. 

¥ If comments are still too long to print after trying the above 
remedies Ñ although they are only designed for short notes Ñ 
then transfer them as text to a word-processing program.

Printing is very slow

If getting a hard copy of your Uromac file quickly is important, there 
are a number of things you can do. 

¥ First, work in black and white, not gray-scale or colour, and 
compress your Þle using the View buttons to minimise the 
number of pages that must be printed. Turn off Background 
Printing in the Chooser: although it is useful to print in the 
background, spooling the document takes time. Ensure that you 
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are using the latest printer driver (the LaserWriter 8 software, for 
instance, is considerably faster than the LaserWriter 7 software).

¥ The Page Setup options affect printing speed. For a PostScript 
laser printer, Faster Printing should be on and the other three 
Uromac-speciÞc options off. Of the generic options, Substitute 
Font should be on, and the rest off. If you have another type of 
printer, you should experiment with the Page Setup options to see 
which give greatest speed. (Remember that the Faster Printing 
option in the Uromac Page Setup dialog box is not necessarily a 
panacea, though: depending on your particular setup, it is 
possible that it could in fact slow down printing.) If using the 
LaserWriter 8 software, leave the Layout option in the Page Setup 
dialog box at Ô1 UpÕ (printing one page per sheet), since its scaling 
is quite slow.

The quality of the hard copy using these settings should be sufficient 
for most purposes except publication. 

Printing speed depends on hardware as well: the faster the computer 
and printer, the faster that material can be printed. A twin-floppy Mac 
Plus driving an original LaserWriter will never be a speed demon. 

Macro Problems

Macros behave unexpectedly

¥ Make sure that you have the right macro, not a different one of the 
same name (in the case of name conßicts, the latest macro loaded 
into memory is used). 

¥ Check that you have the steps and effects recorded somewhere, 
and that you havenÕt misremembered them Ñ it is very easy to do. 

¥ If the macro is a new one, it is possible that a step was not 
recorded correctly, and in particular, that a repeated sequence was 
ended in the wrong place. Try recording it again. 

I have macros in Þles where I donÕt want them

A macro, once created, floats around in memory until you save a file, 
whereupon a copy is saved with the file (not necessarily the original 
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Note
Uromac checks itself on 
start-up for damage or 
virus infection, and will 
present an appropriate 
alert box if it detects a 
problem. (Files are not 
checked, though.) 
file where it was created). If you have opened many files with macros 
in them, you will likely have a lot in memory. 

¥ Delete unwanted macros using the Delete MacroÉ menu 
command and then save the Þle you want free of them. (Delete 
MacroÉ merely removes macros from memory until the Þle they 
are attached to is saved.)

I created a macro, but lost it on quitting Uromac

As mentioned above, macros float around in memory until a file is 
saved. Your macro may have been attached to another file, or lost if 
you saved no files before quitting Uromac.

¥ Save a Þle where you want macros stored before quitting Uromac. 

Crashes

Uromac quits unexpectedly, crashes, or freezes

If Uromac quits unexpectedly or crashes (you get a dialog box with a 
bomb in it), or the pointer freezes, then there may be a Macintosh 
system problem. If the behaviour is repeated, then some non-Apple 
system extension is most likely to be the cause. 

¥ Try turning off system extensions to see what is causing the 
problem. See your Macintosh UserÕs Guide for more details on this 
problem and how to deal with it.

The file you are using may have become corrupted, possibly through 
disk damage, especially if it is on a floppy disk. 

¥ Use disk-checking software to Þnd and attempt to Þx any 
problems in this area. 

It may be that the application has become damaged in some way.

¥ Try reinstalling Uromac from the original locked disks. 

It could be that a computer virus is causing the problems. 
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¥ Check your disk with anti-viral software. If you Þnd a virus, you 
should check all potentially affected computers, disks, and 
backups, and eliminate the infection. See if you can Þnd the cause 
of the outbreak (poor network security or staff copying of software 
onto lab machines, for example) and try to prevent future 
occurrences. 
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data display area 16, 33
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data file 75
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MacLab system 3
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Macro Commands submenu 157
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140
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Start-Up… command 43, 123
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Print… command 80
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comments 82, 90
Data Pad 101
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problems 168–169
restricting 122
X–Y window 103
Zoom window 66

problems and solutions 161–171
pulse parameters 50
Q
Quit command 12
quitting Chart 6, 12
R
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choosing 32
Range pop-up menu 15, 32, 106, 109
Range/Amplitude display 16, 18, 32, 33,
94, 95
Rate pop-up menu 85
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raw data 33, 103, 106
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hiding 122
recording 8, 18–25

changing settings during 19
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problems 165–168
running other applications 23
speed 44
split-screen 23
time equation 25
to disk 43–44
while reviewing data 22
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recording fidelity 14, 32, 54, 67
Recording Status indicator 18, 20
reduction 73, 77
Remove Baseline command 97
Repeat Select Each Block command 140
Repeat Select Every dialog box 139
Repeat Select Every… command 139
repeat sequence 145
Review button 18, 22

hiding 122
Row button 97
S
Samples/Div submenu 28
sampling speed 28
sampling speeds

and View buttons 29
computed input 105
normal 29
problems 165
slow 31

Save As directory dialog box 75
Save As Text File dialog box 76
Save As… command 72, 75–78
Save command 75
Save Selection directory dialog box 78
Save Selection… command 71, 78
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moving 56
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Scale pop-up menu 15, 55
Scale Range dialog box 56
screen savers 30
scroll bar 14
Scroll button 18, 22

hiding 122
scroll while sampling 62
scrolling speed 28
selecting data 70–71
selection information 100
sensitivity bandwidth 107
Set Baseline command 96
Set Marker command 95
Set Scale… option 56
Set Units Conversion dialog box 141
Set Units Conversion… command 140
settings 75, 76, 123
settings file 76
Setup menu 156

Auto Comments… command 149
Channel Titles… command 58
Configure Digital Output… command

147
Display Settings… command 59
Output Voltage… command 52
Stimulator command 49
Stimulator Panel command 51
Timed Events… command 143
Trigger command 45

Show Clipboard command 74
Show Dialog Box dialog box 126
single-sided display 55
size box 14
slider bar 46, 50

slope 100
Slow Speed submenu 31
slow tracking 107
smoothing 34, 103
Speak Message dialog box 138
Speak Message… command 137
specifying connections 151–152
Speed pop-up menu 15, 28, 31
Speed/Time display 16, 19, 28, 57, 94, 9
split bar 16, 54–55
Stack button 65
Start button 17
Start pop-up menu 47
Start Recording command 127
Start time controls 47
Start-up problems 161–163
start-up settings 43
Start-Up Settings dialog box 123
Start-Up… command 43, 123
state changes 147, 150
statistics 100
stimulation

changing during sampling 51
continuous pulses 50
fixed number of pulses 50

Stimulator 49–??
Stimulator command 49
Stimulator Constant Output dialog box 52
Stimulator Panel command 51
Stimulator Panel increment dialog boxe
51, 52
Stimulator Panel miniwindow 51
Stimulator window 49
Stop pop-up menu 47
Stop time controls 48
superscripts and subscripts 42, 58–59, 9
system configuration information 160–16
system extensions 30
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problems 163
Time control 109
time display mode 15, 19, 57–58
Time Display Mode dialog box 57
Timed Event Stimulator Output dialog box
144
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editing 146

Timed Events dialog box 143
Timed Events… command 143
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Tool Bar Settings dialog box 121
tracking channel 66
transferring data 72–74
Translate application 77
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using sampled data 40–41
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Update Screen command 134
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Urom
Licensing & Warranty Agreement
Extent

This Agreement is between Neomedix Systems Pty 
Ltd [ÔNMSÕ] and the purchaser [Ôthe PurchaserÕ] of 
any NMS product Ñ software, hardware, or both 
Ñ and covers all obligations and liabilities on the 
part of NMS, the Purchaser, and other authorised 
users of the product. The Purchaser (or authorised 
user) automatically accepts the terms of this 
Agreement by use of the product. Any changes to 
this Agreement must be recorded in writing and 
have the consent of both NMS and the Purchaser. 

Copyright and Trademarks

NMS develops proprietary computer software and 
hardware, including Acquidata¨,AcquiAmpliÞer¨ 
and AcquiProcessor¨devices. All NMS supplied 
software, hardware, and documentation is 
protected by copyright, and may not be 
reproduced or altered in any way, nor may 
products be derived from or based on it. NMS 
retains the exclusive ownership of the trademarks 
and registered trademarks represented by its 
company name, logo, and product names. 

Responsibilities

The Purchaser and any others using any NMS 
product agree to use it for the purpose for which it 
was designed and in accordance with good clinical 
practice. The user is responsible for the manner of 
use of the products and any resultant effects and 
ac UserÕs Guide 18
agrees to take responsibility for their actions and the 
results of their actions. 

If problems arise with a NMS product, NMS will 
make all reasonable efforts to rectify the fault under 
the terms of the warranty clause also listed in formal 
product quotations. Such service may incur a charge, 
depending on the details of such fault or its cause, 
and is subject to the other conditions in this 
Agreement. 

Limitations

Since NMS products could be affected by external 
factors (for instance, the computer system or 
conÞguration on which they run), absolute 
performance and reliability cannot be guaranteed. 
No warranty, either express or implied or statutory, 
other than that contained in this Agreement, is made 
in respect to NMS products. The Purchaser therefore 
assumes all risks as to the performance and 
reliability of the products, and the resultant effects. 

No claim for damages of any sort arising from the 
use or misuse of NMS products can be made against 
NMS or its agents or employees. 

Nevertheless, NMS products are produced to high 
standards, and should perform substantially as 
described in the supplied documentation. Technical 
support is provided for all products. 
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Hardware Warranty

NMS warrants that the hardware purchased by the 
Purchaser shall be free of defects in material and 
workmanship for one year from its date of 
purchase. If there is such a defect, NMS will repair 
or replace the equipment as appropriate. The 
Purchaser should contact NMS for return 
authorisation prior to returning any product. 

This warranty applies only to hardware in an 
environment to internationally acceptable 
standards.The equipment must be used within the 
stated operating range. Warranty does not cover 
hardware modiÞed in any way, subjected to 
unusual physical, electrical, or environmental 
stress, used with incorrectly wired or substandard 
connectors or cables, or with the original 
identiÞcation marks altered. 

Software License

The Purchaser has the non-exclusive right to use 
the supplied NMS software. (The PurchaserÕs 
employees or technicians, for instance, are entitled 
to use it, provided they adhere to this Agreement.) 

The Purchaser can make as many backup copies of 
NMS software as is reasonable. Each separate 
purchase of a software program, however, licenses 
it to be used on only one computer at any given 
time. Although multiple copies of a purchased 
program may exist, two or more copies must not be 
used simultaneously. Site licenses (multiple-user 
licenses) are treated as if Þve copies of a program 
were purchased separately, even if only one set of 
disks is provided. 

Technical Support

Once a customer registration form has been Þlled 
out andreturned to NMS, the Purchaser is entitled 
to free technical support for any NMS product for 
one year from its date of purchase. (A customer 
registration form is included with each product: if 
for some reason you cannot Þnd one, contact NMS 
for another.) 

Jurisdiction

This Agreement shall be governed by the laws of 
New South Wales in Australia, and any 
proceedings concerning it shall be heard and 
resolved by the Supreme Court of New South 
Wales in Australia. 
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